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About This Guide

This documentation describes how to install, configure, and use Novell Domain Services for Windows

on a Novell Open Enterprise Server (OES) 11 SP3 server.
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¢ Chapter 2, “What's New or Changed in Domain Services for Windows,” on page 19
+ Chapter 3, “Use-Cases,” on page 23

+ Chapter 4, “Deployment Scenarios,” on page 27

+ Chapter 5, “Planning for DSfW,” on page 35

¢ Chapter 6, “Installing Domain Services for Windows,” on page 53

¢ Chapter 7, “Provisioning Domain Services for Windows,” on page 109

+ Chapter 8, “Activities After DSfW Installation or Provisioning,” on page 137

+ Chapter 9, “Upgrading DSfW,” on page 143

¢ Chapter 10, “Running Domain Services for Windows in a Virtualized Environment,” on page 147

¢ Chapter 11, “Logging In from a Windows Workstation,” on page 149

+ Chapter 12, “Using Mac Client,” on page 155
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+ Chapter 14, “Understanding DNS in Relation to DSfW,” on page 163

+ Chapter 15, “Configuring DSfW Server as a WINS Server,” on page 169

+ Chapter 16, “Configuring Sites and Subnets,” on page 175

+ Chapter 17, “Managing Group Policy Settings,” on page 179

+ Chapter 18, “Managing Trust Relationships in Domain Services for Windows,” on page 187
+ Chapter 19, “Providing Access to Server Data,” on page 213

+ Chapter 20, “Printing in the Domain Services for Windows Environment,” on page 223
+ Chapter 21, “Flexible Single Master Operation (FSMO) Roles,” on page 225

+ Chapter 22, “Troubleshooting,” on page 231

+ Appendix A, “Schema,” on page 251

+ Appendix B, “Understanding DSfW in Relation to IDM and Samba,” on page 259

+ Appendix C, “Network Ports Used by DSfW,” on page 263

+ Appendix D, “DSfW Password Policy Attributes,” on page 265

+ “Glossary” on page 267
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Audience

This guide is intended for network installers and administrators.
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Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comment feature at the bottom of each page of the
online documentation.

Documentation Updates

For the most recent version of the OES 11 SP3:Domain Services for Windows Administration Guide,
see the latest Novell Open Enterprise Server 11 documentation (http://www.novell.com/
documentation/oes11).

Additional Documentation

For information about security issues and recommendations for Novell Domain Services for Windows
see OES 11 SP3: Novell Domain Services for Windows Security Guide

For online community resources, and tips and tricks, see (http://www.dsfwdude.com).
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Overview of DSfW

Domain Services for Windows (DSfW) is a suite of technologies in Open Enterprise Server (OES)
that allows Microsoft Windows users to access OES services through native Windows and Active
Directory protocols. By allowing OES servers to behave as if they were Active Directory servers, this
technology enables companies with Active Directory and NetlQ eDirectory deployments to achieve
better coexistence between the two platforms. Users can work in a pure Windows desktop
environment and still take advantage of some OES back-end services and technology, without the
need for a Novell Client on the desktop.

Administrators can use either Novell iManager or Microsoft Management Console (MMC) to
administer users and groups. Network administrators manage file systems using the native tools of
each server, and they can also centrally administer Samba shares on OES / DSfW servers by using
iManager.

Administrators can use MMC to create inter-domain trusts between DSfW domains and Active
Directory domains.

Users can access Novell Storage Services (NSS) volumes on Linux servers by using Samba shares
or NTFS files on Windows servers that use CIFS shares. eDirectory users can also access shares in
trusted Active Directory forests.

Domain Services for Windows is not a meta-directory or a synchronization connector between
eDirectory and Active Directory. It does not do desktop emulation. Domain Services for Windows can
only run on SUSE Linux Enterprise deployments of Open Enterprise Server 2 SP1 and later.

¢ Section 1.1, “Features and Benefits,” on page 13
+ Section 1.2, “Architectural Overview,” on page 15

+ Section 1.3, “Basic Directory Services Concepts,” on page 16

+ Section 1.4, “Key Differences Between the DSfW LDAP Server and the eDirectory Server,” on
page 17

Features and Benefits

DSfW is designed to simplify the network infrastructure in mixed Windows/OES environments,
thereby reducing costs and streamlining IT operations. Minimal changes are required to the default
authentication, authorization, and replication mechanisms in existing eDirectory and Active Directory
environments. DSfW enforces the Active Directory security model in eDirectory and applies it to all
users and groups within the DSfW domain, regardless of the tool used to create the users and
groups. Both Microsoft and Novell applications can be used unmodified. Resources in either the
Active Directory or eDirectory environment remain securely accessible by eDirectory users.

Specific benefits of DSfW include the following:

Overview of DSfW 13
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Figure 1-1 Overview of DSfW
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Clientless login and cross-platform file access for Windows users: From a standard
Windows workstation, users can authenticate to an OES server running eDirectory without the
need for the Novell Client software or multiple logins. After the Windows workstations have
joined the DSfW domain, authorized users can log in and access the file and print services they
are authorized to use, whether the services are provided by OES servers in the DSfW domain or
Windows servers in a trusted Active Directory domain.

Unified repository of user account information: DSfW is not a directory synchronization
solution. Each user is represented by a single user account, and that account can reside in either
eDirectory or Active Directory. A single password is used to authenticate each user to resources
in either environment.

Support for cross-domain and cross-forest trust relationships: DSfW allows administrators
to create cross-domain and cross-forest trusts between a Windows 2003 Active Directory
domain/forest and a DSfW domain/forest. This allows authenticated and authorized DSfW users
to access data on servers in an Active Directory domain/forest.

Support for existing management tools: Administrators can use familiar tools for their
environment, such as iManager for OES and Microsoft Management Console (MMC) for
Windows, thus eliminating the need for re-training.

Network administrators can manage file systems using the native tools of each server, as well as
centrally administer Samba shares on OES /DSfW servers using iManager. Administrators can
use MMC to create one-way cross-forest trusts between DSfW domains and Active Directory
domains. For example, Windows server/workstation policy settings in the domain Group Policies
can be changed by using MMC.
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¢ Support for common authentication protocols and open standards: DSfW supports
common authentication protocols used in the Windows environment, including Kerberos, NTLM,
and SSL/TLS.

+ Single Password to Login: One of the biggest benefits Domain Services for Windows provides
end users is it eliminates multiple logins if they need access to both Active Directory- and
eDirectory-based services. The trust relationship between eDirectory and Active Directory
enables them to employ a single password for the services provided by either directory. From an
IT perspective, this also greatly simplifies user management as objects for those users only need
to be maintained in one directory repository instead of two.

1.2 Architectural Overview

Figure 1-2 illustrates the components included in DSfW and how they interact.

Figure 1-2 DSfW Components
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DSfW is made up of the following technologies:

+ eDirectory: eDirectory 8.8 SP2 and above supports DSfW.
+ Kerberos Key Distribution Center (KDC): Provides Active Directory-style authentication.

NOTE: This is a KDC specifically developed for DSfW. It is different from the Novell Kerberos
KDC (http://www.novell.com/documentation/kdc15/index.html).

+ NMAS Extensions: Provide support for GSS-API authentication mechanisms, and for
SAMSPM, to generate Active Directory-style credentials when a user’s Universal Password is
changed.

+ Active Directory Provisioning Handler (ADPH /Directory System Agent): Provides agent-
side support for the Active Directory information model, regardless of access protocol. It
enforces Active Directory security and information models, allocates Security Identifier (SIDs) to
users and groups, validates entries, and enables existing eDirectory users and groups to use
Active Directory and RFC 2307 authorization.

+ Domain Services Daemon: Provides support for Windows RPCs, including Local Security
Authority, Security Accounts Manager, and Net Logon.
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1.3

1.3.1

1.3.2

+ NAD Virtualization Layer: Virtualizes the Active Directory information model within eDirectory
so that LDAP requests are handled appropriately.

+ CIFS: Provides file services and transport for DCE RPC over SMB. The services are provided by
the Samba 3.x software included with SUSE Linux Enterprise Server 11 SP4 and OES 11 SP3.

+ DNS: The DNS server has been modified to support GSS-TSIG (Kerberos secured dynamic
updates).

+ NTP: The NTP server has been modified to support the secure signing of NTP responses.

Basic Directory Services Concepts

To effectively set up and work with DSfW, a basic understanding of both eDirectory and Active
Directory is required. This section briefly outlines helpful concepts and terminology.

+ Section 1.3.1, “Domains, Trees, and Forests,” on page 16
+ Section 1.3.2, “Naming,” on page 16

+ Section 1.3.3, “Security Model,” on page 17

¢ Section 1.3.4, “Groups,” on page 17

Domains, Trees, and Forests

Domain: In Active Directory, a domain is a security boundary. A domain is analogous to a partition in
eDirectory.

Tree: A DSfW tree consists of a single domain or multiple domains in a contiguous namespace.

Forest: A forest is a collection of Active Directory domains. A forest is analogous to a tree in
eDirectory. You can set up trust relationships to share authentication secrets between domains.

Each Active Directory server has a domain, a configuration, and a schema partition.

Global Catalog: Global catalogs are special Active Directory domain controllers that store a
complete copy of all the Active Directory objects belonging to the host domain and a partial copy of all
other objects in the forest.

Federation can be accomplished through establishing cross-domain and cross-forest trusts.

Naming

Active Directory uses DC (domain class) naming at the root of a partition, while eDirectory supports
other naming attributes like Organization (O) and Organizational Unit (OU). For example, in
eDirectory a partition might be specified as:

ou=sales.o=company
In Active Directory, the partition is specified as:
dc=sales, dc=company

Every Active Directory domain maps to a DNS domain. The DNS domain name can be derived from
the Active Directory domain name. DSfW also follows this rule and supports mapping of eDirectory
partitions to DSfW domains.

For example, the ou=sales.o=company partition can be mapped to the DSfW domain
dc=sales, dc=company, dc=com.
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1.3.3

1.3.4

1.4

Security Model

The Active Directory security model is based on shared secrets. The authentication mechanism is
based on Kerberos. The domain controller contains all users’ Kerberos keys. The KDC, Remote
Procedure Call (RPC) server, and Directory System Agent (DSA) operate inside a “trusted computing
base” and have full access to all user information.

Active Directory users and groups are identified by unique Security Identifiers. The SID consists of
domain-specific prefix, followed by an integer suffix or “relative ID” that is unique within the domain.

For more information about Active Directory, see the Microsoft Active Directory Technical Library
(https://technet.microsoft.com/en-us/library/dd578336(v=ws.10).aspx).

Groups

Active Directory supports universal, global, and local groups. DSfW supports the semantics of these
groups with different scopes when the group management is performed through MMC. However,
there are exceptions. For example, validation of group type transitions is not supported.

Groups can also contain other groups, which is known as Nesting. Other limitations largely result from
the way eDirectory supports nested groups. You cannot add a group from other domains as a
member of a group.

In addition eDirectory supports dynamic groups, because Active Directory does not support them,
dynamic groups are not supported in DSfW. All groups created by using iManager or MMC can be
used as security principals in an Access Control List in eDirectory. Token groups can only have
groups that are enabled as security groups through MMC.

Key Differences Between the DSfW LDAP Server
and the eDirectory Server

Table 1-1 Comparison of DSfW LDAP server and eDirectory server

Function DSfW LDAP Server eDirectory Server

LDAP Operations like Search and  Uses Domain Name format. For Uses X.500 format. For example:

Modify example: dc=eng, dc= novell. ou=eng, o=novell.

Ports When DSfW server is configured eDirectory uses ports 389 and 636
LDAP requests, such as Search for communication purposes. The

and Modify, to a DSfW server on format used is X.500.
port 389 or 636 uses domain name

format instead of eDirectory X.500

format. LDAP ports 1389 and 1636

are enabled to support LDAP

requests using the traditional X.500

format and to behave as eDirectory

ports.

Semantic Controls LDAP requests along with LDAP No support for semantic controls
semantic controls
(2.16.840.1.113719.1.513.4.5)
allow LDAP requests to select
X.500 or the domain format.
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Function DSfW LDAP Server eDirectory Server

Schema Addition Attribute and class mappings are
changed for some object classes.
For example, User and Group
object classes are mapped to user
and group; server is mapped to
ndsServer User and Group object
classes are extended to hold
additional Active Directory
attributes. For more information,
Attribute Mappings and Class
Mappings.

Search Search and Modify, to a DSfW The search spans across patrtitions.
server on port 389 or 636 return
only those objects that exist in the
partition and do not search beyond
the partition boundary. An LDAP
referral is returned, but if the calling
LDAP application does not support
referrals, it fails to search beyond
the partition boundary. A search
request on global catalog ports
(3268, 3269) spans partition
boundaries and searches the entire
forest. The result set contains only
the attributes marked as Partial

Attribute Set (PAS).
Multiple Instances Not supported. Supported.
Support for NT ACLs No support for NT ACLs. Directory objects are protected by
proven eDirectory ACLs.
Domain Partition Every DSfW server has a unique No concept of domain partition.

domain partition (required by the
Active Directory security model).

For both DSfW server and LDAP server, login authorization and auditing is performed by using
NMAS. Data on the wire is encrypted as mandated by the workstations. All keys, including Kerberos
and NTLM, are encrypted by using a per attribute NICI key.
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2.1

2.2

2.3

2.4

What’s New or Changed in Domain
Services for Windows

This section describes the changes made to Domain Services for Windows since the Novell Open
Enterprise Server (OES) 11 release.

+ Section 2.1, “What's New (OES 11 SP3 October 2016 Hot Patch),” on page 19

+ Section 2.2, “What’s New (OES 11 SP3),” on page 19

¢ Section 2.3, “What's New (OES 11 SP2 March 2014 Patches),” on page 19

¢ Section 2.4, “What's New (OES 11 SP1 March 2014 Patches),” on page 19

+ Section 2.5, “What’'s New (OES 11 SP2),” on page 20

+ Section 2.6, “What’'s New (OES 11 SP1),” on page 21

¢ Section 2.7, “What’'s New (OES 11),” on page 22

What's New (OES 11 SP3 October 2016 Hot Patch)

This patch provides the resolution to the Group policy update issue on Windows 10. For more
information on the manual steps to be followed after the patch installation, see Section 22.1.1, “Group
Policy Update Failure on Windows 10,” on page 233.

What's New (OES 11 SP3)

Besides bug fixes, there are no other changes for this component.

What's New (OES 11 SP2 March 2014 Patches)

In addition to bug fixes, the DSfW service provides the following enhancement and behavior change
in the March 2014 Scheduled Maintenance for OES 11 SP2:

New Configuration Parameter in smb.conf File

A new environment variable, winbind rpc timeout, is introduced in [global] section of /etc/
samba/smb . conf file to specify the timeout interval for the incoming RPC (Remote Procedure Call)
requests. This enables you to avoid a windbindd crash due to the timeout while processing the
winbind RPC requests. The default value of this parameter is 35000 milliseconds. If you observe a
winbindd crash, increase the value of this parameter to a greater value, such as 100000 milliseconds.

What's New (OES 11 SP1 March 2014 Patches)

In addition to bug fixes, the DSfW service provides the following enhancement and behavior change
in the March 2014 Scheduled Maintenance for OES 11 SP1:
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2.5

New Configuration Parameter in smb.conf File

A new environment variable, winbind rpc timeout, is introduced in /etc/samba/smb.conf file to
specify the timeout interval for the incoming RPC (Remote Procedure Call) requests. This enables
you to avoid a windbindd crash due to the timeout while processing the winbind RPC requests. The
default value of this parameter is 35000 milliseconds. If you observe a winbindd crash, increase the
value of this parameter to a greater value, such as 100000 milliseconds.

What's New (OES 11 SP2)

Domain Services for Windows in OES 11 SP2 has been modified to run on 64-bit SUSE Linux
Enterprise Server (SLES) 11 SP3.

IMPORTANT: To use the DSfW features introduced in the OES 11 SP2 release, you must upgrade all
Domain Controllers in the DSfW domain to OES 11 SP2.

In addition to bug fixes, Domain Services for Windows provides the following enhancements in the
OES 11 SP2 release:

Configuring DSfW Server as a WINS Server

Duplicate workstation names in a domain lead to several issues such as slow user logins. Configuring
a DSfW server as a WINS server helps to prevent having two workstations with the same name in a
domain. For more information, see “Configuring DSfW Server as a WINS Server” in the OES 11 SP2:
Domain Services for Windows Administration Guide.

Sites and Subnets

The sites and subnets feature enables you to configure multiple sites and distribute domain
controllers over different geographical locations. When a client tries to log in to a domain, the request
goes to the nearest available domain controller, thus ensuring faster domain login. For more
information, see “Configuring Sites and Subnets” in the OES 11 SP2: Domain Services for Windows
Administration Guide.

Mac Client Support

Beginning with OES 11 SP2, DSfW supports the OS X 10.8 and OS X 10.9 clients. This support
enables you to join a Mac client to a DSfW domain, log in to the domain using DSfW credentials, and
access NSS shares. For more information, see “Using Mac Client” in the OES 11 SP2: Domalin
Services for Windows Administration Guide.

SASL NTLMSSP Bind Support

DSfW now includes NTLM support for LDAP authentication. If Kerberos is down or a legacy third-
party application is limited only to NTLM authentication, the NTLM support for LDAP authentication
goes into effect. This NTLMSSP support is layered over the SASL GSS-SPNEGO mechanism. For
more information, see “Support for SASL NTLMSSP Bind in LDAP” in the OES 11 SP2: Domain
Services for Windows Administration Guide.

Novell Client Support

DSfW now enables co-existence of Novell Client with DSfW. Users can now authenticate to a DSfW
server using Novell Client. You can now join a workstation pre-installed with Novell Client to a DSfW
domain without affecting the DSfW communication.
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2.6

With Novell Client support, Windows operations such as domain login, password change, GPO
policy, content redirection, roaming profile, folder redirection, and advanced login parameters will
work.

This feature also enables you to leverage Novell Client features such as login scripts, LDAP
contextless login, login with profile, and automated login. For more information about Novell Client
features, see the Novell Client 2 SP3 for Windows Administration Guide.

Windows 8 Client Support

Beginning with OES 11 SP2, DSfW supports Windows 8 as a client workstation.

Windows 2012 Support

Beginning with OES 11 SP2, DSfW supports Windows 2012 as a member server.

DSfW Install

DSfW install has been modified to not install NSS by default. This is to ensure that the DSfW server is
used only as a domain controller with no other services installed by default. Novell recommends that
you not install other services such as file, print, or iManager on the same server as DSfW.

Script to Address NTP-Signed Requests

NTP-signed requests from Windows clients can now be addressed by using the

cross partition ntp setup.pl script. Execute this script only if /var/1ib/ or /var/opt/
directory hierarchies are in different partitions. For more information, see "DSfW Fails to Set Up
Signed NTP for Clients to Trust" in the OES 11 SP2: Domain Services for Windows Administration
Guide.

What’s New (OES 11 SP1)

Domain Services for Windows in OES 11 SP1 has been modified to run on 64-bit SUSE Linux
Enterprise Server (SLES) 11 SP2. In addition to bug fixes, Domain Services for Windows provides
the following enhancement in the OES 11 SP1 release:

Simplified Install

DSfW installation and configuration using the YaST administrative tool has been modified. The
configuration screens have been reorganized to enable you to deploy a Domain Controller in a fast
and easy manner. DSfW now enables you to deploy a domain controller using the Express Install
option. Express Install minimizes the number of configuration screens and assigns default values for
certain configuration parameters. For more information, see Installing Domain Services for Windows
(http://lwww.novell.com/documentation/oes11/acc_dsfw_Ix/?page=/documentation/oes11/
acc_dsfw_Ix/data/bjcs5rp.html) in the OES 11 SP1: Domain Services for Windows Administration
Guide (http://www.novell.com/documentation/oesll/acc_dsfw_Ix/?page=/documentation/oes11/
acc_dsfw_Ix/data/bookinfo.html).

DSfW AutoYaST Install

DSfW AutoYaST enables you to install DSfW for a new forest domain, new domain in an existing
forest, and new domain controller in an existing domain without any manual intervention. For
information, see Installing DSfW Using AutoYast (https://www.novell.com/documentation/oes11/
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acc_dsfw_Ix/?page=/documentation/oes1l/acc_dsfw_Ix/data/b11i6bnj.html) in the OES 11 SP1:
Domain Services for Windows Administration Guide (http://www.novell.com/documentation/oes11/
acc_dsfw_Ix/?page=/documentation/oes11/acc_dsfw_Ix/data/bookinfo.html)

2.7 What's New (OES 11)

Novell Domain Services for Windows (DSfW) service was modified to support Novell Open Enterprise
Server 11. In addition, the following enhancements are added:

+ Samba Package: The base Samba package and it's related rpm’s are replaced by novell-oes-
samba.
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3.1

3.11

Use-Cases

This section describes some common usage patterns that will help you in understanding the
possibilities and functionalities of DSfW.

+ Section 3.1, “Authenticating to Applications That Require Active Directory-Style Authentication,”
on page 23

+ Section 3.2, “Working With Windows Systems Without Novell Client,” on page 24

+ Section 3.3, “Leveraging an Existing eDirectory Setup,” on page 25

+ Section 3.4, “Interoperability Between Active Directory and eDirectory,” on page 25

Authenticating to Applications That Require
Active Directory-Style Authentication

This use-case can be described using the following scenarios:
¢ Section 3.1.1, “Users Located in the DSfW Forest and Accessing Applications Hosted in the
Active Directory Forest,” on page 23
+ Section 3.1.2, “Users and Applications Hosted in the DSfW Forest,” on page 24

Users Located in the DSfW Forest and Accessing
Applications Hosted in the Active Directory Forest

In this case DSfW is deployed as an interoperable solution for organizations that have both
eDirectory and Active Directory as part of their infrastructure. Most organizations use Active
Directory-enabled applications which means that the application vendor has tested and certified his
application against Active Directory for authentication and management.

By keeping the users in the DSfW forest and the applications in the Active Directory forest,
organizations have the following advantages:

+ Manageability is easier as the users reside on a single directory service and are not spread out.
The company need not invest in network resources that may be required if the users were
spread out.

+ Applications can continue to be certified by the vendors for Active Directory as they are hosted
on an Active Directory infrastructure. With the users residing on DSfW, there is no need to certify
applications.

Figure 3-1 DSfW users Accessing Resources on Active Directory
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for Windows Directory

.

Cross—forest
Users trust Applications

Use-Cases 23



24

3.1.2

3.2

Users and Applications Hosted in the DSfW Forest

The applications in this use case are hosted in the DSfW infrastructure along with the users. This kind
of deployment helps organizations to consolidate their Directory infrastructure.

While most of the application vendors specifically request Active Directory-support, as many
applications are LDAP-enabled, the applications work seamlessly on DSfW.

However, some of the applications that have Active Directory-specific schemas may need additional
effort in terms of schema extensions to work with DSfW.

Figure 3-2 Users and Applications in DSfW Forest

eDirectory

>
' Applications
Users

Domain Services
for Windows

Working With Windows Systems Without Novell
Client

DSfw allows Microsoft Windows users to work in a pure Windows desktop environment and still take
advantage of some OES back-end services and technology, without the need for a Novell Client on
the desktop.

Administrators can either use Novell iManager or Microsoft Management Console (MMC) to
administer users and groups. Network administrators manage file systems using the native tools of
each server, as well as centrally administer Samba shares on OES /DSfW servers using iManager.
Administrators can use MMC to create cross-forest trusts between DSfW domains and Active
Directory domains.

When deployed in an environment that also supports NetWare Core Protocol (NCP), DSfW supports
cross-protocol locking. Whether customers decide to use only Windows clients, NCP clients, or a
combination of both, access rights for files is enforced by the Novell Storage Services (NSS) file
system. Novell Client does not need to be installed and managed as an extra software on the
desktop. This helps in streamlining user experiences in terms of login to the directory and single login
facility to both Active Directory applications and eDirectory services.
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Figure 3-3 Accessing applications without Novell Client
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3.3 Leveraging an Existing eDirectory Setup

If you already have an eDirectory setup but want to install DSfW in your environment, it is
recommended you utilise the existing eDirectory setup and install DSfW in a container in the existing
eDirectory tree. This way you can utilise all the user information in the eDirectory container. This kind
of setup is known as a name-mapped setup.

For more details on name-mapped setup, see Section 5.5.3, “Installation Prerequisites for a Name-
Mapped Setup,” on page 44 and Section 4.2, “Deploying DSfW in a Name-Mapped Setup,” on
page 29

3.4 Interoperability Between Active Directory and
eDirectory

Trust relationships are key to managing Domain Services for Windows (DSfW). To facilitate
communication between Windows and Linux environments you can create a trust to access
resources from another domain. When a domain is installed, a trust is automatically established with
its parent domain.

To assist you in doing this, DSfW supports installing into a new eDirectory tree, an existing eDirectory
tree, or an existing forest, creating multiple DSfW domains, and setting up multiple DSfW domain
controllers within the same domain.

Figure 3-4 illustrates a typical deployment scenario in a mixed Novell/Microsoft environment.
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Figure 3-4 Cross-Forest Trust between Active Directory and DSfW
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The diagram shows an Active Directory forest and a DSfW forest. Within the DSfW forest are two
DSfW servers, an eDirectory SP2 server, and an eDirectory 8.8 SPx server, configured in the same
replica ring. Novell administrators can manage the domain by using iManager connected to any of
these servers, and a Microsoft administrator can use MMC connected to one of the DSfW servers.
The same set of users can access resources from the Active Directory forest through the
establishment of a cross-forest trust, which is a two-way, Kerberos-based, transitive trust between the
two forests.

Within the authentication/authorization boundary (realm) established by DSfW, eDirectory replication
can be used to expand the scope of users and groups that can access resources in a cross-domain
and cross-forest scenario. In the example scenario shown above, users created in eDirectory 8.8 SP2
and above are replicated into the DSfW domain and can therefore access servers in the Active
Directory forest.
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4.1.2

Deployment Scenarios

This section describes deployment scenarios for name-mapped and non-name mapped scenarios:

+ Section 4.1, “Deploying DSfW in a Non-Name-Mapped Setup,” on page 27
+ Section 4.2, “Deploying DSfW in a Name-Mapped Setup,” on page 29

Deploying DSfW in a Non-Name-Mapped Setup

A non-name-mapped setup refers to a setup that includes a new eDirectory Tree and a new DSfW
forest as part of the DSfW installation. Before you start the process of installation, refer Installation
Prerequisites For a Non-Name-Mapped Setup.

The scenarios explained here are only indicative of the various ways in which you can deploy DSfW
server in your environment. Here the tree structure overlaps with the DNS namespace. For instance,
the domain example.com will be mapped to dc=example,dc=com FQDN.

+ Section 4.1.1, “Deploying as a Single Domain,” on page 27

+ Section 4.1.2, “Deploying as Multiple Domains in a Forest,” on page 27

Deploying as a Single Domain

In this scenario, you have a single domain in the DSfW forest and have multiple DSfW servers acting
as domain controllers in the domain.

Figure 4-1 Deploying DSfW as a Single Domain

dc=example, dc=com
-
- .

domain

Domain server 1 server 2 server 3 server 4 server 5
Controllers

In Figure 4-1 the example.com domain is served by 5 domain controllers.

Deploying as Multiple Domains in a Forest

+ “Width” on page 28
+ “Depth” on page 28
+ “Depth and Width” on page 28
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Width

In this scenario, the DSfW forest is spread out in an horizontal manner. You can have each branch
office of the company configured as a separate domain belonging to one single DSfW Forest.

As represented in the figure, example.com is the first domain in the DSfW forest. It represents the
head office of the company and the branch offices are represented by domains, America, India,

Korea, China and Mexico.

Figure 4-2 Deploying DSfW in a Horizontally Spread Tree

example.com

-}
Fmg example.com
=
India Korea China Mexico
- - - -
- - - - - - N -
o= o= = o=
= = ---Bp =

dc=america,dc=example,dc=.com

Depth

In this form of structuring, the tree is vertically structured and you can create different DSfW domains

corresponding to each engineering and support function in the organization.

Figure 4-3 Deploying DSfW in a Vertically Structured Tree

Example

E §= dc=example,dc=com

dc=hr,dc=example,dc=com

dc=finance,dc=hr,dc=example,dc=com

dc=eng,dc=finance,dc=hr,dc=example,dc=com

dc=sales,dc=eng,dc=finance,dc=hr,dc=example,dc=com

Depth and Width

With this combination you get benefits of a tree that is spread both horizontally and vertically. This is
best suited for organizations that have offices locally as well as globally and there is a high

requirement for load processing.
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Figure 4-4 Deploying DSfW in a Combination Structure
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4.2 Deploying DSfW in a Name-Mapped Setup

A name-mapped setup refers to a setup where a new DSfW forest is created on an existing
eDirectory tree using either a part or the entire eDirectory tree. This enables you to utilize all the user
information and other associations in the eDirectory tree. The creation of a DSfW forest into an
existing eDirectory tree starts from a specific container. Association of the DSfW forest to a specific
container is called mapping and the container is called a mapped container. Different DSfW domains
in the DSfW forest are mapped to different DSfW containers. As a prerequisite, the mapped
containers must be partitioned.

Though an already existing eDirectory tree can be used for a name-mapped setup, an OES server
already configured as an eDirectory server cannot be used to create a domain controller for a DSfW
domain. A new server should be added to configure a DSfW domain controller. Before you start the
process of installation, refer Installation Prerequisites for a Name-Mapped Setup.

Figure 4-5 represents an example of a name-mapped setup where an existing eDirectory tree
T=Global has organization type containers America, Asia, and Europe. Consider a scenario where
the container Asia needs to be mapped to a DSfW domain asia.com. As a prerequisite, you must first
partition the Asia container and then introduce a new OES server in your eDirectory tree and install
DSfW pattern. With successful installation and provisioning of DSfW, the container O=Asia becomes
root partition of the DSfW domain. This allows you to utilize all the preexisting users and associations
under the subtree starting from the container Asia.
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Figure 4-5 Deploying DSfW in an Existing eDirectory Tree
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It is also possible to map the partitions underneath O=Asia to a new child domain and skip any levels
of containers underneath. Refer section Section 4.2.1, “Deploying DSfW by Skipping Containers,” on
page 32. So, you can map the OU=India partitioned container to create a new child DSfW domain or
directly map OU=Delhi or OU=Sales partitioned container.

Restrictions
Consider the following restrictions while configuring a name-mapped setup:

+ If you have already mapped a partition to a DSfW domain, then you cannot map the sibling
partitions to create a new DSfW domain. Using the example in Figure 4-5, if you have already
mapped the O=Asia partition, you cannot map the O=America or O=Europe partitions. However,
this restriction is applicable only for the first domain or FRD in a forest. For example, in Figure 4-
5, the sibling containers under Asia (ou=India,ou=China, and ou=Japan) can be configured as
different child domains in the same instance.
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+ Installing DSfW in a tree root partition is not supported.

+ While designing a DSfW tree, you must ensure that the length of the DN does not exceed 255
characters. During provisioning, DSfW creates some objects and length of the DN of these
DSfW-specific objects is included while calculating the length of the DSfW domain's mapped
container. The size of longest default object in a DSfW tree is 144. While calculating the length of
the mapped container, the length of the hostname is also taken into consideration. For example,
if the hostname is myserver, then the mapped container's DN cannot exceed 255-144-8 (length
of the hostname myserver)=103 characters. For more information on provisioning, see
Chapter 7, “Provisioning Domain Services for Windows,” on page 109.

WARNING: If you deploy the forest root domain too deep down in the tree, further child domain
installation may be difficult because the DN mapping range will exhaust.
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42.1 Deploying DSfW by Skipping Containers

After successful mapping of a container to a DSfW domain, you can map any underlying container to
a new DSfW child domain and skip any level of containers in between. For instance, the second level
container from a mapped container can be mapped to the immediate DSfW child domain, thus
skipping the first level container.

Consider a scenario with an eDirectory tree, as represented in the following figure.

Figure 4-6 Existing eDirectory Tree
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As illustrated in Figure 4-7, a domain named asia.com is created which is mapped to the partition
o=asia. Now, you can map the partition ou=bangalore to a child domain named blr.asia.com, by
excluding the partitions between the domains asia.com and blr.asia.com. The child domain excludes
the partition ou=branches. This provides you with an advantage of avoiding an unnecessary server
addition and its management in order to maintain the hierarchy.
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Figure 4-7 Deploying DSfW by Skipping Containers
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4.2.2 Custom Domain Name

DSfW enables you to choose a domain name that need not match the mapped container's typeless
RDN. As illustrated in Figure 4-7, you can map the partition ou=bangalore to a DSfW child domain
named blr.asia.com. Here the domain component blr is used to map a container with typeless RDN
as bangalore.
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5.1

Planning for DSfW

This section describes requirements and guidelines for using the Novell Domain Services for
Windows on a Novell Open Enterprise Server (OES).

IMPORTANT: If your deployment has more than 3 domain controllers or more than 2000 active
users, you must contact Novell Consulting Services or a qualified Novell Partner for Deployment
Assistance.

¢ Section 5.1, “Server Requirements for Installing DSfW,” on page 35
¢ Section 5.2, “Scalability Guidelines,” on page 36

¢ Section 5.3, “Deciding between Name-Mapped and Non-Name-Mapped Installation,” on
page 36

+ Section 5.4, “Extending a Domain Boundary in a Name-Mapped Installation,” on page 39
¢ Section 5.5, “Meeting the Installation Requirements,” on page 41

¢ Section 5.6, “Unsupported Service Combinations,” on page 48

¢ Section 5.7, “Windows Version Support,” on page 49

+ Section 5.8, “Novell Client and Windows Co-existence,” on page 50

¢ Section 5.9, “Administrative Tools,” on page 50

¢ Section 5.10, “Utilities Not Supported in DSfW,” on page 50

¢ Section 5.11, “Limitations,” on page 50

+ Section 5.12, “Restrictions with Domain Names,” on page 51

¢ Section 5.13, “Supported Special Characters in DSfW Passwords,” on page 51
+ Section 5.14, “Enabling Universal Password Policy for DSfW,” on page 51

¢ Section 5.15, “Ensuring Filesystem ACL Support,” on page 52

Server Requirements for Installing DSfW

To install DSfW, you need a server that meets the system requirements for SUSE Linux Enterprise
Server (SLES) 11 SP4 and Open Enterprise Server 11 SP3. For more information, see “Installing
OES 11 SP3 as a New Installation” in the OES 11 SP3: Installation Guide.

You should have access to the installation media for SLES 11 SP4 and OES 11 SP3, either on
physical CD/DVD media or on a networked installation source server. For more information about
installing OES 11 SP3 from an installation source, see “Setting Up a Network Installation Source” in
the OES 11 SP3: Installation Guide

NOTE: Ensure that only root account is created during the SLES installation because administrator or
other Active Directory account names can conflict with the DSfW users.
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5.2 Scalability Guidelines

This section describes the scalability guidelines that can assist you in planning your production
environment for DSfW. The following guidelines can enable you to achieve optimal results for your
specific environment:

+ |f the number of users in your environment is high (in thousands), it is recommended to use a
dedicated server such as the Novell CIFS server for your file server needs. In such scenarios,
the DSfW server should be used only as a domain controller managing domain logins.

+ The number of domain controllers allocated per domain should depend on the number of domain
users and domain logins made to a domain. For example, if the number of concurrent user
domain logins is low, then fewer domain controllers are required. Otherwise, a high number of
simultaneous domain logins necessitates the use of increased number of domain controllers.

+ Load balancing and fault tolerance needs also determine the number of domain controllers
allocated per domain. The guidelines for load balancing and fault tolerance should be applied to
deduce the number of domain controllers allocated per domain.

+ For enterprises that are spread across different geographical locations or that span different
functions, you should configure separate domains for each geographical location or function. For
each geographical location or function, you should have a dedicated domain that meets the
needs of the particular geographical location or function. Having a dedicated domain helps in
reducing the traffic between different geographical locations or functions.

+ If you have multiple domains in your enterprise, you can use depth-wise or width-wise
deployment. However, for depth-wise deployment, you must ensure that the length of the DN
does not exceed 255 characters. For more information on this restriction, refer to “Restrictions”
on page 30.

5.3 Deciding between Name-Mapped and Non-Name-
Mapped Installation

Name-Mapped Installation: Installing DSfW in a name-mapped setup means you are installing
DSfW in an existing eDirectory tree inside a specific container.Before you install DSfW in an existing
container, the container must be partitioned. In Figure 5-1 the existing container Asia is mapped to
create a DSfW forest. After the mapping, all of the containers below the O= Asia container become
part of the DSfW forest.If you have mapped an existing container to a domain, you cannot map the
sibling containers to create a domain. Using the example in Figure 5-1, if you have already mapped
the O=Asia container, you cannot map the O=America or O=Europe containers. However, this
restriction is applicable only for the first domain or FRD in a forest.On the other hand, it is possible to
map the containers underneath O=Asia to a domain.It is not possible to map the tree root partition to
create a DSfW forest.

IMPORTANT: In name-mapped installations, you install DSfW in an existing eDirectory tree inside a
specific container. However, DSfW must be installed on a separate server and not on the server
where eDirectory is installed.
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Figure 5-1 Name-Mapped Installation

T=Global
)T
| | |

America Asia Europe
N
N
B R
India China Japan
©-0- -
Delhi Bangalore

’Eou ’ﬁ‘ou
Sales Finance Sales Finance

Non-Name-Mapped: In case of installing DSfW in a non-name-mapped setup, you are setting up a
new tree in a DSfW forest. Here the tree structure overlaps with the DNS namespace.
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5.3.1

Figure 5-2 Non-Name-Mapped Installation

o=acme
Geographic dc=amerc dc=pacrim dc=europe
(Regional)
Geographic dc=tkyo dc=hnkg dc=lon dc=par
(Location)
= - = - = - = -
HEH HEH HEH HEH
dc=hr dc=sales
Operational
LT B

WARNING: A combination of hon-name-mapped and name-mapped domain installations is not
supported in a single DSfW forest. For example, you cannot install a name-mapped domain in a non-
name-mapped installation scenario. To resolve issues arising out of such unsupported scenarios, you
need to remove and then re-create the domain with the correct installation type.

Impact of a Name Mapped / Non-Name-Mapped setup on a
Tree

This section analyses the various options of setting up a DSfW tree and the associated limitations.

+ “Using a Pyramid Design” on page 38
+ “Using a Flat Design” on page 38

Using a Pyramid Design

With a forest designed in the form of a pyramid, managing and initiating changes to large groups, and
creating logical partitions are easier. This structure is best suited for large organizations with
operations spread out across the globe.

Using a Flat Design

The alternative to the pyramid design is a flat tree that places all objects at one level of the tree.
However, the flat tree design is not supported in DSfW. DSfW can have only one top level domain and
all the other domains need to be organized underneath the top level domain.If you have mapped an
existing container to a domain, you cannot map the sibling containers to create a domain. It is also
not possible to partition the root container and map it to create a DSfW forest.

For more information, see Designing the eDirectory Tree (https://www.netiq.com/documentation/
edir88/edir88/?page=/documentation/edir88/edir88/data/aziiidp.html)
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5.4 Extending a Domain Boundary in a Name-Mapped
Installation

DSfw enables you to map multiple partitions to a domain. You can extend the partition of a domain by
adding existing partitions to it. When you add an existing partition to the domain, the associated users
and groups become a part of the DSfW domain. You can map multiple partitions to a domain either
during DSfW provisioning or after the provisioning. To map multiple partitions to a domain post
provisioning, see Extending the Domain Post Provisioning.

IMPORTANT: Consider the following guidelines:

+ If you are extending the domain partition of a domain, ensure that all the domain controllers of
the domain are running on OES 11 or later.

+ |If a DSfW forest has multiple domains and you want to extend the domain partition of a domain,
you must ensure that all the domains of the DSfW forest are on OES 11 or later. Otherwise,
cross domain access and authentication will not work.

+ If you have already mapped a partition to a DSfW domain, then you cannot map the sibling
partitions to create a new DSfW domain. However, this restriction is applicable only for the first
domain or FRD in a forest.

54.1 Prerequisite

After completing the DSfW configuration and before initiating the provisioning process, you must
ensure that the required replicas are present on the local server. However, for ADC installation,
ensure that all replicas that are already part of the domain are present on the local server.

NOTE: The supported replica type is either read-write or master.

54.2 Use Case Scenario

Consider a scenario where you have an existing eDirectory tree with ou=example,o=organization as
the partition and you want to map this partition to the example.com domain.

NOTE: The RDN of the mapped partition need not match the domain name. For instance, the
partition ou=example,o=organization can be mapped to dsfw.com.

Along with the ou=example,o=organization partition, there are some additional partitions such as
ou=finance,ou=example,o=organization and ou=sales, ou=example,o=organization, that need to be
mapped to the example.com domain. To add these partitions to the domain:

1 After the DSfW configuration is complete, launch the Provisioning Wizard by selecting the DSfw
Provisioning Wizard option from YaST. Alternatively, you can execute the following script at the
command prompt: /opt/novell/xad/sbin/provision dsfw.sh.

2 Enter the authentication details in the login dialog box, depending on the scenario in which you
are provisioning.
3 To customize provisioning, select the Enable Custom Provisioning check box, then click OK.
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¥ () DSfW Server Authentication

I
©)
©
)

Domain Admin Mame : cn=administrator,cn=users, ou=example, o=organization

Domain Admin Password : [

Tree Admin Name : ch=admin, o=0rganization

Tree Admin Password : "

[] Enable Custom Provisioning

o |[_coma |

4 Select the partitions that you want to map to the domain. When you select a partition, validation
checks are performed on the partition before mapping it to the domain. In this example, select
the partitions ou=finance, ou=example,o=organization and ou=sales,
ou=example,o=organization.

] () DSAW Provisioning Wizard ——— ™) (x)
Domain Preparation Domain Partition Mapping
Enables wou to do custom [Enahles wau to specify the partitions to be mapped to the domain. The domain root
modifications before starting \partition is mapped by default and cannot be deselactad.

the provisioning process,

The modifications made during
Diomain Preparation serves as
an input to the prowisioning
process.

Select partitions from the list

[v] ®18 ou=example,o=arganization
g ou=finance,ou=exarmple,o=organization

“8 [ou=sales ou=example o=organization|

o | [ ]

5 Click Next to continue with the DSfW provisioning process.
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5.4.3

5.5

5.5.1

Caveat

While selecting the partitions, you must ensure that there is no gap between the partitions. If you
select partitions that introduce gaps, partitions in between will also be selected automatically.

Meeting the Installation Requirements

Before you start the process of installation, ensure you have met the following prerequisites. These
steps can be used to validate the state of the system before beginning the installation process.

+ Section 5.5.1, “Resolving Samba Dependencies on Selecting DSfW Patterns,” on page 41

¢ Section 5.5.2, “Installation Prerequisites For a Non-Name-Mapped Setup,” on page 42

+ Section 5.5.3, “Installation Prerequisites for a Name-Mapped Setup,” on page 44

Resolving Samba Dependencies on Selecting DSfW
Patterns

Beginning OES 11, the base samba packages are replaced with novell -oes-samba packages. Whil
installing DSFW pattern, a dialog box is displayed that prompts you to replace base sles samba
packages. You must select the option to replace the existing samba rpm's with novell-oes-samba.

4.. Warning x
& pattern:novell-domain-services-11-129.1.x86_64 requires novell-oes-samba,
uninstallable providers: novell-oes-samba-3.4.3-1.19.1 %86 _G4[Preview4]
Cunﬂmt resolution:
' Following actions will be done:
replacement of samba-2.4.3-1.19.1.xB&_&4 with novell-oes-samba-3.4.3-1.19.1. 486
replacement of cifs-mount-2.4.3-1.19.1. %86 _84 with novell-oes-samba-cifs-mount-3.
replacement of samba-client-3.4.3-1.15.1. X86 _ B4 with novell-oes-samba-client-3.4 .2
replacement of libsmbclientd-32.4.3-1.19.1. x86_64 with novell-oes-samba-libsmbclie
replacement of libtalloc1-3.4.3-1.19.1 . x86_&4 with novell-oes-samba-libtalloc1-3.4.3
replacement of libtdh1-3.4.3-1.19.1. x86_64 with novell-oes-samba-libtdb1-3.4.3-1.1¢
replacement of libwbclientd-3.4.3-1.19.1. ¥BE_64 with novell-oes-samba-libwhbclientd:

) do not install pattern:novell-domain-semnvices-11-129.1.x86_64

' break novell-domain-services by ignoring some of its dependencies

[

[ B

| oK - TryAgain | | Expert v || cancel
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5.5.2 Installation Prerequisites For a Non-Name-Mapped Setup

+ “Domain Name and Name Server Configuration is Correct” on page 42
+ “DNS Server is Installed” on page 44
+ “Time is Synchronized” on page 44

+ “Server State in the Replica Ring” on page 44

Domain Name and Name Server Configuration is Correct

Before installing DSfW, ensure the domain name is entered correctly in YaST. To verify and correct
the domain name, do the following:

1 Open YaST>Network Devices>Network Settings. Select the Hostname/DNS tab.

NOTE: You must ensure that the hostname in the properties of the active ethernet controller is a
FQDN. For example, if the hostname in the Hostname/DNS tab is dsfw-dc1 and domain name is
dsfw.com, then the hostname of the active ethernet controller must be dsfw-dcl.dsfw.com. You

can modify the hostname of the active ethernet controller by using the Edit option in the
Overview tab.

8 (O YaST2@es-dth-12 <@cs-dth-12> — e ®
) Network Settings
| Global Options | Overview Hostname/DNS Routing |

Hostname and Domain Name

Hostname Domain Name

|dstw-dc1 | |dstw.com

[ 1 Change Hostname via DHCP Mo interface with dhcp
[ 1 Assign Hostname to Loopback IP

Modify DNS configuration  Custom Policy Rule

[Use Default Policy |v] [ |v|

~MName Servers and Domain Search List

MName Server 1 Domain Search
[192.168.1.155 | |dsfw.com

Name Server 2

[ l

Name Server 3

2 Verify that the domain name is correct.
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3 Ensure that you follow the guidelines given below to configure the name server on a DSfW

domain controller:

+ While configuring the forest root domain, for DNS name resolution during installation, the

name server must point to a valid DNS server. After the DSfW server is configured
successfully, the forest root domain controller will always act as the DNS server for the first

DSfW domain. To ensure that the forest root domain DNS sever resolves other existing

domains in your environment, complete the necessary forwarder settings.

+ To configure the subsequent DSfW domain controllers or DSfW domains, the Name Server
1 entry must point to the forest root domain's IP address.

+ If the existing DNS infrastructure is running on Novell OES DNS server and the zone for the

DSfW domain being configured is already existing, the DSfW configuration has the built-in
capability to extend the existing zone. Ensure that the correct DNS-DHCP locator object is

specified during DSfW configuration in YaST. For more information, see Step 17.

s (O YaST2@ecs-dth-12 <@cs-dth-12> ® @
) Network Settings
| Global Options | Overview Hostname/DNS Routing |
Hostname and Domain Name
Hostname Domain Name
| america-dc2 | | america.dsfw.com
[1 Change Hostname via DHCE  No interface with dhep
[ Assign Hostname to Loopback IP
Maodify DNS configuration  Custormn Folicy Rule
| Use Default Policy |v| [ |v |
~MName Servers and Domain Search List
MName Server 1 Domain Search
[192.168.1.155 | |dsfw.com
Name Server 2
MName Server 3
Help | | Cancel | | Back H QK |

IMPORTANT: In case of installation of a child domain, make sure you specify the name of the

parent domain in the Domain Search field for resolving hostnames.

4 Click OK to save the changes.
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DNS Server is Installed

In a default configuration, there is only one DNS server in a DSfW forest which is the first domain
controller of the first DSfW domain. You must ensure that the DNS configuration (/etc/resolv.conf) of
all domain controllers in all domains of a DSfW forest point to this DNS server. This applies to all
workstations or member servers joined to any DSfW domain.

To split the DNS information across a domain, you must do the following:
+ For every DSfW domain that is configured, specify one or more domain controllers of a given
domain to host the DNS server.

+ Ensure that all the workstation or domain servers joined to a particular domain point to one of the
DNS servers hosting the domain.

+ After the DNS information is split, verify that any name or address resolution to all domains of a
DSfW forest works fine. To verify this, you must set up two-way forwarders between the DSfW
domains.

Time is Synchronized

Ensure time is synchronized between all servers in the replica ring by executing the following
command:

ndscheck -a <bind dn> -w <passwords>

This command in addition to displaying partition and replica health also displays time difference
between servers in the replica ring. If you observe a time difference between the server, ensure that
all the servers in the replica ring are referencing the same NTP server. After this is done, restart the
NTP server by using the rcntp restart command.

Server State in the Replica Ring

Verify that the state of the servers in the replica ring is On by executing the following command:
ndsstat -r

The ndsstat utility displays information related to eDirectory servers, such as the eDirectory tree
name, the fully distinguished server name, and the eDirectory version.

5.5.3 Installation Prerequisites for a Name-Mapped Setup

In case of a name-mapped installation, you are installing DSfW in an existing tree. To ensure the
installation does not encounter errors, make sure you meet the following prerequisites:

+ “Domain Name and Name Server Configuration is Correct” on page 45

+ “eDirectory Version” on page 46

+ “Container is Partitioned” on page 46

+ “DNS Server is Installed” on page 47

+ “Time is Synchronized” on page 47

+ “Schema is Synchronized” on page 47

+ “Server State in the Replica Ring” on page 47

+ “Permissions for Objects” on page 47

+ “Container Names” on page 48
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Domain Name and Name Server Configuration is Correct

Before installing DSfW, ensure the domain name is entered correctly in YaST. To verify and correct
the domain name, do the following:

1 Open YaST>Network Devices>Network Settings. Select the Hostname/DNS tab.

NOTE: You must ensure that the hostname in the properties of the active ethernet controller is a
FQDN. For example, if the hostname in the Hostname/DNS tab is dsfw-dcl and domain name is
dsfw.com, then the hostname of the active ethernet controller must be dsfw-dc1.dsfw.com. You

can modify the hostname of the active ethernet controller by using the Edit option in the
Overview tab.

s () YaST2@cs-dth-12 <@cs-dth-12> ®E ®
&) Network Settings

| Global Options | Owenview Hostname/DNS Routing |
Hostname and Domain Name

Hostname Domain Name

|d9fw—dct | | dsfw.com
1 Change Hostname via DHCP  No interface with dhep
[ | Assign Hostname to Loopback IP

Modify DNS configuration  Custom Policy Rule
IUse Default Policy |v| [ |v|
~Name Servers and Domain Search List
MName Server 1

[192.168.1.155 |

Domain Search

dsfw.com

Name Server 2

l l

MName Server 3

| Help |

Cancel || Back

2 Verify that the domain name is correct.

3 Ensure that you follow the guidelines given below to configure the name server on a DSfW
domain controller:

+ While configuring the forest root domain, for DNS name resolution during installation, the
name server must point to a valid DNS server. After the DSfW server is configured
successfully, the forest root domain controller will always act as the DNS server for the first
DSfwW domain. To ensure that the forest root domain DNS sever resolves other existing
domains in your environment, complete the necessary forwarder settings.
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+ To configure the subsequent DSfW domain controllers or DSfW domains, the Name Server
1 entry must point to the forest root domain's IP address.

+ [f the existing DNS infrastructure is running on Novell OES DNS server and the zone for the
DSfW domain being configured is already existing, the DSfW configuration has the built-in
capability to extend the existing zone. Ensure that the correct DNS-DHCP locator object is
specified during DSfW configuration in YaST. For more information, see Step 17.

&) () YaST2@cs-dth-12 <@cs-dth-12> M@ ®
&) Network Settings
| Global Options | Owenview Hostname/DNS Routing |

Hostname and Domain Name

Hostname Domain Name

| america-dc2 | | america.dsfw.com

1 Change Hostname via DHCP  No interface with dhep
[ | Assign Hostname to Loopback IP

Modify DNS configuration  Custom Policy Rule
IUse Default Policy |v| [ |v |
~Name Servers and Domain Search List
MName Server 1 Domain Search
[192.168.1.155 | |dsfw.com

Name Server 2

l l

MName Server 3

Help | | Cancel || Back |

IMPORTANT: In case of installation of a child domain, make sure you specify the name of the
parent domain in the Domain Search field for resolving hostnames.

4 Click OK to save the changes.

eDirectory Version

Before installing DSfW, ensure that the eDirectory version is 8.8 SP2 or greater. You must also
ensure that the eDirectory version of the servers holding the writable replica of the tree root partition
is 8.8 SP2 and above.

Container is Partitioned

The container in which you are installing DSfW must be partitioned.
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DNS Server is Installed

In a default configuration, there is only one DNS server in a DSfW forest which is the first domain
controller of the first DSfW domain. You must ensure that the DNS configuration (/etc/resolv.conf) of
all domain controllers in all domains of a DSfW forest point to this DNS server. This applies to all
workstations or member servers joined to any DSfW domain.

To split the DNS information across a domain,you must do the following:

+ For every DSfW domain that is configured, specify one or more domain controllers of a given
domain to host the DNS server.

+ Ensure that all the workstation or domain servers joined to a particular domain point to one of the
DNS servers hosting the domain.

+ After the DNS information is split, verify that any name or address resolution to all domains of a
DSfW forest works fine. To verify this, you must set up two-way forwarders between the DSfW
domains.

Time is Synchronized

Ensure time is synchronized between all servers in the replica ring by executing the following
command:

ndscheck -a <bind dn> -w <passwords>

This command in addition to displaying partition and replica health also displays time difference
between servers in the replica ring. If you observe a time difference between the server, ensure that
all the servers in the replica ring are referencing the same NTP server. After this is done, restart the
NTP server using the rentp restart command.

Schemais Synchronized

Ensure the schema is synchronized on all the servers in the replica ring by executing the following
command on all the servers:

ldapsearch -b cn=schema -s base -x attributetypes=<schema attributes>
Substitute the schema attribute value with an attribute you have used in the schema.

For example: ldapsearch -b cn=schema -s base -x attributetypes=xad-domain-flag

Server State in the Replica Ring

Verify that the state of the servers in the replica ring is On by executing the following command:
ndsstat -r

The ndsstat utility displays information related to eDirectory servers, such as the eDirectory tree
name, the fully distinguished server name, and the eDirectory version.

Permissions for Objects

When you are installing in a name-mapped setup, ensure that you have adequate permissions for the
following objects in the tree:

+ Container that is being provisioned
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+ Permissions for DNS Locator and Group objects
+ Permissions to the Security container
+ Modify permissions to the NCP servers holding replica of the master server

Container Names

When you are installing DSfW, it creates few default containers. Make sure that the following
container names do not already exist under the domain partition:

¢ cn=Computers

+ cn=Users

+ ou=Domain Controllers

+ cn=DefaultMigrationContainer

+ cn=Deleted Objects

¢ cn=ForeignSecurityPrincipals

¢ cn=Infrastructure

¢ cn=LostAndFound

¢ cn=NTDS Quotas

¢ cn=Program Data

+ cn=System

+ cn=Container

5.6 Unsupported Service Combinations

IMPORTANT: Do not install any of the following service combinations on the same server as DSfW.
Although not all of the combinations cause pattern conflict warnings, Novell does not support any of
the following combinations:

+ File Server (SLES 11 - Samba)
+ Novell AFP

+ Novell Archive and Version Services
+ Novell CIFS

+ Novell Cluster Services (NCS)
+ Novell FTP

+ Novell iFolder

+ Novell NetStorage

+ Novell Pre-Migration Server

+ Novell QuickFinder

+ Novell Samba
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5.6.1

5.7

Installing Other Products in the DSfW Partition

Novell doesn't support installing other Novell products within a Domain Services for Windows (DSfW)

partition.

Some products might be supported in name-mapped implementations of DSfW. Consult the product
documentation (http://www.novell.com/documentation) and the Novell Support site (http://
www.novell.com/support) for confirmation before attempting such installations.

You should assume that an installation is not supported unless these sources indicate otherwise.

NOTE: This section refers to Novell products that are not included with OES, such as GroupWise. It
doesn’t apply to services included with OES, such as Novell iPrint.

Limitations for installing OES services on the same server are outlined in Section 5.6, “Unsupported
Service Combinations,” on page 48.

Windows Version Support

The following table lists the version of Windows that is supported with DSfW:

Table 5-1 Windows Version Support

OES Version Member Cross Forest Trust
Compatibility
Server Client
OES 11 Microsoft Windows 2003 Microsoft Windows 7 and SP1  Microsoft Windows 2003
Server SP1 and SP2 ) i Server SP1 and SP2 at the
) ) Microsoft Windows XP SP1,  \vindows Server 2003 forest
Microsoft Windows 2008 SP2, and SP3 functional level
Server SP1 and SP2
Microsoft Windows 2008 R2
Server SP1
OES 11SP1 Microsoft Windows 2003 Microsoft Windows 7 and SP1 Microsoft Windows 2003
Server SP1 and SP2 ) ) Server SP1 and SP2 at the
) ) Microsoft Windows XP SP1,  windows Server 2003 forest
Microsoft Windows 2008 SP2, and SP3 functional level
Server SP1 and SP2
Microsoft Windows 2008 R2
Server SP1
OES 11SP2 Microsoft Windows 2003 Microsoft Windows 7 and SP1 Microsoft Windows 2003

Server SP1 and SP2

Microsoft Windows 2008
Server SP1 and SP2

Microsoft Windows 2008 R2
Server SP1

Microsoft Windows 2012

Microsoft Windows 2012 R2

Microsoft Windows XP SP1,
SP2, and SP3

Microsoft Windows 8

Microsoft Windows 8.1

Server SP1 and SP2 at the
Windows Server 2003 forest
functional level
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NOTE: Windows Server 2003 R2 as a member server is not supported.

5.8 Novell Client and Windows Co-existence

The following table lists the version of Novell Client and Windows that can co-exist.

Table 5-2 Novell Client and Windows Co-existence

OES Version Novell Client Version Windows Version
OES 11 SP2 Novell Client 2 SP3 Windows 7 and SP2
Windows 8

5.9 Administrative Tools

The following administrative tools are supported in DSfW.:

¢ Section 5.9.1, “Windows Administration Tools,” on page 50
¢ Section 5.9.2, “Linux Administration Tools,” on page 50

59.1 Windows Administration Tools

From a Windows workstation the only tool supported to administer DSfW is Microsoft Management
Console (MMC).

5.9.2 Linux Administration Tools

For managing DSfW server, use iManager.

5.10 Utilities Not Supported in DSfW

The following eDirectory utilities are not supported on a DSfW server

+ |dif2dib - Utility to load data in to the eDirectory server
+ ndsmerge - Utility to merge two eDirectory trees.

5.11 Limitations

Consider the limitations in this section when planning to install DSfW.

¢ Section 5.11.1, “Hostname,” on page 51
+ Section 5.11.2, “NetBIOS Names,” on page 51

+ Section 5.11.3, “Installation Issue,” on page 51
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5.11.1 Hostname

If the hostname of a primary domain controller or an additional domain controller (ADC) has more
than 15 characters, you must ensure that the first 15 characters of a new ADC that is added to the
domain is different from the first 15 characters of the primary domain controller or any existing ADC in
the domain. Not complying with this guideline will lead to failure in provisioning of the new ADC.

5.11.2 NetBIOS Names

The NetBIOS names are automatically configured from the DNS name you provide for the domain
during the DSfW installation. We recommend you to not change the NetBIOS name.

In case you need to change the NetBIOS names, avoid using the following names:

+ security

+ schema

+ linkengine

+ administrator
+ ndsschema

+ ndscontainer

5.11.3 Installation Issue

DSfW cannot be installed on a server that is already running as an OES server. To install DSfW, you
must do a fresh install of OES.

5.12 Restrictions with Domain Names

Domain names that end with .1ocal are not supported with DSfW. For instance, avoid specifying a
domain name such as example.local. This is because when a domain hame ends with .1ocal, the
.local top level domain is regarded as a link-local domain and the DNS queries are sent to a
multicast address instead of a normal DNS request.

5.13 Supported Special Characters in DSfW Passwords

You may use the following special characters while specifying passwords for eDirectory tree
administrator or domain administrator during DSfW install:

/28 () -{}[]~&"%@

5.14 Enabling Universal Password Policy for DSfW

As part of DSfW provisioning, the Universal Password Policy is enabled on the patrtition that is being
mapped to a domain. This is extended to cover all the partitions that are mapped to a particular DSfW
domain.

However, if the Universal Password Policy is already enabled in your environment and if you don't
want to override it, then you must select the Retain existing Novell Password Policies on Users
check box during DSfW installation. Selecting this check box will mean that the already enabled
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2.15

Universal Password Policy in your environment is applicable to all the partitions that is being planned
to be mapped to a particular DSfW domain. If you do not select this check box, then the users
belonging to a partition (mapped to a DSfW domain) that does not have Universal Password Policy
defined, will not be able to login to the DSfW domain.

For Universal Password Policies defined in your DSfW environment, you must ensure that you select
the Synchronize Distribution Password when setting Universal Password check box in Novell
iManager.
1 Start a browser and point to http:// ip address of server/nps/iManager.html.
For example, http://192.168.1.1/nps/iManager.html.

2 Accept the certificate, enter the Administrator account/password and eDirectory tree, and click
Login.

3 Select Passwords > Password Policies.
4 Click the password policy, then click Universal Password > Configuration Options.
5 Select the Synchronize Distribution Password when setting Universal Password check box.

If you do not select this check box, you will experience password synchronization issues.

Ensuring Filesystem ACL Support

Ensure that the user xattr option is set for the filesystem on which /var resides. If the user xattr
option is not set, then the sysvol ACLs will be missing on /var/opt/novell/xad/sysvol directory
and users will not be able to access sysvol. For more information, refer to the mount (8) manpage.
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6.1

6.1.1

6.1.2

Installing Domain Services for Windows

This section describes how to install and configure Domain Services for Windows (DSfW). You can
install DSfW by using the YaST administrative tool or using the AutoYaST feature.

+ Section 6.1, “Installing and Configuring DSfW Using the YaST Administrative Tool,” on page 53
+ Section 6.2, “Installing DSfW Using AutoYaST,” on page 93

Installing and Configuring DSfW Using the YaST
Administrative Tool

This section describes how to install and configure DSfW using the YaST administrative tool. It covers
the following topics:

+ Section 6.1.1, “Prerequisites for Installation,” on page 53

¢ Section 6.1.2, “Installation Scenarios,” on page 53

+ Section 6.1.3, “Express Installation,” on page 92

+ Section 6.1.4, “Using a Container Admin to Install and Configure DSfW,” on page 92

Prerequisites for Installation

Before you proceed with the installation, please review the details in “Planning for DSfW” on page 35.

Installation Scenarios

DSfW can be installed in the following scenarios:

+ ‘“Installing a Forest Root Domain” on page 53
+ ‘“Installing a Child Domain” on page 66
+ “Installing DSfW as an Additional Domain Controller in a Domain” on page 79

Installing a Forest Root Domain

1 Inthe YaST install for OES, on the Software Selections page, ensure that Novell DNS is
selected. Then select the Novell Domain Services for Windows pattern.

Pattern deployment provides patterns for different services. Selecting a pattern automatically
selects and installs its dependencies.

For information about the entire OES installation process, see the OES 11 SP3: Installation
Guide.

2 Click Accept.
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3 Select the type of Domain Services for Windows configuration you want:

|| YasT2 — 8 X

Domain Services for Windows Configuration

Important

All Deployments
*ou must properly prepare your system before installing Domain Sewvices for Windows (DSAW).
* Be sure to read and comply with the DSfW Best Practices Guide available at
[ https:/fwww. novell. com/products/openenterpriseserver/features/domain-semvices-windows. html ].

Large Deployments
If your deployment has
* Iore than 3 Domain Controllers
or
* Iore than 2,000 active users
You should contact Novell Consulting Services or a qualified Movell Partner for deployment assistance.

Movell Support might require Movell Consulting or Movell Partner involvernent before opening or
continuing with service requests.

[ I have read these recommendations and reviewed the DSAW Best Practices Guide.

Select Server Type:

@ Mew Domain Services for Windows Forest

) New Domain in an existing Domain Services for Windows Forest
' New Domain Controller in an existing Domain Services for Windows Domain
[ Express Install

Recommended only for default configurations.

| Hep | |  Back | | Aport |

3a To install a forest root domain (FRD), select the New Domain Services for Windows Forest
option.

3b Select the Express Install option to deploy a domain controller by automatically populating
certain YaST configuration fields. For more information, see Section 6.1.3, “Express
Installation,” on page 92.

3c Click Next.

4 On the eDirectory configuration page, choose whether to install into an existing eDirectory tree
or create a new tree.
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eDirectory Configuration - New or Existing Tree

MNew or Existing Tree
@ New Tree
) Existing Tree

eDirectory Tree Name

FRD-TREE

W] Use eDirectory Certificates for HTTPS Services
W Reguire TLS for Simple Binds with Password

W Install SecretStore

Help | Back | [ Aport | | Mext

New Tree: Select the New Tree option if this is the first server to go into the tree or if this server
requires a separate tree. Keep in mind that this server will have the master replica for the new
tree, and that users must log in to this new tree to access its resources.

Existing Tree: Select the Existing Tree option if you want to incorporate this server into an
existing eDirectory tree. This server might not have a replica copied to it, depending on the tree
configuration.

Use eDirectory Certificates for HTTPS Services: Select Use eDirectory certificates for
HTTPS Services if you want your OES services that provide HTTPS connectivity to use the more
secure eDirectory certificates instead of the self-signed certificates created by YaST.

Require TLS for Simple Binds with Password: Select the Require TLS for Simple Binds with
Password option if you want to disallow clear passwords and other data.

By default, the Transport Layer Security (TLS) and Secure Sockets Layer (SSL) protocols are
not enabled in Active Directory.

Install SecretStore: Select Install SecretStore if you want to eliminate the need to remember or
synchronize all the multiple passwords required for accessing password-protected applications.

5 Click Next to continue.

6 Specify information to access the existing eDirectory tree.

This screen is displayed only of you select the Existing Tree option in Step 4.
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eDirectory Configuration - Existing Tree Information

IP Address of an existing eDirectory server with a replica

[188.168.1.10

Enter NCP Port on the existing server

524 l2

Enter LDAF Fort on the existing semwer

Enter Secure LDAP Fort on the existing semver

|636 B

FDN of the tree administrator (e.g. cn=admin,o=navell)

|cn:Admin,o:noveIl |

Admin Password

—

Help | | Back | | Aot | Next

6a Specify the IP address of an existing eDirectory server.
6b Do not change the NCP Port, LDAP Port, and Secure LDAP Port information.

6c Specify the tree admin credentials for the administrator to log in to the eDirectory tree. For
information about the special characters that you can use while specifying the password,
see Section 5.13, “Supported Special Characters in DSfW Passwords,” on page 51.

6d Click Next.
7 Specify the Domain Name and NetBIOS information:
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Domain Services for Windows Configuration - Domain and NetBIOS Name

DNS Name for New Domain
labs. birnovell.com

v

NetBI0s Domain Mame
LABS

[[J Configure this server as a WINS Server

Site Mame of Domain Controller

Default-First-Site-Mame

| Hep | Back | | Avort |

DNS Name for New Domain: The DNS name for the new domain is automatically populated
based on the Hostname and DNS configuration settings.

You must ensure that the host name in the properties of the active Ethernet controller is an
FQDN. For example, if the host name is dcl and the domain name is dsfw.com, then the host
name in the YaST > Network Devices > Network Settings > Hostname/DNS tab of the active
Ethernet controller must be dcl.dsfw.com. You can modify the host name of the active Ethernet
controller by using the Edit option in the Overview tab of the LAN settings in YaST.

Configure this Server as a DNS Server: If you want this server to be a DNS server for the
domain, select the Configure this server as a DNS Server option. If this option is not selected,
you must ensure that a DNS server that contains the domain names for Domain Services for
Windows is available somewhere in the network.

NetBIOS Domain Name: The NetBIOS Domain name is automatically populated based on the
Hostname and DNS configuration settings.

By default, this is the domain context name without the parent context. For example, in the
cn=central,dc=example,dc=com domain, the default NetBIOS name is central.

Configure this machine to be a WINS server: If you want this server to be a WINS server,
select the Configure this machine to be a WINS server option. For more information about
WINS, see Chapter 15, “Configuring DSfW Server as a WINS Server,” on page 169.

Site Name of Domain Controller: Default-First-Site-Name is specified as the site name by
default. To create a new site, specify the site name or click Browse to specify a site from the list
of sites. For more information about sites and subnets, see Chapter 16, “Configuring Sites and
Subnets,” on page 175.

Specify details to map the existing eDirectory container to the new domain.
This screen is displayed only of you select the Existing Tree option in Step 4.
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| YasST2 - o X

eDirectory Configuration - New Domain Information

New Domain Administrator Name
cn=Administrator cn=Users.dc=labs.dc=blr. dc=novell. dc=com

Specify Administrator Fassword

[ ]

Werify Administrator Password

[ _|

Enter the FDM of the container that needs to be mapped as labs.birnovell.com (e.g. ou=domain, o=novell)

[ | | Browse

[[] Retain existing NMAS password policies

| Hep | | Back | | oAbt | | Next |

Specify the domain administrator password in both fields. For information about the special
characters that you can use while specifying the password, see Section 5.13, “Supported
Special Characters in DSfW Passwords,” on page 51.

The administrator name is hard-coded. However, after you finish DSfW installation and
configuration (post provisioning), you can modify administrator details such as the administrator
name. For more information, see Section 8.2, “Renaming Administrator Details Using MMC,” on
page 138.

FQDN of the eDirectory Container: Specify the Fully Qualified Domain Name of the existing
eDirectory container that you want to be mapped to the new domain.

IMPORTANT: A DSfW domain can only be created in Organization (O), Organizational Unit
(OU) and Domain Component (DC) containers. Installing a name-mapped domain to map
Country and Locality containers is not supported. However, you can map O and OU under these
containers.

Retain Existing NMAS Password Policies: If you select the Retain existing NMAS Password
Policies option, the password policies assigned to the users within the container that is mapped
to the new domain do not change. However, the password policies outside the partition boundary
are not carried forward. You need to create a new password policy assigned to the partition root.
For details on creating a new password policy, see “Creating Password Policies”. For information
about default password policy settings for DSfW, see Appendix D, “DSfW Password Palicy
Attributes,” on page 265.

Specify a reliable Network Time Protocol (NTP) provider.

eDirectory requires that all servers in a tree be time-synchronized. To add multiple time servers
to the list of NTP servers, click the Add button and specify the IP address or DNS host name of
the NTP server. In a single-server scenario, you can select the Use local clock check box and
specify the local machine as the NTP provider.
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| YasST2 - o X

eDirectory Configuration - NTP

Network Time Protocol (NTP) Servers

Time Servers

Use local clockl

10 Click Next.

NOTE: If you are using the Express install, Step 11 through Step 17 are not displayed.
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11 Specify the settings to configure the local server in the eDirectory tree:

eDirectory Configuration - Local Server Configuration

Semver Context

Directory Information Base (DIB) Location

Browse

arlopinovellieDirectorydataldib]

Enter LOAP Port

Enter Secure LDAP Part

l

Enter iMonitor Port

[8028

Enter Secure iMonitor Port

[8030

Help |  Back |

[ Abort | Mext

11la Leave the location of the Directory Information Base (DIB) at the default setting.

11b Leave the iMonitor Port settings at the defaults unless you need to change them to avoid

port conflicts with other services.

11c Leave the Secure iMonitor Port settings at the defaults unless you need to change them to

avoid port conflicts with other services.
11d Click Next to continue.
12 Specify details to configure SLP:
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eDirectory Configuration - SLP

@ Use multicast to access SLP
() Configure SLP to use an existing Directory Agent
() Configure as Directory Agent

vl
Backup Interval in Seconds
=Tulu]
Senvice Location Protocol Scopes

DERAULT

Configured SLP Directory Agents

SLP Directory Agents

| Help | | Back | | Apot |

Multicast to access SLP: Select the Use multicast to access SLP option to request SLP
information through a multicast packet.

Configure SLP to use an Existing Directory Agent: If you have more than three servers in
your eDirectory tree, and you already have a Directory Agent running, select the Configure SLP
to use an existing Directory Agent option.

Configuring Directory Agent: Select the Configure as Directory Agent option if you want the
local server to act as a directory agent.

¢ Select the DASyncReg check box to enable SLP to query statically configured directory
agents for registrations.

+ Select the Backup SLP Registrations check box to enable periodical backup of all
registrations. In the Backup Interval in Seconds field, specify the time interval (seconds) to
perform the backup.

Service Location Protocol Scopes: Inthe Service Location Protocol Scopes field, specify the
scope that a User Agent (UA) or Service Agent (SA) is allowed when making requests or when
registering services, or specify the scope that a Directory Agent (DA) must support.

The default value is DEFAULT. Use commas with no space to separate each scope. For
example:

net.slp.useScopes = myScopel,myScope2, myScope3

Configuring SLP Directory Agents: In the Configured SLP Directory Agents field, specify the
host name or IP address of one or more external servers on which an SLP Directory Agent is
running. Do not specify the local host.

To add an agent, click Add. In the SLP DA Server field, specify a server's DNS name or IP
address, then click Add.

To remove an agent, select one or more agents to remove, then click Delete.
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13 Click Next.
14 Select the authentication service you want to install:

] YasT2 — o X

Novell Modular Authentication Service

Select the NMAS Login Methods to Install:

[J certhutual
Challenge Response
[J DIGEST-MDS

NDS

[[J simple Password
[[J SASL GSSAPI

| SelectAll | | Deselect Al |

| ke | | Back | | Aver |

NOTE: The SASL GSSAPI mechanism is an eDirectory-specific SASL mechanism. It is not used
on a DSfW server. The DSfW-specific SASL GSSAPI mechanism is extended during DSfW
configuration by default.

15 Click Next.
16 Specify the common proxy details:
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eDirectory Configuration - OES Common Proxy User Information

Use Common Proxy User as default for OES Products

OES Common Proxy User Name (e.g. cn=0ESCommonFroxy_hostname)

cn=0ESCommonFroxy_frd

QOES Common Proxy User Context (e.g. o=novell)

ou:OESS stemObjects, dc=labs, de=blr, de=novell, dc=com)|

QES Common Proxy User Password

[preeeeer ]

Verify OES Common Proxy User Password

l

l

Assign Common Froxy Password Policy to Proxy User

| Help | | Back |

o

16a To use a common proxy for DSfW, select the Use Common Proxy User as default for OES
Products check box. When this check box is selected, the OES Common Proxy User Name
and Password fields are enabled. These fields are populated with a system-generated user
name and password. To change these values, see Step 16b.

or

If you do not want to use a common proxy, deselect the check box and click Next. Then

continue with Step 17.
16b Specify the following information:

+ The common proxy user name. You must specify a fully distinguished name.

+ The proxy user password.

+ Retype the password in the Verify OES Common Proxy User Password field.

16c To assign a common proxy password policy to the proxy user, select the Assign Common

Proxy Password Policy to Proxy User check box.

16d Click Next to continue.
17 Specify the details to configure the DNS server:
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Novell DNS Services Configuration
Common DNS Configuration Object Contexts
[l Get context information fram existing DNS server

Existing Movell DNS server address

193.168.1.10

Novell DMNS Sewvices Locator Object Context (e.g. ou=dns,o=novell):

[ou:OESSystemObjects,dc:internal,dc:shcs,dc:sa,dc:edu‘dc:aul| Browse |

Movell DNS Sewvices Root Server Info Context (e.q. ou=dns, o=novell):

[ou:OESSystemObjects_dc:internal_dc:shcs,dc:sa_dc:edu_dc:aul| Browse |

Movell DNS Sewices Group Object Context (2.g. ou=dns, o=novell):

[ou=OESSystemObjects,dc=internal,dc=shcs,dc=sa,dc=edu,dc=aul| Browse |

Proxy User Information

Proxy User for DNS Management (e.g. cn=myuser,o=novell)

[cn:OESCommonF’roxy_dsf\M,ou:OESSystemObjectS‘dc=internaLl | Browse

Specify Password for Proxy User Werify Password for Proxy User

tecloicicoloiiok kbl

Use Secure LDAP Port
Credential Storage Location:
@ CASA ) Local file based format

| Hep | | Back | | Avot |

17a If you are configuring DNS in an existing tree where DNS is already configured, select the
Get context and proxy user information from existing DNS server check box. Specify the
IP address of an NCP server hosting the existing DNS server and click Retrieve. This
retrieves the Locator, Root Server Info, and Group contexts.

NOTE: Before running the configure DNS task in the DSfW provisioning wizard, ensure
that the partition hosting the Locator, Root Server Info, and Group contexts has a local
replica on the DSfW server that is being configured.

17b If there is no existing DNS server in the tree, specify the following information:

+ The context of the DNS service locator object (for example,
ou=0ESSystemObjects, dc=dsfw, dc=com).

+ The context of the DNS Root Serverinfo object (for example,
ou=0OESSystemObjects,dc=dsfw, dc=com).

+ The context of the DNS Services Group object (for example,
ou=0ESSystemObjects,dc=dsfw, dc=com).

17c¢ Specify the fully distinguished, typeful name of the proxy user that will be used for DNS
management, such as cn=0ESCommonProxy serverl, ou=0ESSystemObjects, dc=com tO
authenticate to eDirectory during runtime for accessing information for DNS. The user must
have eDirectory read, write, and browse rights under the specified context.

17d Specify the password of the proxy user for accessing DNS.

If you selected the Use Common Proxy User as default for OES Products check box in
Step 164, the proxy user and password fields are populated with common proxy user name
and password.

17e Decide whether to use a secure LDAP port.
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Use Secure LDAP Port option is selected by default to ensure that the data transferred by
this service is secure and private. If you deselect this option, the data transferred is in clear

text format.

17f Specify the Credential Storage Location as CASA.
17g Click Next to continue.

18 After the installation is complete, the OES Configuration Summary page is displayed. Review the
settings, then click Next to start the DSfW installation.

m
Preparation

» OES Configuration

YasT2
(] Novell Open Enterprise Server Configuration

() Skip Configuration
® Use Following Configuration

LDAP Configuration for Open Enterprise Services

Configure is enabled

* L DAP Server Address: 198.168.1.10
* [DAP Server Address: 198.168.1.10

eDirectory

Configure is gnabled

* Tree Mame: FRD-TREE

= Tree Type: existing

* Use eDirectory certificates for HTTP services: yes

® Require TLS for Simple Binds with Password: yes

® Install SecretStore: yes

* Address of an existing server: 198.168.1.10

= Configure Domain Services for Windows: yes

= Domain type: Mew domain controller in an existing domain
* DMNS name for new domain: dsfw.com

* Configure this machine to be a primary DNS server: no
* Forest root domain: dsfw.com

* Replicate Partitions: no

Change v |

)

Help | | Apot || Back

19 When the installation is complete, click Finish.
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r ] YasTz "o x
Preparation () Perform eDirectory Configuration

» OES Configuration
Configure the firewall for directory services

Perform time synchronization

Configure and start the Service Location Protocol
Copy the NICI Foundation Key file

Check for conflicting objects in the directory

Establish eDirect

Tune eDirectory

Configure and sta & Configuring and starting eDirectory

T O O O SR RN

‘Wait for eDirectol This will take a while..........

Enable eDirectory to start on reboot
Fetch the eDirectory tree root certificate
Perform OES schema extension
Configure the NMAS login methods
Configure CES Common Proxy User
Configure Novell DNS

Configure Domain Senvices for Windows

Configure and start eDirectory using "ndsconfig”

| Hep | | Apot |

This completes the DSfW installation. However, the server is not ready for use until you provision
DSfW and the supporting services.

@' Mote : Domain Services for Windows(DSMW) configuration is not wet complete.
Launch the DSfW Provisioning Wizard in ¥asT to complete the configuration.

oK

20 To start provisioning, do one of the following:
¢ From the terminal, run the /opt/novell/xad/sbin/provision dsfw.sh Sscript.
¢ Launch YaST. The DSfW Provisioning Wizard is listed as an option.
To authenticate, enter the password of the current domain.
For more details on provisioning, see “Provisioning Domain Services for Windows” on page 109.

21 When provisioning is complete, the DSfW server is ready for use. Verify that eDirectory and
DSfW have been installed and configured correctly by using the instructions in Chapter 8,
“Activities After DSfW Installation or Provisioning,” on page 137.

Installing a Child Domain

1 Inthe YaST install for OES, on the Software Selections page, ensure that Novell DNS is
selected. Then select the Novell Domain Services for Windows pattern.

Pattern deployment provides patterns for different services. Selecting a pattern automatically
selects and installs its dependencies.
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For information about the entire OES installation process, see the OES 11 SP3: Installation
Guide.

2 Click Accept.
3 Select the type of Domain Services for Windows configuration you want:

| YasST2 - o X

Domain Services for Windows Configuration

Important

All Deployments
*You must properly prepare your system before installing Domain Senvices for Windows (DSfW).
* Be sure to read and comply with the DSfW Best Practices Guide available at
[ https:/www. novell. com/products/openenterprisesenver/features/domain-senvices-windows. html ].

Large Deployments
Ifyour deployment has
* WMore than 3 Domain Controllers
or
* More than 2.000 active users
“ou should contact Novell Consulting Services or a qualified Novell Partner for deployment assistance.

Novell Support might require Movell Consulting or Novell Partner involvement before opening or
continuing with semvice requests.

[ | have read these recommendations and reviewed the DSMW Best Practices Guide.

Select Sewver Type:

(2 New Domain Services for Windows Forest

@ Mew Domain in an existing Domain Services for Windows Forest

(2 New Domain Controller in an existing Domain Senvices for Windows Domain

[l Express Install
Recommended only for default configurations.

| Help | | Back | | Apot |

3a To create a new Domain in an existing Windows forest, select the New Domain in an
Existing Domain Services for Windows Forest option.

3b Select the Express Install option to deploy a Domain Controller by automatically populating
certain YaST configuration fields. For more information, see Section 6.1.3, “Express
Installation,” on page 92.

3c Click Next.
4 On the eDirectory configuration page in YaST, specify the following:
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| YasST2 - o X

eDirectory Configuration - Existing Tree Information

Existing eDirectory Tree Name

FRD-TREE

Use eDirectory Certificates for HTTPS Semwices
Require TLS for Simple Binds with Password
Install SecretStore

[[] Enable NMAS-based login for LDAF authentication

| Help | | Back | | Apot |

Use eDirectory Certificates for HTTPS Services: Select Use eDirectory certificates for
HTTPS Services if you want your OES services that provide HTTPS connectivity to use the more
secure eDirectory certificates instead of the self-signed certificates created by YaST.

Require TLS for Simple Binds with Password: Select the Require TLS for Simple Binds with
Password option if you want to disallow clear passwords and other data.

By default, the Transport Layer Security (TLS) and Secure Sockets Layer (SSL) protocols are
not enabled in Active Directory.

Install SecretStore: Select Install SecretStore if you want to eliminate the need to remember or
synchronize all the multiple passwords required for accessing password-protected applications.

Enable NMAS-based login for LDAP Authentication: Select this option if you want to enable
NMAS-based login for LDAP authentication.

5 Click Next to continue.
6 Specify information to access the existing eDirectory Tree.
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| YasST2 - o X

eDirectory Configuration - Existing Tree Information

IP Address of an existing eDirectory server with a replica

[198.168.1.10 | [ vangate |

Enter NCP Port on the existing server
[524 B

bl

Enter LDAP Port on the existing server
|389 B

bl

Enter Secure LDAP Port on the existing server

|636 B

bl

FDN of the tree administrator (e.g. cn=admin, o=naovell)

|en=admin, o=novell |

Admin Password

[

[ b | [ Back | | Avor |

6a Do not change the NCP Port, LDAP Port, and Secure LDAP Port information.

6b Specify the tree admin credentials for the administrator to log in to the eDirectory tree. For
information about the special characters that you can use while specifying the password,
see Section 5.13, “Supported Special Characters in DSfW Passwords,” on page 51.

6¢c Click Next.
7 Specify the Domain Name and NetBIOS information:
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| YasST2 - o X

Domain Services for Windows Configuration - Domain and NetBIOS Name

DNS Name for New Domain
frd.labs. birnovell. com

[[J Configure this server as a DNS server

NetBI0s Domain Mame
FRD

[[J Configure this server as a WINS Server

Site Mame of Domain Controller

Default-First-Site-Mame | | Browse

| Help | | Back | | Apot |

DNS Name for New Domain: The DNS name for the new domain is automatically populated
based on the Hostname and DNS configuration settings.

You must ensure that the host name in the properties of the active Ethernet controller is an
FQDN. For example, if the host name is dcl and the domain name is dsfw.com, then the host
name in the YaST > Network Devices > Network Settings > Hostname/DNS tab of the active
Ethernet controller must be dcl.dsfw.com. You can modify the host name of the active Ethernet
controller by using the Edit option in the Overview tab of the LAN settings in YaST.

Configure this Server as a DNS Server: If you want this server to be a DNS server for the
domain, select the Configure this server as a DNS Server option. If this option is not selected,
you must ensure that a DNS server that contains the domain names for Domain Services for
Windows is available somewhere in the network.

NetBIOS Domain Name: The NetBIOS Domain name is automatically populated based on the
Hostname and DNS configuration settings.

By default, this is the domain context name without the parent context. For example, in the
cn=central,dc=example,dc=com domain, the default NetBIOS name is central.

Configure this machine to be a WINS server: If you want this server to be a WINS server,
select the Configure this machine to be a WINS server option. For more information about
WINS, see Chapter 15, “Configuring DSfW Server as a WINS Server,” on page 169.

Site Name of Domain Controller: Default-First-Site-Name is specified as the site name by
default. To create a new site, specify the site name or click Browse to specify a site from the list
of sites. For more information about sites and subnets, see Chapter 16, “Configuring Sites and
Subnets,” on page 175.

8 Specify details to map the existing container to the new domain.
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| YasST2 - o X

eDirectory Configuration - Domain Services for Windows

Farent Domain Administrator Mame

cn=Administrator, cn=Users, ou=IN, o=novell

Enter Administrator Password

Aottt

New Domain Administrator Name
cn=Administrator. cn=Users.dc=frd. dc=labs. dc=blr dc=novell.dc=com

Specify Administrator Password

— |

Werify Administrator Password

— |

Enter the FDM of the container that needs to be mapped as frd.labs.birnovell.com (e.g. ou=domain. o=novell)

[ou:US_o:noveII | Browse

[[] Retain existing NMAS password policies

| Help | | Back | | Apot | Next

Parent Domain Administrator Name: The name and context for the parent domain
administrator that you are creating this domain in.

New Domain Administrator Name: The name and context of the administrator account. This is
the administrator you are entering the password for. You will use this account to log in to the
Domain Services for Windows domain.

FDN of the container that needs to be mapped: Specify the FDN of the container that you
want to map to the new domain.

IMPORTANT: A DSfW domain can only be created in Organization (O), Organizational Unit
(OU) and Domain Component (DC) containers. Installing a name-mapped domain to map
Country and Locality containers is not supported. However, you can map O and OU under these
containers.

Retain Existing NMAS Password Policies: If you select the Retain existing NMAS Password
Policies option, the password policies assigned to the users within the container that is mapped
to the new domain do not change. However, the password policies outside the partition boundary
are not carried forward. You need to create a new password policy assigned to the partition root.
For details on creating a new password policy, see “Creating Password Policies”. For information
about default password policy settings for DSfW, see Appendix D, “DSfW Password Palicy
Attributes,” on page 265.

Specify a reliable Network Time Protocol (NTP) provider.

eDirectory requires that all servers in a tree be time-synchronized. To add multiple time servers
to the list of NTP servers, click the Add button and specify the IP address or DNS host name of
the NTP server. In a single-server scenario, you can select the Use local clock check box and
specify the local machine as the NTP provider.
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eDirectory Configuration - NTP

Metwork Time Protocol (NTP) Servers

Time Servers  +

)| Deete

Use local clock

Help | [ Back [ Abort

10 Click Next.

NOTE: If you are using express install, Step 11 to Step 17 is not displayed.
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11 Specify the settings to configure the local server in the eDirectory tree:

eDirectory Configuration - Local Server Configuration

Semver Context

Browse

Directory Information Base (DIB) Location

arlopinovellieDirectorydataldib]

Enter LOAP Port

Enter Secure LDAP Part

l

Enter iMonitor Port

[8028

Enter Secure iMonitor Port

[8030

Help

l Back

| | Abort | Next

11la Leave the location of the Directory Information Base (DIB) at the default setting.

11b Leave the iMonitor Port settings at the defaults unless you need to change them to avoid
port conflicts with other services.

11c Leave the Secure iMonitor Port settings at the defaults unless you need to change them to
avoid port conflicts with other services.

11d Click Next to continue.
12 Specify details to configure SLP:
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eDirectory Configuration - SLP

@ Use multicastto access SLP
Configure SLP to use an existing Directory Agent
Caonfigure as Directory Agent

DASyncReg
Backup SLP Registrations
Backup Interval in Seconds

|-

Service Location Protocol Scopes
| DEFAULT

Configurad SLP Directary Agents

SLP DirectoryAgents  w
Add Delete
. . ] e . X
[ Hew | [ Back | [ Aot |

Multicast to access SLP: Select the Use multicast to access SLP option to request SLP
information through a multicast packet.

Configure SLP to use an Existing Directory Agent: If you have more than three servers in
your eDirectory tree, and you already have a Directory Agent running, select the Configure SLP
to use an existing Directory Agent option.

Configuring Directory Agent: Select the Configure as Directory Agent option if you want the
local server to act as a directory agent.

+ Select the DASyncReg check box to enable SLP to query statically configured directory
agents for registrations.

+ Select the Backup SLP Registrations check box to enable periodical backup of all
registrations. In the Backup Interval in Seconds field, specify the time interval (seconds) to
perform the backup.

Service Location Protocol Scopes: Inthe Service Location Protocol Scopes field, specify the
scope that a User Agent (UA) or Service Agent (SA) is allowed when making requests or when
registering services, or specify the scope that a Directory Agent (DA) must support.

The default value is DEFAULT. Use commas with no space to separate each scope. For
example:

net.slp.useScopes = myScopel,myScope2, myScope3

Configuring SLP Directory Agents: In the Configured SLP Directory Agents field, specify the
host name or IP address of one or more external servers on which an SLP Directory Agent is
running. Do not specify the local host.

To add an agent, click Add. In the SLP DA Server field, specify a server's DNS name or IP
address, then click Add.

To remove an agent, select one or more agents to remove, then click Delete.

13 Click Next.
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14 Select the authentication service you want to install:

Novell Modular Authentication Service

Selectthe NMAS Login Methods to Install:

Certviutual

+ Challenge Response
DIGEST-MDZ

¥ NDS
Simple Password
SASL GSSAPI

[ selectal | [ Deselectal |

| Hen | [ Back | | Apop |

NOTE: The SASL GSSAPI mechanism is an eDirectory-specific SASL mechanism. It is not used
on a DSfW server. The DSfW-specific SASL GSSAPI mechanism is extended during DSfW
configuration by default.

15 Click Next.
16 Specify the common proxy details:
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eDirectory Configuration - OES Commeon Proxy User Information

| Use Common Proxy User as default for OES Products

OES Common Proxy User Mame (e.g. cn=0ESCommonProxy_hostname,o=novell)

OESCommonProxy child, ou=0ES SystemObjects, de=child de=pocnnmd.dec=com

OES Common Proxy User Fassword

| Akttt

Verify OES Common Proxy User Password

bbbkt

| Assign Common Proxy Password Policy to Proxy User

Help | | Back | | Aport | Mext

16a To use a common proxy for DSfW, select the Use Common Proxy User as default for OES
Products check box. When this check box is selected, the OES Common Proxy User Name
and Password fields are enabled. These fields are populated with a system-generated user
name and password. To change these values, see Step 16b.

or

If you do not want to use a common proxy, deselect the check box and click Next. Then
continue with Step 17.

16b Specify the following information:
+ The common proxy user hame. You must specify a fully distinguished name.
+ The proxy user password.
+ Retype the password in the Verify OES Common Proxy User Password field.

16c To assign a common proxy password policy to the proxy user, select the Assign Common
Proxy Password Policy to Proxy User check box.

16d Click Next to continue.
17 Specify the details to configure the DNS server.
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Novell DNS Services Configuration

Common DME Configuration Objects Context
¥ Get context information from existing DNS semver
Existing Novell DNS server address:
188.168.1.10

Novell DNS Services Locator Object Context (e.g. ou=dns,o=novell):
| ou=0ESSystemObjects.dc=pocnnmd.dc=com
Novell DNS Services Group Object Context (e.0. ou=dns.o=novell):

| oU=0ESSystemObjects,dc=pocnnmd,de=com

[ Hewm | [ Bak | [ amport | [ Mest |

17a If you are configuring DNS in an existing tree where DNS is already configured, select the
Get context and proxy user information from existing DNS server check box. Specify the
IP address of an NCP server hosting the existing DNS server and click Retrieve. This
retrieves the Locator, Root Server Info, and Group contexts.

NOTE: Before running the configure DNS task in the DSfW provisioning wizard, ensure
that the partition hosting the Locator, Root Server Info, and Group contexts has a local
replica on the DSfW server that is being configured.

17b Specify the following information:

+ The context of the DNS service locator object (for example,
ou=OESSystemObjects,dc=dsfw,dc=com)

+ The context of the DNS Services Group object (for example,
ou=0OESSystemObjects,dc=dsfw, dc=com).

17c Click Next to continue.

18 After the installation is complete, the OES Configuration Summary page is displayed. Review the
settings, then click Next to start the DSfW installation.
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LN

Preparation

» OES Configuration

YasTz

Novell Open Enterprise Server Configuration

() Skip Configuration
@ Use Following Configuration

LDAP Configuration for Open Enterprise Services

Configure is enabled

* [ DAP Server Address: 198.168.1.10
* [ DAP Server Address: 198.168.1.10

eDirectory

Configure is enabled

* Tree Name: FRD-TREE
* Tree Type: existing
® Use eDirectory certificates for HTTP services: yes
* Require TLS for Simple Binds with Password: yes
*® Install SecretStore: yes
* Address of an existing server: 198.168.1.10
= Configure Domain Services for Windows: ves
* Domain type: Mew domain controller in an existing domain
* DNS name for new domain: dsfw com
= Configure this machine to be a primary DNS sever: no
* Forest root domain: dsfw.com
* Replicate Partitions: no
| * Movell DNS Services Locator Object Context. ou=0ESSystemObjects, dc=dsw,dc=com.

Change... |

Apot | | Back

l

| Help | |

Next

19 When the installation is complete, click Finish.

1 ]
Preparation

» OES Configuration

YasT2

(] Perform eDirectory Configuration

Configure the firewall for directory services
Perform time synchronization

Configure and start the Senvice Location Protocol
Copy the NICI Foundation Key file

Check for conflicting objects in the directory

Establish eDirect

Tune eDirectory

L N N Y T T N

A Configuring and starting eDirectory

Configure and sta

Wait for eDirecto This will take a while...

- Enable eDirectory to start on reboot

- Fetch the eDirectory tree root certificate
- Perform OES schema extension

- Configure the NMAS login methods

- Configure OES Common Proxy User

- Configure Movell DNS

- Configure Domain Services for Windows

Configure and start eDirectory using "ndsconfig"

43%
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This completes the DSfW installation. However, the server is not ready for use until you provision
DSfW and the supporting services.

(;' Mote : Domain Services for Windows (DSfW) configuration is not yet complete.
Launch the DAV Provisioning Wizard in YaST to complete the configuration.

oK

20 To start provisioning, do one of the following:
¢ From the terminal, run the /opt/novell/xad/sbin/provision dsfw.sh Script.
+ Launch YaST. The DSfW Provisioning Wizard is listed as an option.
To authenticate, enter the password of the current domain.
For more details on Provisioning, see “Provisioning Domain Services for Windows” on page 109.

21 When provisioning is complete, the DSfW server is ready for use. Verify that eDirectory and
DSfW have been installed and configured correctly by using the instructions in Chapter 8,
“Activities After DSfW Installation or Provisioning,” on page 137.

Installing DSfW as an Additional Domain Controller in a Domain

1 Inthe YaST install for OES, on the Software Selections page, ensure that Novell DNS is
selected. Then select the Novell Domain Services for Windows pattern.

Pattern deployment provides patterns for different services. Selecting a pattern automatically
selects and installs its dependencies.

For information about the entire OES installation process, see the OES 11 SP3: Installation
Guide.

2 Click Accept.
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3 Select the type of Domain Services for Windows configuration you want:

|| YasT2 — o X

Domain Services for Windows Configuration

Important
All Deployments
*%ou must properly prepare your system bhefore installing Domain Services for Windows (DSAA).
* Be sure to read and comply with the DSAW Best Practices Guide available at
[ https:/Awww. novell. com/products/openenterpriseserver/features/domain-sevices-windows. html .

Large Deployments
Ifyour deployment has
* More than 3 Domain Controllers
or
* More than 2,000 active users
“ou should contact Novell Consulting Services or a qualified Novell Partner for deployment assistance.

Movell Suppert might require Movell Consulting or Novell Partner involvement before opening or
continuing with sevice requests.

[[] | have read these recommendations and reviewed the DS#W Best Practices Guide.

Select Server Type:

(' Mew Domain Services for Windows Forest
) Mew Domain in an existing Domain Services for Windows Forest

! Mew Domain Controller in an existing Domain Services for Windows Domain

[l Express Install

Recommended only for default configurations.

| Hep | | Back | | Amport |

3a To create a new domain controller in an existing Domain Services for Windows domain,
select the New Domain in an Existing Domain Services for Windows Domain option.

3b Select the Express Install option to deploy a domain controller by automatically populating
certain YaST configuration fields. For more information, see Section 6.1.3, “Express
Installation,” on page 92.

4 On the eDirectory configuration page in YaST, specify the following:
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| YasST2 - o X

eDirectory Configuration - Existing Tree Information

Existing eDirectory Tree Name

FRD-TREE

Use eDirectory Certificates for HTTPS Semwices
Require TLS for Simple Binds with Password
Install SecretStore

[[] Enable NMAS-based login for LDAF authentication

| Help | | Back | | Apot |

Use eDirectory Certificates for HTTPS Services: Select Use eDirectory certificates for
HTTPS Services if you want your OES services that provide HTTPS connectivity to use the more
secure eDirectory certificates instead of the self-signed certificates created by YaST.

Require TLS for Simple Binds with Password: Select the Require TLS for Simple Binds with
Password option if you want to disallow clear passwords and other data.

By default, the Transport Layer Security (TLS) and Secure Sockets Layer (SSL) protocols are
not enabled in Active Directory.

Install SecretStore: Select Install SecretStore if you want to eliminate the need to remember or
synchronize all the multiple passwords required for accessing password-protected applications.

Enable NMAS-based login for LDAP Authentication: Select this option if you want to enable
NMAS-based login for LDAP authentication.

5 Click Next to continue.
6 Specify information to access the existing eDirectory tree.
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| YasST2 - o X

eDirectory Configuration - Existing Tree Information

IP Address of an existing eDirectory server with a replica

[198.168.1.10 | [ vangate |

Enter NCP Port on the existing server
[524 ]

Enter LDAP Port on the existing server
|389 B

Enter Secure LDAP Port on the existing server

|636 <l

FDN of the tree administrator (e.g. cn=admin, o=naovell)

|en=admin, o=novell |

Admin Password

[m

[ b | [ Back | | Avor |

6a Do not change the NCP Port, LDAP Port and Secure LDAP Port information.

6b Specify the tree admin credentials for the administrator to log in to the eDirectory tree. For
information about the special characters that you can use while specifying the password,
see Section 5.13, “Supported Special Characters in DSfW Passwords,” on page 51.

6¢c Click Next.
7 Specify the Domain Name and NetBIOS information:
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| YasST2 - o X

Domain Services for Windows Configuration - Domain and NetBIOS Name

DNS Name for New Domain
labs. birnovell.com

[[J Configure this server as a DNS server

MetBIOS Domain Mame
LABS

[[J Configure this server as a WINS Server

Site Mame of Domain Controller

Default-First-Site-Mame | | Browse

| Help | | Back | | Apot |

DNS Name for New Domain: The DNS name for the new domain is automatically populated
based on the Hostname and DNS configuration settings.

You must ensure that the host name in the properties of the active Ethernet controller is an
FQDN. For example, if the host name is dcl and the domain name is dsfw.com, then the host
name in the YaST > Network Devices > Network Settings > Hostname/DNS tab of the active
Ethernet controller must be dcl.dsfw.com. You can modify the host name of the active Ethernet
controller by using the Edit option in the Overview tab of the LAN settings in YaST.

Configure this Server as a DNS Server: If you want this server to be a DNS server for the
domain, select the Configure this server as a DNS Server option. If this option is not selected,
you must ensure that a DNS server that contains the domain names for Domain Services for
Windows is available somewhere in the network.

NetBIOS Domain Name: The NetBIOS Domain name is automatically populated based on the
Hostname and DNS configuration settings.

By default, this is the domain context name without the parent context. For example, in the
cn=central,dc=example,dc=com domain, the default NetBIOS name is central.

Configure this machine to be a WINS server: If you want this server to be a WINS server,
select the Configure this machine to be a WINS server option. For more information about
WINS, see Chapter 15, “Configuring DSfW Server as a WINS Server,” on page 169.

Site Name of Domain Controller: Default-First-Site-Name is specified as the site name by
default. To create a new site, specify the site name or click Browse to specify a site from the list
of sites. For more information about sites and subnets, see Chapter 16, “Configuring Sites and
Subnets,” on page 175.

Specify the domain administrator password in the Enter Administrator Password field. For
information about the special characters that you can use while specifying the password, see
Section 5.13, “Supported Special Characters in DSfW Passwords,” on page 51.
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eDirectory Configuration - Domain Services for Windows

Existing domain administrator name

chn=Administrator, cn=Users, ou=IN, o=novell

Enter Administrator Password

Attt

T | Bek | [ pvort |

9 Specify a reliable Network Time Protocol (NTP) provider.

eDirectory requires that all servers in a tree be time-synchronized. To add multiple time servers
to the list of NTP servers, click the Add button and specify the IP address or DNS host name of
the NTP server. In a single-server scenario, you can select the Use local clock check box and

specify the local machine as the NTP provider.
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eDirectory Configuration - NTP

Metwork Time Protocol (NTP) Servers

Time Servers  +

)| Deete

Use local clock

—_—,
Help | Back Abort Mext
Help | LB | ! | N

10 Click Next.

NOTE: If you are configuring using Express install, then Step 11 through Step 16 will not be
displayed.
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11 Specify the settings to configure the local server in the eDirectory tree:

eDirectory Configuration - Local Server Configuration

Semver Context

Directory Information Base (DIB) Location

Browse

arlopinovellieDirectorydataldib]

Enter LOAP Port

Enter Secure LDAP Part

l

Enter iMonitor Port

[8028

Enter Secure iMonitor Port

[8030

Help |  Back |

[ Abort | Mext

11la Leave the location of the Directory Information Base (DIB) at the default setting.

11b Leave the iMonitor Port settings at the defaults unless you need to change them to avoid

port conflicts with other services.

11c Leave the Secure iMonitor Port settings at the defaults unless you need to change them to

avoid port conflicts with other services.
11d Click Next to continue.
12 Specify details to configure SLP:

OES 11 SP3: Domain Services for Windows Administration Guide



eDirectory Configuration - SLP

@ Use multicastto access SLP
Configure SLP to use an existing Directory Agent
Caonfigure as Directory Agent

DASyncReg
Backup SLP Registrations
Backup Interval in Seconds

|-

Service Location Protocol Scopes
| DEFAULT

Configurad SLP Directary Agents

SLP DirectoryAgents  w
Add Delete
. . ] e . X
[ Hew | [ Back | [ Aot |

Multicast to access SLP: Select the Use multicast to access SLP option to request SLP
information through a multicast packet.

Configure SLP to use an Existing Directory Agent: If you have more than three servers in
your eDirectory tree, and you already have a Directory Agent running, select the Configure SLP
to use an existing Directory Agent option.

Configuring Directory Agent: Select the Configure as Directory Agent option if you want the
local server to act as a directory agent.

+ Select the DASyncReg check box to enable SLP to query statically configured directory
agents for registrations.

+ Select the Backup SLP Registrations check box to enable periodical backup of all
registrations. In the Backup Interval in Seconds field, specify the time interval (seconds) to
perform the backup.

Service Location Protocol Scopes: Inthe Service Location Protocol Scopes field, specify the
scope that a User Agent (UA) or Service Agent (SA) is allowed when making requests or when
registering services, or specify the scope that a Directory Agent (DA) must support.

The default value is DEFAULT. Use commas with no space to separate each scope. For
example:

net.slp.useScopes = myScopel,myScope2, myScope3

Configuring SLP Directory Agents: In the Configured SLP Directory Agents field, specify the
host name or IP address of one or more external servers on which an SLP Directory Agent is
running. Do not specify the local host.

To add an agent, click Add. In the SLP DA Server field, specify a server's DNS name or IP
address, then click Add.

To remove an agent, select one or more agents to remove, then click Delete.
13 Select the authentication service you want to install.
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Novell Modular Authentication Service

Select the NMAS Login Methods to Install:

Certhvutual

¥ Challenge Response
DIGESTMDS

¥ NDS
Simple Password
SASL GSSAP|

| selectal | | Deselectall |

[ Hep | | Back | [ Aport |

NOTE: The SASL GSSAPI mechanism is an eDirectory-specific SASL mechanism. It is not used
on a DSfW server. The DSfW-specific SASL GSSAPI mechanism is extended during DSfW
configuration by default.

14 Click Next.
15 Specify the common proxy details:
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eDirectory Configuration - OES Commeon Proxy User Information

| Use Common Proxy User as default for OES Products

OES Common Proxy User Mame (e.g. cn=0ESCommonProxy_hostname,o=novell)

cn=0ESCommonProxy adec ou=0ESSystemnObjects, o=novell|

OES Common Proxy User Fassword

| Akttt

Verify OES Common Proxy User Password

bbbkt

| Assign Common Proxy Password Policy to Proxy User

Help | | Back | | Abart Mext

15a To use a common proxy for DSfW, select the Use Common Proxy User as default for OES
Products check box. When this check box is selected, the OES Common Proxy User Name
and Password fields are enabled. These fields are populated with a system-generated user
name and password. To change these values, see Step 15b.

or

If you do not want to use a common proxy, deselect the check box and click Next. Then
continue with Step 16.

15b Specify the following information:
+ The common proxy user hame. You must specify a fully distinguished name.
+ The proxy user password.
+ Retype the password in the Verify OES Common Proxy User Password field.

15¢ To assign a common proxy password policy to the proxy user, select the Assign Common
Proxy Password Policy to Proxy User check box.

15d Click Next to continue.
16 Specify the details to configure the DNS server:
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Novell DNS Services Configuration

Common DME Configuration Objects Context
¥ Get context information from existing DNS semver
Existing Novell DNS server address:
188.162.1.10

Novell DNS Services Locator Object Context (e.g. ou=dns,o=novell):
| ou=0ESSystemnObjects.o=novell
Novell DNS Services Group Object Context (e.0. ou=dns.o=novell):

| ou=0ESSystemObjects, o=novell

[ Hewm | [ Bak | [ amport | [ Mest |

16a If you are configuring DNS in an existing tree where DNS is already configured, select the
Get context and proxy user information from existing DNS server check box. Specify the
IP address of an NCP server hosting the existing DNS server and click Retrieve. This
retrieves the Locator, Root Server Info, and Group contexts.

NOTE: Before running the configure DNS task in the DSfW provisioning wizard, ensure
that the partition hosting the Locator, Root Server Info, and Group contexts has a local
replica on the DSfW server that is being configured.

16b Specify the following information:

+ The context of the DNS service locator object (for example,
ou=OESSystemObjects,dc=dsfw,dc=com)

+ The context of the DNS Services Group object (for example,
ou=0OESSystemObjects,dc=dsfw, dc=com).

16¢ Click Next to continue.

17 After the installation is complete, the OES Configuration Summary page is displayed. Review the
settings, then click Next to start the DSfW installation.
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[, | YasTz2 ==k |
B Novell Open Enterprise Server Configuration
> —
OES Configuration O skip Configuration
@ Use Following Configuration
LDAP Configuration for Open Enterprise Services
Configure is enabled
* [ DAP Server Address: 198.168.1.10
* [ DAP Server Address: 198.168.1.10
eDirectory
Configure is enabled
* Tree Name: FRD-TREE
* Tree Type: existing
® Use eDirectory certificates for HTTP services: yes
* Require TLS for Simple Binds with Password: yes
*® Install SecretStore: yes
= Address of an existing server; 198.168.1.10
= Configure Domain Services for Windows: ves
* Domain type: Mew domain controller in an existing domain
* DNS name for new domain: dsfw.com
= Configure this machine to be a primary DNS sever: no
* Forest root domain: dsfw.com
* Replicate Partitions: no |
L = Movell DNS Services Locator Object Context. ou=0ESSystemObjects, de=dsfw,dc=com. :E‘
Change... |
[ hep | | Avot || Back [ Next
18 When the installation is complete, click Finish.
v ] YaST2 — o x
Preparation (] Perform eDirectory Configuration
» OES Configuration
Configure the firewall for directory semvices
Perform time synchronization
v Configure and start the Senice Location Protocol
v Copy the NIC| Foundation Key file
v Check for conflicting objects in the directory
+  Establish eDirect
v Tune eDirectory
- Configure and sta A Configuring and starting eDirectory
N Wait for eDirecto This will take a while...
- Enable eDirectory to start on reboot
- Fetch the eDirectaory tree root certificate
- Perform OES schema extension
- Configure the NMAS login methods
- Configure OES Common Proxy User
- Configure Movell DNS
- Configure Domain Services for Windows
Configure and start eDirectory using "ndsconfig”
N,
Help | Abort |
Installing Domain Services for Windows 91



6.1.3

6.1.4

This completes the DSfW installation. However, the server is not ready for use until you provision
DSfW and the supporting services.

gﬁ' Mote : Domain Services for Windows (DSfW) configuration is not yet complete.
Launch the DAV Provisioning Wizard in YaST to complete the configuration.

oK

19 To start provisioning, do one of the following:
¢ From the terminal, run the /opt/novell/xad/sbin/provision dsfw.sh Script.
+ Launch YaST. The DSfW Provisioning Wizard is listed as an option.
To authenticate, enter the password of the current domain.
For more details on provisioning, see “Provisioning Domain Services for Windows” on page 109.

20 When provisioning is complete, the DSfW server is ready for use. Verify that eDirectory and
DSfW have been installed and configured correctly by using the instructions in Chapter 8,
“Activities After DSfW Installation or Provisioning,” on page 137.

Express Installation

Beginning in OES 11 SP1, DSfW enables you to easily configure a domain controller by using the
Express Install option. An Express Install simplifies the installation of a domain controller and
reduces user intervention by automatically populating certain YaST configuration fields. This is done
by assigning default values for the Local server configuration, NMAS, SLP, DNS, and common proxy
pages to minimize the number of configuration pages.

You cannot use an Express Install to customize configuration parameters for components such as
DNS.

Using a Container Admin to Install and Configure DSfW

For this procedure, assume that you want to configure DSfW in an existing tree with
o=novell,ou=india.o=novell, and ou=blr.ou=india.o=novell as root partitions.

You must have at least one eDirectory 8.8 SP2 and above server in the tree that holds a writable
replica of the root partition.The root partition should be on the server that is holding the name-mapped
container. This is required for creating partitions during DSfW configuration.

To configure a container admin and use it to install DSfW:
1 Create a container in an existing tree. For example:
ou=india.o=novell
2 Create a cn=1localadmin user under the ou=india.o=novell container.
The container must be partitioned (before installing the server) by using the admin for the tree.
3 Assign the following rights to the container admin:
+ Supervisor rights on this partition.

+ Supervisor rights (inherited) for the entry rights to the security container.
+ Read and Write permission for the DNS locator and DNS group object.
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+ Read and Write permission for the DNS server object if the DNS server is located in other
domain.

+ Supervisor rights (inheritable) on the ou=0ESSystemObjects container holding the NCP
Server object of the forest root domain, while installing a subsequent domain or an
additional domain controller as a container admin.

For example, ou=0ESSystemObjects, dc=parent, dc=com where dc=parent,dc=com is the
forest root domain.

+ Supervisor rights on the configuration partition and schema partition to create a subsequent
domain or an additional domain controller.

For information on rights that must be assigned before doing a container admin installation, see
“Rights Required for Subcontainer Administrators” in the OES 11 SP3: Installation Guide.

For more information on installing a secondary server into an existing tree as a non-administrator
user, refer to the eDirectory 8.8 Installation Guide (http://www.netig.com/documentation/edir88/
edirin88/index.html?page=/documentation/edir88/edirin88/data/a7ivcnh.html).

4 Use the tree admin to extend the schema for DSfW:

4a On an existing OES 11 or later server, run the Novell Schema tool found in YaST > Open
Enterprise Server > Novell Schema Tool and specify the IP address of the eDirectory 8.8
server with a writable replica of the root.

or
Use the OES schema tool or iManager to extend the schema.
4b Specify the tree admin’s password and click Next.

4c Select Novell Linux User Management (LUM), Novell DNS, Novell Domain Services for
Windows, Novell Directory Services, Novell iPrint Services, Novell Storage Services
(NSS), Novell NCP Server, Novell SMS, and NMAS.

It is not necessary to select any of the other items in the list. Wait for the schema changes to
be synchronized across the tree before proceeding with the installation of the first DSfwW
server.

5 Use YaST with container admin credentials to configure Novell DSfW.

For information on installing and configuring the Novell DNS service, refer to “Installing the DNS
Server” and “eDirectory Permissions ” in the OES 11 SP3: Novell DNS/DHCP Services for Linux
Administration Guide.

NOTE: Apart from the tree administrator installation, container administrator installation is the only
supported installation scenario. DSfW installation as a DSfW Domain Administrator is not supported.

Installing DSfW Using AutoYaST

DSfW AutoYaST Installation feature enables you to install and configure DSfW without any manual
intervention. You can use this feature to install DSfW for a new forest domain, new domain in an
existing forest, and new domain controller in an existing domain.

To use DSfW AutoYaST feature, you must first download the template file for Name-Mapped or Non-
Name-Mapped installation scenarios and then modify the values of certain tags to install a Forest
Root Domain (FRD), Additional Domain Controller (ADC), or Child domain controller (CDC).
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The following sections will take you through the procedure to install DSfW using AutoYaST.

¢ Section 6.2.1, “Prerequisites,” on page 94
+ Section 6.2.2, “Installing DSfW,” on page 94
+ Section 6.2.3, “Modifying Template Files,” on page 94

6.2.1 Prerequisites

+ Modified template file that must be copied to a web server.
+ A boot scenario set up. You can boot from media or from an installation source.

+ One or more target computers to install the server software to and the following information
about each:

+ Hostip

*

Netmask

*

Gateway
Install path of SUSE iso
Path of the modified template file located on the web server

*

*

+ To determine the NCP server object location, follow the guideline given below:

The NCP server object of the DSfW domain controller that is being configured must be placed
under the container ou=0ESSystemObjects. This container is present or created below the
eDirectory partition that is mapped to the DSfW domain.

For example, assume that the partition ou=example, o=organization is being mapped to a
DSfW domain. The NCP server object container will be
ou=0ESSystemObject, ou=example, o=organization.

6.2.2 Installing DSfW

1 Download the template file and modify parameters in the template file based on your installation
scenario. For more information, see Section 6.2.3, “Modifying Template Files,” on page 94.

2 Copy the modified template file to a web server.
3 Start the target server and specify the following options during boot up:

*

Hostip- IP address of the target server.

*

Netmask-Subnet mask of the network.

*

Gateway- Gateway IP address of the network
Install- SLES iso path
Autoyast- Complete path (including filename) of the modified template file in the web server.

*

*

Madifications to the template file depends on the installation scenarios. Following sections take you
through the various installation scenarios and the modifications required.

6.2.3 Modifying Template Files

Follow the sections below to modify the template files based on your installation scenario.

+ “Forest Root Domain in a Name-Mapped Environment” on page 95
+ “Additional Domain Controller in a Name-Mapped Environment” on page 97
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¢ “Child Domain Controller in a Name-Mapped Environment” on page 99

+ “Forest Root Domain in a Non-Name-Mapped Environment” on page 101

+ “Additional Domain Controller in a Non Name Mapped Environment” on page 103

¢ “Child Domain Controller in a Non Name Mapped Environment” on page 106

Forest Root Domain in a Name-Mapped Environment

Table 6-1 Template file modifications for FRD in a name-mapped installation

Tag Line Value to be specified
number
<media_url> 7 Path of OES media
<ca_commonName> 82 YaST Default CA (<domain name of the forest being
installed>)
<organisation> 85 Tree name
<password> 87 Machine root password
<server_commonName> 88 <hostname>.<domain name>
<server_email> 89 postmaster@<domain name>
<domain_name> 103 <domain name of the forest being installed>
<group_context> 105 FQDN of the DNS DHCP group object
<host_name> 106 Hostname of the target server
<ldap_server> 111, 773, IP address of the target server
791, 1233
<locater_context> 112 FQDN of the base container that has the DNS DHCP
locator object.
<ntp_server_list> 115 <listentry> NTP server IP </listentry>
<replica_server> 119 IP address of the existing eDirectory server
<runtime_admin> 120 cn=0OESCommonProxy <hostnames>, ou=OESSystemObject
s,<FQDN of the base container>
NOTE: The base container must be partitioned
<runtime_admin_password> 121 <runtime_admin> password
<server_context> 123 ou=0ESSystemObjects.<FQDN of the base
containers
<server_object> 124 cn=DNS_edir<hostname>, ou=OESSystemObjects, <FQDN
of the base containers
<slp_da> 128 <listentry> SLP server IP </listentry>
<xad_domain_name> 140 <domain name>
<xad_domain_type> 141 Forest
<xad_existing_container> 142 <FQDN of the base container>
<xad_forest_root> 143 Domain Name
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Tag Line Value to be specified
number

<xad_ldap_admin_context> 144 <FQDN of the tree admin>

<xad_ldap_admin_password> 145 Password of the <xad_ldap_admin_context>

<xad_netbios> 147 Unique netBIOS in the subnet

<host_address> 589 IP address of the target server

<name> 591 <hostname>.<domain name> <hostname>

<ldap_domain> 680 dc=<domain name prefix>,dc=<domain name
suffix>,dc=<domain name suffix>

<domain> 703 <domain name>

<hostname> 704 <hostname>

<nameserver> 706 IP address of target server

<search> 711 Domain name of target server

<ipaddr> 719 IP address of the target server

<netmask> 721 Subnet mask of the network

<broadcast> 734 Broadcast IP address of the network

<gateway> 752 IP address of the gateway in the network

<admin_group > 772 LUM admingroup context. You can create a new group in
any context or point to an existing admingroup.

<lum_enabled_services> 774 You can choose LUM services based on your
requirement. For example, if you want to enable FTP
service, set the value of the <ftp> tag to yes.

<partition_root> 784 ou=0ESSystemObjects, <FQDN of the base
containers>

<ws_context> 788 ou=0ESSystemObjects, <FQDN of the base
containers

<nssadmin_dn> 792 cn=<hostname>admin.ou=0ESSystemObjects.<FQDN of
the base containers

<xad_tree_admin_context> 919 <FQDN of the tree admin>

<xad_tree_admin_password> 920 Password of <xad_tree_admin_context>. Same
password that is entered in <xad_ldap_admin_password>

<admin_context> 921 cn=Administrator.cn=Users.dc=<domain name
prefix>.dc=<domain suffixls>.<dc suffix2s>.

<admin_password> 922 Password for the Domain Administrator specified in
<admin_context>

<ip_address> 925 IP address of the target server

<ip_address> 930 IP address of the existing eDirectory server

<proxy_context> 935 cn=0ESCommonProxy <hostnames>, ou=OESSystemObject
s,<FQDN of the base containers

<timezone> 1451 Timezone
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Additional Domain Controller in a Name-Mapped Environment

Table 6-2 Template file modifications for ADC in a name-mapped installation

Tag Line Value to be specified
number

<media_url> 7 Path of OES media

<organisation> 85 Tree name

<password> 87 Machine root password

<server_commonName> 88 <hostname>.<domain name>
For example, if the value of this tag is frd.dsfw.com, you
must modify the value to adc.dsfw.com where adc is the
hostname of the target server.

<group_context> 105 FQDN of the DNS DHCP group object

<host_name> 106 Hostname of the target server

<ldap_server> 111, 773, IP address of the target server

791, 1233

<locater_context> 112 FQDN of the base container that has the DNS DHCP
locator object.

<ntp_server_list> 115 <listentry> NTP server IP </listentry>

<replica_server> 119 IP address of the corresponding primary domain
controller

<runtime_admin> 120 cn=0ESCommonProxy <hostnames>, ou=OESSystemObject
s,<FQDN of the base containers

<runtime_admin_password> 121 <runtime_admin> password

<server_object> 124 cn=DNS_edir<hostname>, ou=OESSystemObjects, <FQDN
of the base containers>

<slp_da> 128 <listentry> SLP server IP </listentry>

<xad_convert_existing_container> 139 Empty

<xad_domain_type> 141 Controller

<xad_existing_container> 142 Empty

<xad_forest_root> 143 Domain Name

<xad_parent_domain_admin_context> 151 FQDN of the parent domain administrator. For example:
cn=<Administrator name>.cn=users.dc=<domain
name prefix>.dc=<domain name
suffixls>,dc=<domain name suffix2>.

<xad_replicate_partitions> 153 Yes

<xad_retain_policies> 154 No or Yes

<host_address> 589 IP address of the target server

Installing Domain Services for Windows

97



Tag Line Value to be specified

number
<name> 591 <hostname>.<domain name> <hostname>
For example, if the value of thistag is frd.dsfw.com frd,
you must modify the value to adc.dsfw.com adc where
adc is the hostname of the target server.
<hostname> 704 Hostname of the target server
<nameserver> 706 IP address of the existing DSfW server having DNS
<search> 711 Domain name of the existing DSfW server having DNS
<ipaddr> 719 IP address of the target server
<netmask> 721 Subnet mask of the network
<broadcast> 734 Broadcast IP address of the network
<gateway> 752 IP address of the gateway in the network
<admin_group > 772 LUM admingroup context. You can create a new group in
any context or point to an existing admingroup.
For example, cn=<admingroup
name>, cn=Users,dc=<domain name>,dc=<domain name
suffix>
<lum_enabled_services> 774 You can choose LUM services based on your
requirement. For example, if you want to enable FTP
service, set the value of the <ftp> tag to yes.
<sshd> 781 Yes
<partition_root> 784 ou=0ESSystemObjects, <FQDN of the base
containers
<ws_context> 788 ou=0ESSystemObjects, <FQDN of the base
containers
<nssadmin_dn> 792 cn=<hostname>admin.ou=0ESSystemObjects.<FQDN of
the base containers
<ldap_servers> 925 Add the following to the Idap_servers tag:
<listentry>
<ip address> IP address of the 1local
server</ip address>
<ldap port config:type="integer">389</
ldap_ports>
<ldaps port config:type="integer">636</
ldaps_port>
</listentry>
<listentry>
<ip_address> IP address of the parent
domain</ip address>
<ldap port config:type="integer">389</
ldap_ports>
<ldaps port config:type="integer">636</
ldaps_ports>
</listentrys>
<ip_address> 930 IP address of the existing eDirectory server
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Tag Line Value to be specified

number
<proxy_context> 935 cn=0ESCommonProxy <hostnames>, ou=OESSystemObject
s,<FQDN of the base containers
<timezone> 1451 Timezone

Child Domain Controller in a Name-Mapped Environment

Table 6-3 Template file modifications for CDC in a name-mapped installation

Tag Line Value to be specified

number
<media_url> 7 Path of OES media
<ca_commonName> 82 YaST Default CA (<domainname>)
<organisation> 85 Tree name
<password> 87 Machine root password
<server_commonName> 88 <hostname>.<domain name>

For example, if the value of this tag is frd.dsfw. com,
you must modify the value to cdc.child.dsfw.com
where cdc is the hostname of the target server and
child.dsfw.com is the domain name of the new domain.

<server_email> 89 postmaster@<domain name>

<domain_name> 103 Domain name

<group_context> 105 FQDN of the DNS DHCP group object

<host_name> 106 Hostname of the target server

<ldap_server> 111, 773, IP address of the target server

791, 1233

<locater_context> 112 FQDN of the base container that has the DNS DHCP
locator object.

<ntp_server_list> 115 <listentry> NTP server IP </listentry>

<replica_server> 119 IP address of the parent domain

<runtime_admin_password> 121 <runtime_admin> password

<server_context> 123 ou=0ESSystemObjects.<FQDN of the base
containers

<server_object> 124 cn=DNS_edir<hostname>, ou=OESSystemObjects, <F
QDN of the base container>

<slp_da> 128 <listentry> SLP server IP </listentry>

<xad_domain_name> 140 Domain name

<xad_domain_type> 141 Domain

<xad_existing_container> 142 FQDN of the base container
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Tag Line Value to be specified
number

<xad_forest_root> 143 Domain Name

<xad_netbios> 147 Unique netBIOS in the subnet

<xad_parent_domain> 149 Name of the parent domain

<xad_parent_domain_admin_context> 151 FQDN of parent domain administrator. For example,
cn=Administrator.cn=Users.dc=<domain
name>.dc=<domain suffix 1>.dc=<domain suffix
2>.

<xad_parent_domain_admin_password> 152 Password of the parent domain

<host_address> 589 IP address of the target server

<name> 591 <hostname>.<domain name> <hostname>

<ldap_domain> 680 dc=<domain name prefix 1>,dc=<domain name
prefix 2>,dc=<domain name suffix
1>,dc=<domain name suffix 2>

<domain> 703 Domain name

<hostname> 704 Hostname

<nameserver> 706 IP address of the existing DSfW server having DNS

<search> 711 Domain name of the existing DSfW server having DNS

<ipaddr> 719 IP address of the target server

<netmask> 721 Subnet mask of the network

<broadcast> 734 Broadcast IP address of the network

<gateway> 752 IP address of the gateway in the network

<admin_group > 772 LUM admingroup context. You can create a new group
in any context or point to an existing admingroup.
For example, cn=<admingroup
name>, cn=Users, dc=<domain names>,dc=<domain
name suffixs.

<lum_enabled_services> 774 You can choose LUM services based on your
requirement. For example, if you want to enable FTP
service, set the value of the <ftp> tag to yes.

<partition_root> 784 ou=0ESSystemObjects, <FQDN of the base
containers>

<ws_context> 788 ou=0ESSystemObjects, <FQDN of the base
container>

<nssadmin_dn> 792 cn=<hostname>admin.ou=0ESSystemObjects.<FQDN
of the base containers>

<admin_context> 921 cn=<Administrator names.cn=Users.dc=<domain

name cdc prefix>.dc=<domain name frd
prefix>.dc=<domain suffixls>.<dc suffix2s>.
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Tag Line

Value to be specified

number

<ldap_servers> 925

<proxy_context> 935

<timezone> 1451

Add the following to the Idap_servers tag:

<listentry>

<ip address>
local server</ip address>

<ldap_port
config:type="integer">389</1ldap ports>

<ldaps_port
config:type="integer">636</ldaps_ports>

</listentrys>

<listentry>

<ip address>
parent domain</ip addresss>

<ldap_port
config:type="integer">389</ldap ports>

<ldaps_port
config:type="integer">636</ldaps_port>

</listentry>

IP address of the

IP address of the

cn=0ESCommonProxy <hostnames>, ou=0ESSystemObj

ects, <FQDN of the base containers>

Timezone

Forest Root Domain in a Non-Name-Mapped Environment

Table 6-4 Template file modifications for FRD in a non-name-mapped installation

Tag Line Value to be specified
number
<media_url> 7 Path of OES media
<ca_commonName> 83 YaST Default CA (<domainname>)
<organisation> 86 Tree name
<password> 88 Machine root password
<server_commonName> 89 <hostname>.<domain name>
where hostname is the hostname of the target server and
domain name is the domain name of the new forest
domain that is being installed.
<server_email> 90 postmaster@<domain name>
<domain_name> 104 Domain name of the forest
<group_context> 106 FQDN of the DNS DHCP group object
<host_name> 107 Hostname of the target server
<ldap_basedn> 111 ou=0ESSystemObjects,dc=<domain name
prefix>,dc=<domain name suffix>
<ldap_server> 112,773, IP address of the target server
791,122
6
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Tag Line Value to be specified

number

<locater_context> 113 FQDN of the base container that has the DNS DHCP
locator object.

<ntp_server_list> 116 <listentry> NTP server IP </listentry>

<runtime_admin> 121 cn=0ESCommonProxy <hostname>, ou=OESSystemObject
s,dc=<domain name prefix>,dc=<domain name
suffix>

<runtime_admin_password> 122 <runtime_admin> password

<server_context> 124 ou=0ESSystemObjects.dc=<domain name
prefix>.dc=<domain name suffix>

<server_object> 125 cn=DNS_edir-
<hostname>, ou=0ESSystemObjects, dc=<domain name
prefix>,dc=<domain name suffix>

<slp_da> 129 <listentry> SLP server IP </listentry>

<tree_type> 134 New

<xad_config_dns> 137 Yes

<xad_domain_name> 139 Domain name of the forest

<xad_domain_type> 140 Forest

<xad_forest_root> 142 Domain Name

<xad_ldap_admin_context> 143 cn=<Administrator names.cn=Users.dc=<domain
prefix>.dc=<domain name suffix>

<xad_ldap_admin_password> 144 Password of the DSfW forest domain administrator

<xad_netbios> 146 Unique netBIOS in the subnet

<host_address> 588 IP address of the local server

<name> 590 <host name>.<domain name of the forest> <host name>

<domain> 702 <domain name of the forest>

<hostname> 703 Hostname of the target server

<ipaddr> 719 IP address of the target server

<admin_group> 772 cn=admingroup, ou=OESSystemObjects, dc=<domain
name prefix>,dc=<domain name suffix>

<partition_root> 784 ou=0ESSystemObjects,dc=<domain name
prefix>,dc=<domain name suffix>

<ws_context> 788 ou=0ESSystemObjects,dc=<domain name
prefix>,dc=<domain name suffix>

<nssadmin_dn> 792 cn=<hostnames.ou=0ESSystemObjects.dc=<domain
name prefix>.dc=<domain name suffix>

<admin_context> 919 cn=<Administrator names.cn=Users.dc=<domain
name prefixs>.<domain name suffixs

<admin_password> 920 Same password that is entered in

<xad_ldap_admin_password>
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Tag Line Value to be specified
number

<ip_address> 923 IP address of the target server

<proxy_context> 928 cn=0ESCommonProxy <hostnames.ou=0ESSystemObject
s,dc=<domain name prefix>.<domain name suffix>

<nameserver> 705 IP address of target server

<search> 710 Domain name of target server

<netmask> 721 Subnet mask of the network

<broadcast> 734 Broadcast IP address of the network

<gateway> 752 IP address of the gateway in the network

<admin_group > 772 LUM admingroup context. You can create a new group in
any context or point to an existing admingroup.

<lum_enabled_services> 774 You can choose LUM services based on your requirement.
For example, if you want to enable FTP service, set the
value of the <ftp> tag to yes.

<proxy_user> 785 FQDN of the common proxy user if you want to configure
LUM using common proxy. Otherwise, the value of this tag
can be empty.

<proxy_user_password> 786 Common proxy user password of the <proxy user>
defined on line 785

<admin_password > 920 DSfW administrator password

<proxy_password> 929 Password of the <proxy_context>

<tree_name > 930 eDirectory tree name

<timezone> 1451 Timezone

Additional Domain Controller in a Non Name Mapped Environment

Table 6-5 Template file modifications for ADC in a hon-name-mapped installation

Tag Line Value to be specified
number

<media_url> 7 Path of OES media

<ca_commonName> 83 YaST Default CA (<domainname>)

<organisation> 86 Tree name

<password> 88 Machine root password

<server_commonName> 89 <hosthame>.<domain name>
For example, if the value of this tag is frd.dsfw.com, you
must modify the value to adc.dsfw.com where adc is the
hostname of the target server.

<domain_name> 104 Empty

Installing Domain Services for Windows 103



Tag Line Value to be specified
number

<group_context> 106 FQDN of the DNS DHCP group object

<host_name> 107 Empty

<ldap_basedn> 111 Empty

<ldap_server> 112,773,7 IP address of the target server

91,1226

<locater_context> 113 FQDN of the base container that has the DNS DHCP
locator object.

<ntp_server_list> 116 <listentry> NTP server IP </listentry>

<replica_server> 120 IP address of the primary domain controller

<runtime_admin> 121 Empty

<runtime_admin_password> 122 <runtime_admin> password

<server_object> 125 Empty

<slp_da> 129 <listentry> SLP server IP </listentry>

<tree_type> 134 Existing

<xad_config_dns> 137 Yes or No
A value of “Yes” indicates that the server will be
configured as a DNS server for the domain.

<xad_convert_existing_container> 138 Empty

<xad_domain_type> 140 Controller

<xad_existing_container> 141 Empty

<xad_forest_root> 142 Domain Name

<xad_ldap_admin_context> 143 cn=<Administrator names.cn=Users.dc=<domain
prefixs.dc=<domain name suffixs

<xad_parent_domain_admin_context> 150 FQDN of the parent domain administrator. For example:
cn=<Administrator names>.cn=users.dc=<domain
name prefixs.dc=<domain name
suffixls>,dc=<domain name suffix2>

<xad_replicate_partitions> 152 Yes

<xad_retain_policies> 153 Yes or No

<host_address> 588 IP address of the target server

<name> 590 <hostname>.<domain name> <hostname>
For example, if the value of thistag is frd.dsfw.com frd,
you must modify the value to adc.dsfw.com adc where
adc is the hostname of the target server.

<ldap_domain> 679 dc=<domain name prefix 1>,dc=<domain name

prefix 2>,dc=<domain name suffix 1>,dc=<domain
name suffix 2>
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Tag Line Value to be specified
number
<hostname> 703 Hostname of the target server
<nameserver> 705 IP address of the existing DSfW server running DNS
<search> 710 Domain name of existing DSfW server running DNS
<ipaddr> 719 IP address of the target server
<netmask> 721 Subnet mask of the network
<broadcast> 734 Broadcast IP address of the network
<gateway> 752 IP address of the gateway in the network
<admin_group > 772 LUM admingroup context. You can create a new group in
any context or point to an existing admingroup.
<lum_enabled_services> 774 You can choose LUM services based on your
requirement. For example, if you want to enable FTP
service, set the value of the <ftp> tag to yes.
<sshd> 781 yes
<proxy_user> 785 FQDN of the common proxy user if you want to configure
LUM using common proxy. Otherwise, the value of this
tag can be empty.
<proxy_user_password> 786 Common proxy user password of the <proxy user>
defined on line 785
<nssadmin_dn> 792 cn=<hostname>admin.ou=0ESSystemObjects.<FQDN of
the base containers>
<admin_password > 920 DSfW administrator password
<ldap_servers> 923 Add the following to the Idap_servers tag:
<listentrys>
<ip address> IP address of the 1local
server</ip addresss>
<ldap port config:type="integer">389</
ldap_ports>
<ldaps port config:type="integer">636</
ldaps_ports>
</listentrys>
<listentry>
<ip address> IP address of the
primary domain controller</ip address>
<ldap port config:type="integer">389</
ldap_port>
<ldaps port config:type="integer">636</
ldaps_port>
</listentry>
<proxy_context> 928 cn=0OESCommonProxy <hostname>, ou=0OESSystemObject
s,<FQDN of the base container>
<proxy_password> 929 Password of the <proxy_context>
<tree_name > 930 eDirectory tree name
<timezone> 1451 Timezone
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Child Domain Controller in a Non Name Mapped Environment

Table 6-6 Template file modifications for CDC in a non-name-mapped installation

Tag Line Value to be specified
number
<media_url> 7 Path of OES media
<ca_commonName> 83 YaST Default CA (<domainname>)
<organisation> 86 Tree name
<password> 88 Machine root password
<server_commonName> 89 <hostname>.<domain name>
For example, if the value of this tag is frd.dsfw. com,
you must modify the value to cdc.child.dsfw.com
where cdc is the hostname of the target server and
child.dsfw.com is the domain name.
<server_email> 90 postmaster@<domain name>
<domain_name> 104 Empty
<group_context> 106 FQDN of the DNS DHCP group object
<host_name> 107 Empty
<ldap_basedn> 111 Empty
<ldap_server> 112,773,7 |IP address of the target server
91,1226
<locater_context> 113 FQDN of the base container that has the DNS DHCP
locator object.
<ntp_server_list> 116 <listentry> NTP server IP </listentry>
<replica_server> 120 IP address of the existing eDirectory server
<runtime_admin> 121 Empty
<runtime_admin_password> 122 <runtime_admin> password
<server_context> 124 ou=0ESSystemObjects.<FQDN of the base
containers
<server_object> 125 Empty
<slp_da> 129 <listentry> SLP server IP </listentry>
<tree_type> 134 Existing
<xad_config_dns> 137 Yes or No
A value of “Yes” indicates that the server will be
configured as a DNS server for the domain.
<xad_domain_name> 139 domain name
<xad_domain_type> 140 domain
<xad_existing_container> 141 FQDN of the base container that has been partitioned
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Tag Line Value to be specified
number

<xad_forest_root> 142 Domain Name

<xad_ldap_admin_context> 143 cn=<Administrator names>.cn=Users.dc=<domain
prefix>.dc=<domain name suffix>

<xad_netbios> 146 Unique netBIOS in the subnet

<xad_parent_domain> 148 Domain name of the parent domain

<xad_parent_domain_address> 149 IP address of the parent domain

<xad_parent_domain_admin_context> 150 FQDN of parent domain administrator. For example:
cn=Administrator.cn=Users.dc=<domain
name>.dc=<domain suffix 1>.dc=<domain suffix
2>.

<xad_parent_domain_admin_password> 151 Password of the parent domain

<host_address> 588 IP address of the target server

<name> 590 <hostname>.<domain name> <hostname>

<hostname> 679 hostname

<domain> 702 domain name

<nameserver> 705 IP address of the existing DSfW server running DNS

<search> 710 Domain name of existing DSfW server running DNS

<ipaddr> 719 IP address of the target server

<netmask> 721 Subnet mask of the network

<broadcast> 734 Broadcast IP address of the network

<gateway> 752 IP address of the gateway in the network

<admin_group > 772 LUM admingroup context. You can create a new group
in any context or point to an existing admingroup.

<lum_enabled_services> 774 You can choose LUM services based on your
requirement. For example, if you want to enable FTP
service, set the value of the <ftp> tag to yes.

<partition_root> 784 ou=OESSystemObjects, <FODN of the base
container>

<proxy_user> 785 FQDN of the common proxy user if you want to
configure LUM using common proxy. Otherwise, the
value of this tag can be empty.

<proxy_user_password> 786 Common proxy user password of the <proxy user>
defined on line 785

<ws_context> 788 ou=0ESSystemObjects, <FQDN of the base
containers

<nssadmin_dn> 792 cn=<hostnames>admin.ou=0ESSystemObjects.<FQDN

of the base containers>
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Tag Line Value to be specified
number
<admin_context> 919 cn=<Administrator names.cn=Users.dc=<domain
name cdc prefix>.dc=<domain name frd
prefix>.dc=<domain suffixls>.<dc suffix2s>.
<admin_password > 920 DSfW administrator password
<ldap_servers> 923 Add the following to the Idap_servers tag:
<listentrys>
<ip address> IP address of the local
server</ip address>
<ldap port config:type="integer">389</
ldap_port>
<ldaps_port
config:type="integer">636</ldaps port>
</listentrys>
<listentry>
<ip address> IP address of the
parent domain</ip addressx>
<ldap port config:type="integer">389</
ldap_port>
<ldaps_port
config:type="integer">636</ldaps port>
</listentry>
<proxy_context> 928 cn=0ESCommonProxy <hostnames, ou=OESSystemObje
cts,<FQDN of the base container>
<proxy_password> 929 Password of the <proxy_context>
<tree_name > 930 eDirectory tree name
<timezone> 1451 Timezone
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7.1

1.2

Provisioning Domain Services for
Windows

This section describes the process of provisioning and describes how you can use the Domain
Services for Windows (DSfW) Provisioning Wizard to configure DSfW and the supporting services on
top of eDirectory.

+ Section 7.1, “What Is Provisioning?,” on page 109

+ Section 7.2, “Features and Capabilities of the Provisioning Wizard,” on page 109

¢ Section 7.3, “Provisioning Wizard Interface,” on page 110

¢ Section 7.4, “Using the Wizard to Provision the DSfW Server,” on page 112

+ Section 7.5, “Provisioning Tasks,” on page 113

+ Section 7.6, “Provisioning Tasks for Name-Mapped and Non-Name-Mapped Scenarios,” on
page 118

+ Section 7.7, “Logging,” on page 122
¢ Section 7.8, “Troubleshooting,” on page 123

+ Section 7.9, “Executing Provisioning Tasks Manually,” on page 130

What Is Provisioning?

After you have installed DSfW, you need to configure DSfW and the supporting services to make the
DSfW server ready for use. Provisioning is the process of configuring the services on a DSfW server.
It is made up of a series of logical steps that execute in a predetermined order to complete the DSfW
installation.

The configuration details provided during DSfW installation serve as input for the Provisioning
Wizard. The tasks to be executed for provisioning vary with the scenario in which DSfW has been
installed.

Features and Capabilities of the Provisioning
Wizard

The Provisioning Wizard makes it easy to configure services on DSfW.

+ Dynamic Task list : As explained in What Is Provisioning?, the tasks displayed during the
provisioning process vary with the scenario in which DSfW has been installed. When you launch
the Provisioning Wizard, you see only those tasks that are essential to provision the DSfW
server in a specific scenario.

+ Resuming Tasks : The Provisioning Wizard stores the status and details of the tasks being
performed inthe /etc/opt/novell/xad/provisioning.xmnl file. If you close the wizard window
or cancel a task during provisioning, the next time you launch provisioning, the task resumes
from the point it was stopped.
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+ Precheck and Post check : The Provisioning Wizard is made up of pluggable scripts that

contain set of instructions to validate the state of the system after a provisioning task is
completed and before the start of the next provisioning task.

Each task has a corresponding script located in the /opt/novell/xad/lib64/perl/Install
folder. These scripts contain pre-operation and post-operation pluggable subroutines that take
care of the validation process. The precheck ensures that all the prerequisites are met for
execution of the task and the post-check ensures that the task is finished before moving on to
the next task.

Skipping Tasks: If you choose not to execute a particular task from the Provisioning Wizard,
you can choose to skip that task and later execute the task manually from the console. A
validation is done to ensure that the task that is skipped has been performed manually.The
logging feature is available only for tasks performed through the Provisioning Wizard. If you
execute tasks manually by using the process in Section 7.9, “Executing Provisioning Tasks
Manually,” on page 130, the task execution details are logged in the /var/opt/novell/xad/
log/ndsdcinit. log file.

IMPORTANT: When you decide to skip a task from the Provisioning Wizard, the task has to be
executed from the console. As part of pre-check process, checks are done to ensure that all the
prerequisites are met for execution of the next task.

Error Handling and Logging : During execution of each provisioning task, any errors or
warnings are logged in the /var/opt/novell/xad/log/provisioning.log file. The log file
records details and error codes that help you when you need to debug errors. For more
information about logging, see Section 7.7, “Logging,” on page 122.

7.3 Provisioning Wizard Interface

The Provisioning Wizard provides a single interface to configure services on DSfW and is divided into
the following panes:

+ Task List
+ Task Description

+ Log Messages
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Figure 7-1 Snapshot of the Provisioning Wizard
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Task List : The task list displayed on the left pane of the wizard varies with the installation scenario.
The configuration information provided during DSfW installation serves as input for the Provisioning
Wizard to compute the list of tasks to be displayed.

For example: If you selected a non-name-mapped scenario for DSfW installation, the tasks to be
performed for provisioning are different from the tasks to be performed if you selected a name-
mapped scenario for installation. For details on the tasks for each provisioning scenario, see
Section 7.6, “Provisioning Tasks for Name-Mapped and Non-Name-Mapped Scenarios,” on
page 118.

Task Description : The Task Description pane displays a short description of the task currently being
performed. If you need more information on the task, select the Help option. This displays detailed
help for the wizard.

Log Messages : The Log Messages pane displays details of events happening in the background
and the status of each operation. To read more about logs, see Section 7.7, “Logging,” on page 122.

The following table describes the functionality of the buttons in the Provisioning Wizard:
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Table 7-1 Provisioning Screen Buttons

Option Description

Skip This option can be used in cases where you have already executed a task
manually and then decide to execute rest of the tasks by using the
Provisioning Wizard.

When you click the Skip option, the next task is selected.

Run All Select this option if you want all the tasks to be executed sequentially without
manual intervention.

Run Executes the current task.

Rerun This option is displayed when a task fails to complete because of an error.
Select this option to execute the task again.

Abort Cancels the current task.

Help Displays descriptive help for each task.

7.4 Using the Wizard to Provision the DSfW Server

1 After DSfW installation is done, you must run the Provisioning Wizard to complete the DSfW
configuration process. To launch the wizard, do one of the following:

¢ From the terminal, run the /opt/novell/xad/sbin/provision dsfw.sh Script.
+ Launch YaST. The DSfW Provisioning Wizard is listed as an option.
This opens the login dialog box.

NOTE: If you do not provision the DSfW server every time you login, a dialog box indicating that
DSfW configuration is not complete is displayed. The DSfW server will not be functional till the
provisioning is completed.

2 Enter the password in the login dialog box, depending on the scenario in which you are
provisioning.

Table 7-2 Authentication Details for Provisioning

Provisioning Scenario Password Details Required

Non-name-mapped, forest root domain The current domain password.

Name-mapped, forest root domain The current domain password and the tree admin
password.

Non-name-mapped child The current domain password, the parent domain

password, and the tree/container admin password.

Name-mapped child The current domain password, the parent domain
password, and the tree/container admin password.

additional domain controller The current domain and tree admin password.

After the password details are verified, the Provisioning Wizard is launched.
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1.5

IMPORTANT: If you are installing the first child domain in a non-name-mapped scenario, the
tree admin and the parent domain password is the same.

For name mapped installation scenarios, the Enable Custom Provisioning check box is
enabled. This check box remains disabled for all non-name mapped and ADC installation
scenarios. To enable custom provisioning, continue with Step 3.

or

If you don’t want to customize provisioning, leave the Enable Custom Provisioning check box
deselected. Click OK, then follow the on-screen prompts to configure DSfW and the supporting
services to complete the installation process and make the DSfW server ready for use.

Select the Enable Custom Provisioning check box and click OK. Custom provisioning enables
you to add multiple eDirectory partitions to a DSfW domain.

Select the partitions that you want to map to the domain. When you select a partition, validation
checks are performed on the partition before mapping it to the domain.

IMPORTANT: If the replica is not local, you cannot select the partition. To map a partition to the
domain, you must first ensure that the replica is present on the local server and then click
Refresh to reload the tree view. You can then select the partitions from the tree view.

5 Click Next to continue with the DSfW provisioning process.

Provisioning Tasks

NOTE: To know about the provisioning tasks associated with each installation scenario, see
Section 7.6, “Provisioning Tasks for Name-Mapped and Non-Name-Mapped Scenarios,” on
page 118.

The Provisioning Wizard lets you perform the following tasks:

*

Section 7.5.1, “Provisioning Precheck,” on page 114
Section 7.5.2, “Configure DNS,” on page 114

Section 7.5.3, “Configure DNS and WINS,” on page 115
Section 7.5.4, “Create Domain Partition,” on page 115
Section 7.5.5, “Add Domain Replica,” on page 115

Section 7.5.6, “Configure SLAPI Plug-Ins,” on page 116
Section 7.5.7, “Add Domain Objects,” on page 116

Section 7.5.8, “Create Configuration Partition,” on page 116
Section 7.5.9, “Create Schema Partition,” on page 116
Section 7.5.10, “Add Configuration Objects,” on page 116
Section 7.5.11, “Add Domain Controller,” on page 117
Section 7.5.12, “Assign Rights,” on page 117

Section 7.5.13, “Samify Objects,” on page 117

Section 7.5.14, “Configure Site,” on page 117

Section 7.5.15, “Restart DSfW Services,” on page 117
Section 7.5.16, “Set Credentials for Accounts,” on page 118
Section 7.5.17, “Enable Kerberos,” on page 118
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7.5.1

7.5.2

114

*

*

Section 7.5.18, “Establish Trust,” on page 118
Section 7.5.19, “Cleanup,” on page 118

Provisioning Precheck

This task verifies the state of the servers to ensure that they are ready for provisioning.

As part of the provisioning precheck activity, a health check is performed in the background to
validate the state of the system to avoid a stale state. Not validating the system state can lead to
irrecoverable failures in the system. This makes the health check very important.

The health check performs the following actions:

*

Verifies that the services important for the installation, such as Kerberos, Samba, and NMB, are
running on the remote server.

Verifies that the DNS service is active on the server configured as the DNS server.

Verifies that all the servers that are part of the replica ring are active and that time is
synchronized among the servers.

Verifies that the version of eDirectory on the server where installation is done is 8.8 SP2 or later.

In a name-mapped installation scenario, it checks the server to see if it contains any existing
DSfW-specific objects.

Triggers a purge on the remote server to clear deleted objects.

Configure DNS

This task configures DNS on the DSfW server. DSfW uses DNS as its location service, enabling
computers to find the location of domain controllers.

As part of this task, the following actions are performed:

*

*

*

Forward Lookup zones are configured for the domain to resolve queries on domain name
lookup.

Reverse Zones are configured for the domain to resolve requests that need to associate a DNS
name with an IP address.

Resource records of type NS, SRV, A, PTR are created.

The zone references are added to the DNS Server, DNS Group object, and the DNS Locator
object.

Currently, DSfW is tightly coupled with Novell DNS and needs at least one DNS server to run on
a domain controller.

NOTE: As part of DSfW installation, the DNS server is configured in the first domain in the forest. For
subsequent child domains, you can either link to the DNS server in the first domain or install a DNS
server for the child domain.
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7.5.3

7.5.4

7.5.5

Configure DNS and WINS

This task configures DNS and WINS on the DSfW server. DSfW uses DNS as its location service,
enabling computers to find the location of domain controllers. You can also configure a DSfW server
as a WINS server. WINS is a name server and service for NetBIOS computer names. It provides
NetBIOS name to IP address mapping for the client workstations in different subnets.

As part of DNS configuration, the following actions are performed:
+ Forward Lookup zones are configured for the domain to resolve queries on domain name
lookup.

+ Reverse Zones are configured for the domain to resolve requests that need to associate a DNS
name with an IP address.

+ Resource records of type NS, SRV, A, PTR are created.

+ The zone references are added to the DNS Server, DNS Group object, and the DNS Locator
object.

Currently, DSfW is tightly coupled with Novell® DNS and needs at least one DNS server to run
on a domain controller, but there are future plans to provide support for any DNS server capable
of supporting secure DNS updates.

By default, the DNS server is configured on the first domain controller in a forest. For any additional
domain controller in the forest, you can either use the existing DNS server in the forest or configure
this server as a DNS server. Before configuring any additional domain controller in the domain,
ensure that the nameserver entry in /etc/resolv. conf points to the DNS server that the first domain
controller of the domain is using.

As part of WINS configuration, the following actions are performed:

+ The DNS entry in the corresponding zone object is created.

¢ The /etc/samba/smb.conf file is updated with the parameters required for Samba services
to act as a WINS server.

+ The nmb process is restarted.

The post?check operation for the task checks if the DNS entry and data files corresponding to WINS
are created.

Create Domain Partition

This task creates a partition for the domain.

This partition has complete information about all the domain objects. Information about the domain
objects is replicated to domain controllers in the same domain.

Add Domain Replica

This task adds the replica to the local server.

NOTE: This task is executed for all provisioning scenarios except for non-name-mapped and forest
root domain installation.
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7.5.6 Configure SLAPI Plug-Ins

This task loads the SLAPI plug-ins. The SLAPI plug-ins take care of maintaining the Active Directory
information model. This ensures that the SLAPI framework is ready before any domain-specific data
is added.

During the configuration process, the following tasks are performed:

+ Attributes and Classes are mapped between Active Directory and eDirectory schema objects.
+ The NLDAP server is refreshed and the SLAPI plug-ins are loaded.
+ The NAD plug-in is checked to see if it is loaded.

7.5.7 Add Domain Objects

This task adds the domain objects that represent the domain-specific information under the domain
partition.

The domain partition replicates data only to the domain controllers within its domain. In addition to
this, it also creates containers for configuration and schema partitions that are later partitioned.

7.5.8 Create Configuration Partition

This task partitions the configuration container (cn=configuration) created as part of the Domain
Objects Addition task. This configuration partition contains information on the physical structure and
configuration of the forest (such as the site topology).

In case of a child domain installation, the replica of the configuration container is added to the local
server.

The configuration partition is forest specific and by default the first domain controller of every domain
gets a replica. The Additional Domain gets the replica of this partition if you select the Replicate
schema and configuration partitions option in YaST during installation.

759 Create Schema Partition

This task partitions the schema container (cn=schema) created during the Domain Objects Addition
task.

The schema partition contains the definition of object classes and attributes within the forest. If there
is a child domain or additional domain controller, replica of the schema container is added to the local
server.

The schema partition is forest-specific and by default the first domain controller of every domain gets
a replica. The Additional Domain gets the replica of this partition if you select the Replicate schema
and configuration partitions option in YaST during installation.

7.5.10 Add Configuration Objects

This task adds the configuration and schema partition objects.

It helps maintain integrity with the Active Directory information model.
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7.5.11

7.5.12

7.5.13

7.5.14

7.5.15

Add Domain Controller

This task adds the domain controller to the domain.

This task creates additional objects that make your server act as a domain controller. The task is only
executed if you have installed DSfW as an additional domain controller in the domain.

Assign Rights

This task configures directory-specific access rights for the domain and the domain administrator
being provisioned.

The task performs the following activities:

+ Computes effective ACLs.
+ Imports NDS Super rights ACLs and sets rights for the administrator at the container level.
¢ Imports NDS Admin ACLs.

Samify Objects

The existing user and group objects are extended to receive Active Directory attributes that allow
them to be part of the domain being provisioned. Some of the extended attributes are supplementary
Credentials, objectSid, and samAccountName.

Configure Site

This task partitions the domain controller object (MSDS:Server), which is represented as a container
object in eDirectory. This domain controller object is located under
cn=Servers,cn=<sitename>,cn=Sites, cn=Configuration,dc=<domain name>

This task performs the following actions:

+ Pre?checks the DSfW environment before partitioning of the object.
+ Partitions the domain controller object.
+ Post?checks the DSfW environment after partitioning of the object.

Restart DSfW Services

This task restarts services in order of dependence.

The restart is essential for the changes to be committed. The services that are restarted, as part of
this task are:
1. ndsd (eDirectory)
novell-named (DNS)
nscd (Name Server cache daemon)
rpcd (RPC server)
xad-krb5kdc (Kerberos)
xad-kpasswdd (Kpassword)
xadsd (XAD daemon)

N o o > w DN
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7.5.16

7.5.17

7.5.18

7.5.19

118

1.6

8. nmbd (NMB server, NETBIOS lookup)
9. winbindd

10. smbd (Samba)

11. sshd (SSH)

12. rsyncd (rsync)

After the services are restarted, your domain is up. However, before it is ready for use, you need to
perform the remaining tasks in the provisioning wizard.

Set Credentials for Accounts

This task sets the password and kerberizes the administrator, krbgt, and guest accounts.

Enable Kerberos

In DSfW, Kerberos is the primary security protocol for authentication within a domain. The Kerberos
authentication mechanism issues tickets for accessing network services.

As part of this task, the krbs. conf file is updated and a ticket is sent to the administrator principal.

These changes trigger a change in the Kerberos Policy files that are stored in sysvol. This change
requires a synchronization update to eDirectory, which is done by using the gpo2nmas utility.

Establish Trust

A trust is a relationship established between domains that enables users in one domain to be
authenticated by a domain controller in the other domain. Authentication between domains occurs
through trusts.

This task establishes two-way transitive trust relationships between the domain being provisioned
and the parent domain. In a transitive trust, all the domains belonging to the same forest trust each
other. If any more new domains are added, an automatic trust relationship is established between the
root domain and the new domain.

For example: If domain A trusts domain B and domain B trusts domain C, then users from domain C
can access resources in domain A.

Cleanup

This task removes files from a partial or failed installation. It also removes the temp directories and
checkpoint files created during provisioning.

Provisioning Tasks for Name-Mapped and Non-
Name-Mapped Scenarios

The following table lists the provisioning tasks corresponding to each installation scenario.
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Table 7-3 Provisioning Tasks for Different Installation Scenarios

Installation Scenario

Provisioning Tasks

Installing DSfW in a Non-Name-Mapped Setup
(Forest Root Domain)

*

*

Provisioning Precheck
Configure DNS

NOTE: If you have selected the configure this
server as a WINS server option in YaST, the
Configure DNS and WINS task is executed
instead of the Configure DNS task.

Create Domain Partition
Configure SLAPI Plug-Ins
Add Domain Objects

Create Configuration Partition
Create Schema Partition
Add Configuration Objects
Assign Rights

Samify Objects

Configure Site

Restart DSfW Services

Set Credentials for Accounts
Enable Kerberos

Cleanup

Installing DSfW in a Name-Mapped Setup (Forest
Root Domain)

Provisioning Precheck
Configure DNS

NOTE: If you have selected the configure this
server as a WINS server option in YaST, the
Configure DNS and WINS task is executed
instead of the Configure DNS task.

Add Domain Replica
Configure SLAPI Plug-Ins
Add Domain Objects

Create Configuration Partition
Create Schema Partition
Add Configuration Objects
Assign Rights

Samify Objects

Configure Site

Restart DSfW Services

Set Credentials for Accounts
Enable Kerberos

Cleanup
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Installation Scenario

Provisioning Tasks

Installing DSfW in a Name-Mapped Setup (Child
domain)

Provisioning Precheck
Configure DNS

NOTE: If you have selected the Configure this
server as a WINS server option in YaST, the
Configure DNS and WINS task is executed
instead of the Configure DNS task.

Add Domain Replica
Configure SLAPI Plug-Ins
Add Domain Objects

Create Configuration Partition
Create Schema Partition
Add Configuration Objects
Assign Rights

Samify Objects

Configure Site

Restart DSfW Services

Set Credentials for Accounts
Enable Kerberos

Establish Trust

Cleanup
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Installation Scenario

Provisioning Tasks

Installing DSfW in a Non-Name-Mapped Setup (Child
domain)

*

*

Provisioning Precheck

Configure DNS

NOTE: If you have selected the Configure this

server as a WINS server option in YaST, the
Configure DNS and WINS task is executed
instead of the Configure DNS task.

Create Domain Partition
Add Domain Replica
Configure SLAPI Plug-Ins
Add Domain Objects

Create Configuration Partition
Create Schema Partition
Add Configuration Objects
Assign Rights

Samify Objects

Configure Site

Restart DSfW Services

Set Credentials for Accounts
Enable Kerberos

Establish Trust

Cleanup

Installing DSfW as an additional domain controller in a
Domain

Provisioning Precheck

Add Domain Replica
Configure SLAPI Plug-Ins
Create Configuration Partition
Create Schema Partition
Add Domain Controller
Assign Rights

Configure Site

Restart DSfW Services

Set Credentials for Accounts
Enable Kerberos

Configure DNS

NOTE: If you have selected the Configure this

server as a WINS server option in YaST, the
Configure DNS and WINS task is executed
instead of the Configure DNS task.

Cleanup
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7.7 Logging
The Log Messages pane in the Provisioning Wizard displays the details and status of events

happening in the background during the execution of each task.

The log details are displayed on the GUI and also logged in the /var/opt/novell/xad/log/
provisioning.log file.

The details that are recorded in the log file are:
+ The status of each task.

+ The status of health check operations

+ The output, error messages, and warnings printed by utilities such as 1dapsearch, and
ldapconfig.

Tasks return a zero value on success and specific error codes on failure. These error codes provide
useful information for debugging purposes.

Table 7-4 Error Code ldentifiers

Error Codes Module

101-110 Remote Server Health Check
111-120 DNS Server Status

121-130 Bad Address Cache

131-140 Purger Execution

141-150 Top Level Container Check
151-160 eDirectory Server Status

In addition to the provisioning.log file that contains information on tasks executed through the
Provisioning Wizard, you can use the following log files for debugging purposes:

Table 7-5 Additional Log Files

Log file What it Contains
/var/opt/novell/xad/log/healthcheck.log Contains details about health check process
/var/opt/novell/xad/log/ndsdcinit.log Contains log messages from the install framework.

Details recorded include:

¢+ Commands executed
* Success or failure of each operation

+ Pre and post check operation details.

122 OES 11 SP3: Domain Services for Windows Administration Guide



1.8

7.8.1

Troubleshooting

This section describes some issues you might experience with Novell Domain Services for
Windows(DSfW) while provisioning and provides suggestions for resolving or avoiding them.

+ Section 7.8.1, “Troubleshooting Provisioning Tasks,” on page 123

Troubleshooting Provisioning Tasks

This section describes the errors that you might experience while executing the Provisioning tasks
and provides details for resolving them.

+ “Provisioning Precheck” on page 123

+ “Configure DNS” on page 123

+ “Configure SLAPI Plug-in” on page 124

+ “Create Domain Partition” on page 125

+ “Add Domain Replica” on page 126

+ “Add Domain Objects” on page 126

+ “Create Configuration Partition” on page 127

+ “Create Schema Partition” on page 128

+ “Add Configuration Objects” on page 128

+ “Assign Rights” on page 129

+ “Establish Trust” on page 130

+ “Update Service Configuration” on page 130

¢ “Cleanup” on page 130

Provisioning Precheck

All details related to task execution and state of the task are recorded in the provisioning.log file

Error: Provisioning Pre-check Failed

Cause: The provisioning pre-check scripts check for existence of schema and configuration partition
in the first domain controller. If the first domain controller does not have a schema and configuration
partition, it fails to locate the partitions, an error is thrown.

Solution: It is recommended that you select the Replicate schema and configuration Partitions
option during installation. If you have failed to do that, replicate the partitions using iManager. For
more information, see Administering Replicas (http://www.netiq.com/documentation/edir88/edir88/
data/fbgciaad.html)

Configure DNS

All details related to task execution and state of the task are recorded in the provisioning.log file

+ “Error: Insufficient Access” on page 124
+ “Entry already Exists” on page 124
+ “ldapmodify Failed” on page 124
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124

Error: Insufficient Access

Cause: The administrator being used to execute the 1dapmodify command does not have privileges
to complete the operation.

Solution 1: In the provisioning.log file, search for the 1dapmodify command. Make sure the
administrator used to execute that command has adequate privileges to execute this command.

Solution 2: If the DNS Locator and Group objects are outside the domain partition, make sure the
administrator has privileges to access the objects.

Entry already Exists
Cause: You see this error when you retry executing a task and the task fails during execution.

Solution: For any task that has failed, delete the associated objects from the server and then retry
the task.

Depending on the task that failed, different objects are created. For instance, if the DNS Configuration
task failed, you need to delete the Locator object and the Group object

Idapmodify Failed
Cause: Replica synchronization fails.

Solution: To resolve this issue, refer Novell Error Codes Reference Guide (http://www.novell.com/
documentation/nwec/?page=/documentation/nwec/nwec/data/al39nky.html)

Configure SLAPI Plug-in

+ “Error: Insufficient Access” on page 124

+ “Entry already Exists” on page 124

+ “ldapmodify Failed” on page 125
Cause:

The NAD Plug-in is not loaded

Solution:
Execute 1dapsearch on the LDAP server object to find out adman NAD plug-in is configured.

Perform LDAP server refresh using iManager or using the 1dapconfig -R -a <admin> -w
<passwd> command.

Error: Insufficient Access

Cause: The administrator being used to execute the 1dapmodify command does not have privileges
to complete the operation.

Solution: Inthe provisioning.log file, search for the 1dapmodify command. Make sure the
administrator used to execute that command has adequate privileges to execute this command.

Entry already Exists

Cause: You see this error when you retry executing a task and the task fails during execution.
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Solution: For any task that has failed, delete the associated objects from the server and then retry
the task.

Depending on the task that failed, different objects are created. For instance, if the DNS Configuration
task failed, you need to delete the Locator object and the Group object

Idapmodify Failed
Cause: Replica synchronization fails.

Solution: To resolve this issue, refer Novell Error Codes Reference Guide (http://www.novell.com/
documentation/nwec/?page=/documentation/nwec/nwec/data/al39nky.html)

Create Domain Partition

All details related to task execution and state of the task are recorded in the provisioning.log file

+ “Error: 626 All Referrals Failed” on page 125
+ “Error: 625 Transport Failure/ Unknown Error” on page 125
+ “Error: 30 Retry Entries to Get the Replica Status in the Log File” on page 125

Error: 626 All Referrals Failed
Cause: The synchronization process between the replicas fails.

Solution: To resolve this issue, refer Novell Error Codes Reference Guide (http://www.novell.com/
documentation/nwec/?page=/documentation/nwec/nwec/data/al39nky.html)

Error: 625 Transport Failure/ Unknown Error

Cause: The DSfW server could not reach the master server. For example, installing a child server
requires the parent server to be reachable, or installing a DSfW server in the name-mapped forest
root domain scenario requires the server holding the tree replica to be reachable.

Solution 1: Ensure that the servers are reachable. Remove the bad address cache from the servers
by using the following command:

set ndstrace=*UP
Try executing the task again.

Solution 2: Try executing the provisioning task manually. For details see, Section 7.9, “Executing
Provisioning Tasks Manually,” on page 130.

Error: 30 Retry Entries to Get the Replica Status in the Log File
Cause: A very slow network link can cause incomplete operations and multiple retries.

Solution: Check the speed of your network link. Try executing the task again.
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Add Domain Replica

All details related to task execution and state of the task are recorded in the provisioning.log file

+ “Error: 626 All Referrals Failed” on page 126
+ “Error: 625 Transport Failure/ Unknown Error” on page 126

+ “Error: 30 Retry Entries to Get the Replica Status in the Log File” on page 126

Error: 626 All Referrals Failed
Cause: The synchronization process between the replicas fails.

Solution: To resolve this issue, refer Novell Error Codes Reference Guide (http://www.novell.com/
documentation/nwec/?page=/documentation/nwec/nwec/data/al39nky.html)

Error: 625 Transport Failure/ Unknown Error

Cause: The DSfW server could not reach the master server. For example, installing a child server
requires the parent server to be reachable, or installing a DSfW server in the name-mapped forest
root domain scenario requires the server holding the tree replica to be reachable.

Solution 1: Ensure that the servers are reachable. Remove the bad address cache from the current
server by using the following command:.

set ndstrace=*UP
Try executing the task again.

Solution 2: Try executing the provisioning task manually. For details see, Section 7.9, “Executing
Provisioning Tasks Manually,” on page 130.

Error: 30 Retry Entries to Get the Replica Status in the Log File
Cause: A very slow network link can cause incomplete operations and multiple retries.

Solution: Check the speed of your network link. Try executing the task again.

Add Domain Objects

All details related to task execution and state of the task are recorded in the provisioning. log file.
+ “Error: Insufficient Access” on page 126
+ “Entry already Exists” on page 126
+ “ldapmodify Failed” on page 127

Error: Insufficient Access

Cause: The administrator being used to execute the 1dapmodify command does not have privileges
to complete the operation.

Solution: Inthe provisioning.log file, search for the 1dapmodify command. Make sure the
administrator used to execute that command has adequate privileges to execute this command.

Entry already Exists

Cause: You see this error when you retry executing a task and the task fails during execution.
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Solution: For any task that has failed, delete the associated objects from the server and then retry
the task.

Depending on the task that failed, different objects are created. For instance, if the DNS Configuration
task failed, you need to delete the Locator object and the Group object

Idapmodify Failed
Cause: Replica synchronization fails.

Solution: To resolve this issue, refer Novell Error Codes Reference Guide (http://www.novell.com/
documentation/nwec/?page=/documentation/nwec/nwec/data/al39nky.html)

Create Configuration Partition

All details related to task execution and state of the task are recorded in the provisioning.log file

+ “Error: 626 All Referrals Failed” on page 127
+ “Error: 625 Transport Failure/ Unknown Error” on page 127
+ “Error: 30 Retry Entries to Get the Replica Status in the Log File” on page 127

Error: 626 All Referrals Failed
Cause: The synchronization process between the replicas fails.

Solution: To resolve this issue, refer Novell Error Codes Reference Guide (http://www.novell.com/
documentation/nwec/?page=/documentation/nwec/nwec/data/al39nky.html)

Error: 625 Transport Failure/ Unknown Error

Cause: The DSfW server could not reach the master server. For example, installing a child server
requires the parent server to be reachable, or installing a DSfW server in the name-mapped forest
root domain scenario requires the server holding the tree replica to be reachable.

Solution 1: Ensure that the servers are reachable. Remove the bad address cache from the current
server by using the following command..

set ndstrace=*UP
Try executing the task again.

Solution 2: Try executing the provisioning task manually. For details see, Section 7.9, “Executing
Provisioning Tasks Manually,” on page 130.

Error: 30 Retry Entries to Get the Replica Status in the Log File
Cause: A very slow network link can cause incomplete operations and multiple retries.

Solution: Check the speed of your network link. Try executing the task again.
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Create Schema Partition
All details related to task execution and state of the task are recorded in the provisioning.log file

+ “Error: 626 All Referrals Failed” on page 128
+ “Error: 625 Transport Failure/ Unknown Error” on page 128
+ “Error: 30 Retry Entries to Get the Replica Status in the Log File” on page 128

Error: 626 All Referrals Failed
Cause: The synchronization process between the replicas fails.

Solution: To resolve this issue, refer Novell Error Codes Reference Guide (http://www.novell.com/
documentation/nwec/?page=/documentation/nwec/nwec/data/al39nky.html)

Error: 625 Transport Failure/ Unknown Error

Cause: The DSfW server could not reach the master server. For example, installing a child server
requires the parent server to be reachable, or installing a DSfW server in the name-mapped forest
root domain scenario requires the server holding the tree replica to be reachable.

Solution 1: Ensure that the servers are reachable. Remove the bad address cache from the current
server by using the following command:.

set ndstrace=*UP
Try executing the task again.

Solution 2: Try executing the provisioning task manually. For details see, Section 7.9, “Executing
Provisioning Tasks Manually,” on page 130.

Error: 30 Retry Entries to Get the Replica Status in the Log File
Cause: A very slow network link can cause incomplete operations and multiple retries.

Solution: Check the speed of your network link. Try executing the task again.

Add Configuration Objects

All details related to task execution and state of the task are recorded in the provisioning.log file

+ “Error: Insufficient Access” on page 128
+ “Entry already Exists” on page 129
+ “ldapmodify Failed” on page 129

All details related to task execution and state of the task are recorded in the provisioning.log file

Error: Insufficient Access

Cause: The administrator being used to execute the 1dapmodify command does not have privileges
to complete the operation.

Solution: Inthe provisioning.log file, search for the 1dapmodify command. Make sure the
administrator used to execute that command has adequate privileges to execute this command.
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Entry already Exists
Cause: You see this error when you retry executing a task and the task fails during execution.

Solution: For any task that has failed, delete the associated objects from the server and then retry
the task.

Depending on the task that failed, different objects are created. For instance, if the DNS Configuration
task failed, you need to delete the Locator object and the Group object

Idapmodify Failed
Cause: Replica synchronization fails.

Solution: To resolve this issue, refer Novell Error Codes Reference Guide (http://www.novell.com/
documentation/nwec/?page=/documentation/nwec/nwec/data/al39nky.html)

Assign Rights

All details related to task execution and state of the task are recorded in the provisioning.log file

+ “Error: Insufficient Access” on page 129
+ “Entry already Exists” on page 129
+ “ldapmodify Failed” on page 129

All details related to task execution and state of the task are recorded in the provisioning.log file

Error: Insufficient Access

Cause: The administrator being used to execute the 1dapmodify command does not have privileges
to complete the operation.

Solution 1: Inthe provisioning.log file, search for the 1dapmodify command. Make sure the
administrator used to execute that command has adequate privileges to execute this command.

Solution 2: If the DNS Locator and Group objects are outside the domain partition, make sure the
administrator has privileges to access the objects.

Entry already Exists
Cause: You see this error when you retry executing a task and the task fails during execution.

Solution: For any task that has failed, delete the associated objects from the server and then retry
the task.

Depending on the task that failed, different objects are created. For instance, if the DNS Configuration
task failed, you need to delete the Locator object and the Group object

Idapmodify Failed
Cause: Replica synchronization fails.

Solution: To resolve this issue, refer Novell Error Codes Reference Guide (http://www.novell.com/
documentation/nwec/?page=/documentation/nwec/nwec/data/al39nky.html)
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Establish Trust

Cause

This error occurs in cases where the parent realm could not be resolved

Solution

Use the provision -g -q --locate-dc parent.domain command to resolve the parent domain.
Retry executing the task.

Update Service Configuration

Cause

This error occurs in cases where the parent realm could not be resolved

Solution
Use the provision -q -g --locate-dc parent.domain command to resolve the parent domain.
Retry executing the task.

Cleanup

Cause

This error occurs in cases where the parent realm could not be resolved

Solution

Use the provision -g -g --locate-dc parent.domain command to resolve the parent domain.
Retry executing the task.

7.9 Executing Provisioning Tasks Manually

This section details the method of Provisioning DSfW server by using command line scripts.

+ Section 7.9.1, “Exporting Passwords,” on page 130

+ Section 7.9.2, “Provisioning Tasks,” on page 131

7.9.1 Exporting Passwords

Before provisioning DSfW server using the command line scripts, it is important to export the
passwords in order to authenticate and pass the credentials for the provisioning tasks.

You do not need to export the username. This is because the username used during YaST
configuration is stored in the xad.ini file and reused for provisioning.
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7.9.2

Table 7-6 Details of Passwords to be Exported

Scenarios

Password Details

Forest Root Domain

Child Domain

Additional Domain Controller

export NDSEXISTINGADMINPASSWD and
ADM_PASSWD with tree admin credentials

export ADM_PASSWD_DOMAIN=current domain
password

export ADM_PASSWD_PARENT=parent domain
password

export NDSEXISTINGADMINPASSWD-=tree domain
password

export NDSEXISTINGADMINNAME=tree admin
export ADM_PASSWD=current domain password

export NDSEXISTINGADMINPASSWD-=tree domain
password

Provisioning Tasks

NOTE: To know about the provisioning tasks associated with each installation scenario, see
Section 7.6, “Provisioning Tasks for Name-Mapped and Non-Name-Mapped Scenarios,” on

page 118.

+ “Provisioning Precheck” on page 132

¢ “Configure DNS” on page 132

+ “Configure DNS and WINS” on page 132
+ “Create Domain Partition” on page 133

+ “Add Domain Replica” on page 133

+ “Configure SLAPI Plug-ins” on page 133
+ “Add Domain Objects” on page 133

+ “Create Configuration Partition” on page 134
+ “Create Schema Partition” on page 134

+ “Add Configuration Objects” on page 134
+ “Add Domain Controller” on page 134

+ “Assign Rights” on page 134

+ “Samify Objects” on page 134

+ “Configure Site” on page 135

+ “Restart DSfW Services” on page 135

+ “Set Credential for Accounts” on page 135
+ “Enable Kerberos” on page 135

¢ “Establish Trust” on page 135

¢ “Cleanup” on page 135
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Provisioning Precheck

This task verifies the state of the servers to ensure that they are ready for provisioning.

As part of the provisioning precheck activity, a health check is performed in the background to
validate the state of the system to avoid a stale state. Not validating the system state can lead to
irrecoverable failures in the system. This makes the health check very important.

After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision precheck.pl

Configure DNS

This task configures DNS on the DSfW server. DSfW uses DNS as its location service, enabling
computers to find the location of domain controllers.

NOTE: As part of DSfW installation, the DNS server is configured in the first domain in the forest. For
subsequent child domains, you can either link to the DNS server in the first domain or install a DNS
server for the child domain.

After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision dns.pl

Configure DNS and WINS

This task configures DNS and WINS on the DSfW server. DSfW uses DNS as its location service,
enabling computers to find the location of domain controllers. You can also configure a DSfW server
as a WINS server. WINS is a name server and service for NetBIOS computer names. It provides
NetBIOS name to IP address mapping for the client workstations in different subnets.

As part of DNS configuration, the following actions are performed:
+ Forward Lookup zones are configured for the domain to resolve queries on domain name
lookup.

+ Reverse Zones are configured for the domain to resolve requests that need to associate a DNS
name with an IP address.

+ Resource records of type NS, SRV, A, PTR are created.

+ The zone references are added to the DNS Server, DNS Group object, and the DNS Locator
object.

Currently, DSfW is tightly coupled with Novell® DNS and needs at least one DNS server to run
on a domain controller, but there are future plans to provide support for any DNS server capable
of supporting secure DNS updates.

By default, the DNS server is configured on the first domain controller in a forest. For any additional
domain controller in the forest, you can either use the existing DNS server in the forest or configure
this server as a DNS server. Before configuring any additional domain controller in the domain,
ensure that the nameserver entry in /etc/resolv.conf points to the DNS server that the first domain
controller of the domain is using.

As part of WINS configuration, the following actions are performed:

+ The DNS entry in the corresponding zone object is created.
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¢ The /etc/samba/smb.conf file is updated with the parameters required for Samba services
to act as a WINS server.

+ The nmb process is restarted.

The post?check operation for the task checks if the DNS entry and data files corresponding to WINS
are created.

Create Domain Partition

This task creates a partition for the domain.

This partition has complete information about all the domain objects. Information about the domain
objects is replicated to domain controllers in the same domain.

NOTE: This task is not executed in a name-mapped scenario.

After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision partition domain.pl

Add Domain Replica

This task moves the replica of the domain partition from the master server to the local server.

NOTE: This task is executed for all provisioning scenarios except for non-name-mapped and forest
root domain installation.

After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision add domain replica.pl

Configure SLAPI Plug-ins

This task loads the SLAPI plug-ins. The SLAPI plug-ins take care of maintaining the Active Directory
information model. This ensures that the SLAPI framework is ready before any domain-specific data
is added.

After you have exported the passwords, execute the following script:

/opt/novell /xad/share/dcinit/provision/provision config slapi.pl

Add Domain Objects

This task adds the domain objects that represent the domain-specific information under the domain
partition.

After you have exported the passwords, execute the following script:

lopt /novell/xad/share/dcinit/provision/provision add domainobj.pl
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Create Configuration Partition

This task partitions the configuration container (cn=configuration) created as part of the Domain
Objects Addition task. This configuration partition contains information on the physical structure and
configuration of the forest (such as the site topology).

After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision partition configuration.pl

Create Schema Partition

This task partitions the schema container (cn=schema) created during the Domain Objects Addition
task.

After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision partition schema.pl

Add Configuration Objects

This task adds the configuration and schema partition objects. It helps maintain integrity with the
Active Directory information model.

After you have exported the passwords, execute the following script:

lopt /novell/xad/share/dcinit/provision/provision add configobj.pl

Add Domain Controller

This task adds the domain controller to the domain.

This task creates additional objects that make your server act as a domain controller. The task is only
executed if you have installed DSfW as an additional domain controller in the domain.

After you have exported the passwords, execute the following script:

/opt/novell /xad/share/dcinit/provision/provision domain join.pl

Assign Rights

This task configures directory-specific access rights for the domain and the domain administrator
being provisioned.

After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision config acl.pl

Samify Objects

This task is specific to a name-mapped installation. The existing user and group objects are extended
to receive Active Directory attributes that allow them to be part of the domain being provisioned.
Some of the extended attributes are supplementary Credentials, objectSid, and samAccountName.

After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision samify.pl

134 OES 11 SP3: Domain Services for Windows Administration Guide



Configure Site

This task partitions the domain controller object (MSDS:Server), which is represented as a container
object in eDirectory. This domain controller object is located under
cn=Servers,cn=<sitenames>,cn=Sites, cn=Configuration,dc=<domain name>

This task performs the following actions:

+ Pre?checks the DSfW environment before partitioning of the object.
+ Partitions the domain controller object.
+ Post?checks the DSfW environment after partitioning of the object.

Restart DSfW Services
This task restarts services in order of dependence.
After you have exported the passwords, execute the following script:

lopt /novell/xad/share/dcinit/provision/provision restart dsfw.pl

Set Credential for Accounts
This task sets the password and kerberizes the administrator, krbgt, and guest accounts.
After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision_set cred foraccounts.pl

Enable Kerberos

In DSfW, Kerberos is the primary security protocol for authentication within a domain. The Kerberos
authentication mechanism issues tickets for accessing network services.

As part of this task, the krbs . conf file is updated and a ticket is sent to the administrator principal.
After you have exported the passwords, execute the following script:

lopt /novell/xad/share/dcinit/provision/provision enable local krb.pl

Establish Trust

A trust is a relationship established between domains that enables users in one domain to be
authenticated by a domain controller in the other domain. Authentication between domains occurs
through trusts.

After you have exported the passwords, execute the following script:

/opt/novell/xad/share/dcinit/provision/provision trusts crossref.pl

Cleanup

This task removes files from a partial or failed installation. It also removes the temp directories and
checkpoint files created during provisioning.

After you have exported the passwords, execute the following script:
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/opt/novell/xad/share/dcinit/provision/provision cleanup.pl
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8.1

Activities After DSfW Installation or
Provisioning

This section discusses details about activities that can be performed after DSfW installation or
provisioning.

+ Section 8.1, “Verifying the Installation,” on page 137

+ Section 8.2, “Renaming Administrator Details Using MMC,” on page 138

+ Section 8.3, “Extending the Domain Post Provisioning,” on page 139

Verifying the Installation

Perform these tasks to verify that eDirectory and DSfW have been installed and configured correctly.
These tasks might require certain environment variable settings to be updated. You must either
restart the OES server or logout of the OES server and login again to update the necessary
environment variables.

NOTE: After you have installed a child domain or an additional domain controller, the DNS server
running at forest root domain (or the DNS server you are pointing to in /etc/resolv.conf file) must
be restarted. Execute the following command on the server hosting the Novell DNS service:

rcnovell-named restart

(J Check the /etc/hosts file to ensure that it contains only one entry with this server’s primary |P
address. For example:

192.168.1.1 oesdc.dsfw.com oesdc

(O Check the /etc/resolv.conf file to ensure that it contains a name server and domain search
entry for server on which DNS is hosted. For example:

nameserver 192.168.1.1
search dsfw.com

O If you reconfigure the LAN settings using YaST, ensure that the loopback IP address. .(except
172.0.0.1) is not active in /etc/hosts.

O Verify that eDirectory has been properly configured by using the following command:

/opt/novell/eDirectory/bin/ndsstat -h localhost
This command returns information similar to the following:

Tree Name: DSFW_TREE

Server Name:.CN=OESDC.OU=0ESSystemObjects.dc=dsfw.dc=com.T=DSFW_TREE
Binary Version: 20217.06

Root Most Entry Depth: 0

Product Version: eDirectory for Linux v8.8 SP5 [DS]

Activities After DSfW Installation or Provisioning 137



(0 Execute xadentrl validate at the terminal prompt.

If the services are configured correctly, the result of the command will be similar to the following
output:

Tree Name: DSFW-TREE

Server Name: .CN=testfrd.OU=0ESSystemObjects.dc=dsfw.dc=com.T=DSFW-TREE.
Binary Version: 20501.00

Root Most Entry Depth: 0

Product Version: eDirectory for Linux v8.8 SP5 [DS]

Checking for nameserver BIND
number of zones: 2

debug level: 0

xfers running: 0

xfers deferred: 0

soa queries in progress: 0
query logging is OFF
recursive clients: 0/1000
tcp clients: 0/100

server is up and running
zone details are dumped at /var/opt/novell/log/named/named zones.info

Checking for Name Service Cache Daemon: running
Checking for RPC Endpoint Mapper Service running
Checking for Kerberos KDC Service running
Checking for Kerberos Password Change Server running
Checking for Domain Services Daemon running
Checking for Samba NMB daemon running
Checking for Samba WINBIND daemon running
Checking for Samba SMB daemon running
Checking for service sshd running
Checking for rsync daemon: running

O Execute the following commands:
kinit administrator@domainname
rpcclient -k localhost -c¢ dsroledominfo
If your server is configured correctly, you should see information similar to the following:
Machine Role = [5]
Directory Service is running.

Domain is in native mode.

8.2 Renaming Administrator Details Using MMC

If you rename the administrator account using MMC, only AD-specific attributes like
sAMAccountName are modified. You may be required to update the uniquelD attribute if you want to
use the renamed administrator account for iManager administration. For more information, see
Section 22.1.30, “iManager Fails to Create Samba Shares if the Administrator Name is Changed
using MMC,” on page 242.
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8.3

NOTE: You must not use special characters such as $ * ! ' while renaming a domain administrator,
because if the domain administrator name contains any of these special characters, any ADC or child
domain installations to the domain will not succeed.

On a Windows workstation, click Start > Run, and enter mmc.

When the Console opens, select File > Add/Remove Snap-ins.

Select Active Directory Users and Computers and click Users.

In the details pane, right-click the user account that you want to rename, and then click Rename.

a A W N P

Type the new full name of the user account, then press ENTER to display the Rename User
dialog box.

6 Fill in the following fields:
First name: Specify the first name of the user.
Last name: Specify the last name of the user.
Display name: Specify the user name to be displayed in Active Directory.

User logon name: Specify the user logon hame and select the user principal name (UPN) suffix
in the drop-down list. This field represents the userPrincipleName attribute.

User logon name (pre-Windows 2000): Specify a name for the user that is unique to the Active
Directory forest. This field represents the sAMAccountName attribute.

7 Click OK.

Extending the Domain Post Provisioning

DSfW enables you to map multiple partitions to the domain post provisioning by using the domain
partition management tool. The domain partition management tool manages partitions in the domain
name space by adding or removing partitions. The tool can be used to manage local as well as
remote domains, and it must be executed only from a DSfW server. The tool uses the following
syntax:

domaincntrl <Operations> [arguments]

NOTE: To perform add and remove operations, you must ensure that all the domain controllers of a
domain are up and reachable.

Operation Description

--list Lists the current domain partition list.
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Operation

Description

--add

--remove

--samify

--desamify

--preps

--help

Adds a partition to the domain name space. You can use this operation to
specify the partition to be added to the domain name space from the list of
partitions that are displayed. When you specify a partition, the tool runs
validation checks on the partition before adding it to the domain name
space. When the partition is added to the domain name space, the partition
is samified.

The add operation cannot be performed for the following:

+ Domain root partition
+ Configuration partition

* Schema partition

NOTE: To add a patrtition to the domain, all the domain controllers must
have either read/write or master replica of the partition that is being added.

Removes the specified partition from the domain name space. When you
specify a partition, the tool runs validation checks on the partition before

removing it from the domain name space. When the partition is removed
from the domain name space, the partition is desamified.

The remove operation cannot be performed for the following:

+ Domain root partition
+ Configuration partition

¢ Schema partition

Samifies the specified partition. Samification can be done only for domain
partitions. The add operation calls this operation internally. However, if
samification is not successful when you use the add operation, you can
perform samification explicitly by using this operation. If the specified
partition contains several users or groups, the samification process can be
time-consuming.

Desamifies the specified partition. This operation can be run only on local
domains and not on remote domains. The remove operation calls this
operation internally. However, if desamification is not successful when you
use the remove operation, you can perform desamification explicitly by
using this operation.

Prepares the server with the following sequence of activities:

Schema version check: Checks the Schema version to determine if the
version on the server is OES 2 SP3 or later. If the schema version is lesser
than OES 2 SP3, an error message is displayed suggesting the user to
extend the schema on the server and abort the operation.

uniqueDomainID attribute check: Searches for uniqueDomainID attribute
on the domain root. If attribute is not found, the attribute is updated on the
domain root.

Samification: Samifies all the objects in the eDirectory partition that is
mapped to the DSfW domain.

NOTE: This option must be used only if the server is migrated from OES 2
SP2.

Displays usage of the command.
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Arguments Description

-a Specifies the remote domain name. This argument
cannot be used with the desamify operation.

-d Enables debugging.

-F Lists the partition mapping forest-wide. This argument
is used only with the list operation.

-0 Sends debug logs to the specified file.

8.3.1 Examples
domaincntrl --list
Lists the current local domain partition list.

domaincntrl --list -F
Lists the partition list of each domain in the forest.

domaincntrl --list -a example.com
Lists the partition list of the example.com remote domain.

domaincntrl --add -d
Adds a partition to the local domain name space with debugging enabled.

domaincntrl --add -a example.com
Adds a partition to the remote domain name space.

domaincntrl --remove -d -0 /tmp/out.txt

Removes a partition from the local domain name space with debugging enabled and saves the
logs to the out . txt file.

domaincntrl --samify

Samifies the specified domain partition.

domaincntrl --samify -a example.com

Samifies the example.com remote domain partition.

domaincntrl --desamify

Desamifies the specified partition.
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9.1

9.11

Upgrading DSfW

This section provides information and links for upgrading DSfW to OES 11 SP3.

+ Section 9.1, “Upgrading DSfW to OES 11 SP3,” on page 143
¢ Section 9.2, “Upgrading from OES 1.0 Linux,” on page 145

+ Section 9.3, “Migrating Data to a Domain Services for Windows Server,” on page 146

Upgrading DSfW to OES 11 SP3

This section helps you understand the types of upgrade, prerequisites for upgrading, and the upgrade
process.

¢ Section 9.1.1, “Upgrade Scenario,” on page 143

+ Section 9.1.2, “Supported Mixed Mode configurations,” on page 144

+ Section 9.1.3, “Prerequisite,” on page 144

+ Section 9.1.4, “Media Upgrade,” on page 144

¢ Section 9.1.5, “Channel Upgrade,” on page 144

+ Section 9.1.6, “AutoYaST Upgrade,” on page 144

+ Section 9.1.7, “Configuring WINS and Sites in an Upgrade Scenario,” on page 144

+ Section 9.1.8, “Troubleshooting,” on page 145

Upgrade Scenario

If a DSfW domain has multiple domain controllers, it is recommended to upgrade the primary domain
controller first, followed by the upgrade of the remaining domain controllers.

To determine the IP address of the server that is the primary domain controller, use the following
command:

dig -t SRV _1ldap. tcp.pdc. msdcs. DOMAIN NAME +short

Here, DOMAIN_NAME_ is the domain name of the current domain, for example dsfw.com. In a
DSfW setup that has multiple domains like FRD or child domain, the upgrade can be commenced
from any domain.

NOTE: If all the domain controllers are not upgraded to the same patch level, the OES features will
not be available.
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9.1.2

9.13

9.14

9.15

9.1.6

9.1.7

Supported Mixed Mode configurations

Mixed mode DSfW domains in a DSfW forest is supported. However, it is recommended to have all
the domain controllers of a domain run the same version of OES. You can have DSfW domains run
different versions of OES (for example, OES 2 SP2 and OES11) in the same DSfW forest. However,

SP2-specific features will only work in domains that run OES 2 SP2 and above. Similarly, OES 11-
specific features will only work in domains that run OES 11.

Prerequisite

Before running the upgrade process, ensure that time is synchronized between all the servers in the
replica ring.

Media Upgrade

Media upgrade involves upgrading in an offline mode from a physical media such as CD or DVD. For

step-by-step instructions, refer to “Using Physical Media to Upgrade (Offline)” in the OES 11 SP3:
Installation Guide.

Channel Upgrade

For information about channel upgrade from OES 11 to OES 11 SP3, see “Channel Upgrade from
OES 11 SP2 to OES 11 SP3” in the OES 11 SP3: Installation Guide.

AutoYaST Upgrade

AutoYaST upgrade enables you to upgrade to an OES server without user intervention.For more
information, see “Using AutoYaST for an OES 11 SP3 Upgrade” in the OES 11 SP3: Installation
Guide.

Configuring WINS and Sites in an Upgrade Scenario

After you upgrade your server to OES 11 SP3, the server reboots and you are prompted to configure
additional features like WINS and Sites. This can be done using the DSfW Configuration Wizard.

IMPORTANT: You are prompted to configure these features only once. If you fail to configure these
features during the first instance, you will not be able to configure these features later.

1 Enter the authentication details in the login dialog box, depending on the scenario in which you
are provisioning, then click OK.

Provisioning Scenario Authentication Details Required

Non-name-mapped, forest root domain The current domain credentials.

Name-mapped, forest root domain The current domain credentials and the tree admin
credentials.

Non-name-mapped child The current domain credentials, the parent domain
credentials, and the tree/container admin
credentials.
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9.1.8

9.2

Provisioning Scenario Authentication Details Required

Name-mapped child The current domain credentials, the parent domain
credentials, and the tree/container admin
credentials.

Additional Domain Controller The current domain credentials and the tree admin
credentials.

IMPORTANT: If you are installing a first-level child domain in a non-name-mapped scenario, the
tree admin and the parent domain credentials are the same.

2 Select the feature that you want to configure, then click Next.

3 On the task list page, click Run to manually execute a task or click Run All to execute all the
tasks sequentially without any manual intervention.

Troubleshooting

+ “Samba cache File Corruption” on page 145

+ “Upgrade Fails” on page 145

Samba cache File Corruption

After upgrading, you may encounter a Samba cache file corruption issue. Follow the instruction
documented in “Error Mapping SID to UID” on page 247 to resolve the error.

Upgrade Fails

If upgrade to OES 11 SP3 fails during the post-configuration phase, then the upgrade tool will not
retry and upgrade of other OES components will continue. You must rerun the upgrade scripts based
on the upgrade scenario.

Upgrade to OES 11 SP3: Use the script /opt /novell/xad/sbin/upgrade dsfw.pl

You must also ensure that the kerberos ticket is up-to-date. To obtain the domain administrator's
ticket use kinit.

kinit <Administrator Name>

Upgrading from OES 1.0 Linux

In-place upgrade of an existing OES 1.0 Linux server to a DSfW server is not supported.

You must first install and configure a new OES server with DSfW, then migrate data from the existing
OES 1.0 NetWare or Linux server.
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9.3 Migrating Data to a Domain Services for Windows
Server

The migration of data to an OES 11 SP3 server running DSfW is similar to any other data migration to
OES 11 SP3:

+ You should use the OES migration tools.

+ When the source and destination servers are in the same eDirectory tree, only the data and
trustee rights are migrated.

+ When the source and destination servers are in different eDirectory trees, the data and
associated users are migrated.

For information on how to use the OES migration tools for migrating data, see the OES 11 SP3:
Migration Tool Administration Guide.
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Running Domain Services for Windows
In a Virtualized Environment

Domain Services for Windows runs in a virtualized environment just as it does on a physical Open
Enterprise Server (OES) server and requires no special configuration or other changes.

To get started with KVM virtualization, see the Virtualization with KVM documentation. (http://
www.suse.com/documentation/sles11/book kvm/?page=/documentation/sles11l/book_kvm/data/
book _kvm.html).

To get started with XEN virtualization, see “Introduction to Xen Virtualization (http://www.suse.com/
documentation/sles11/book_xen/data/cha_xen_basics.html)” in the Virtualization with Xen (http://
www.suse.com/documentation/sles11/book_xen/data/book_xen.html) guide.

For information on setting up virtualized OES, see “Installing, Upgrading, or Updating OES on a VM”
in the OES 11 SP3: Installation Guide.

To get started with third-party virtualization platforms, such as Hyper-V from Microsoft and the
different VMware product offerings, refer to the documentation for the product that you are using.
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1 Logging In from a Windows Workstation

11.1

With Domain Services for Windows (DSfW) properly set up, Windows workstations can be joined to
the DSfW domain and users can log in to the domain.

Windows users can then use Windows Explorer (or other familiar Windows interfaces) to browse to
the DSfW domain and see the CIFS shares to which they have access.

¢ Section 11.1, “Joining a Windows Workstation to a DSfW Domain,” on page 149

¢ Section 11.2, “Logging In to a DSfW Domain,” on page 152

¢ Section 11.3, “Logging Out,” on page 153

¢ Section 11.4, “Limitations,” on page 153

¢ Section 11.5, “Support for SASL NTLMSSP Bind in LDAP,” on page 154

Joining a Windows Workstation to a DSfW Domain

Kerberos authentication requires that the domain controller’s time and the Windows workstation’s
time be synchronized. After the DSfW server is installed, verify that the Windows workstations in the
domain are set to get their time from this server.

You must ensure that the workstations joined to a DSfW domain have a unique machine name. A
duplicate machine name will lead to an unstable domain and slow workstation logins. If you attempt to
join a machine with a duplicate name to a DSfW domain, no warning or error messages will be
displayed.

In case you experience slow workstation logins because of duplicate machine names in your
environment, you can enforce intruder lockout. For more information, refer to the TID (http://
www.novell.com/support/viewContent.do?externalld=7006851).

NOTE: A duplicate machine name may get assigned due to reuse of the machine name or re
imaging the machines in a virtualized environment.

Execute the following steps to join a Windows workstation to a DSfW domain:

NOTE: The steps might vary depending on how you have Windows configured. The examples shown
are for the Windows “classic” desktop.

1 From a Windows computer on the same network as the DSfW server, go to Network
Connections in the Control Panel, select Local Area Connection, and click Properties.

2 Select Internet Protocol (TCP/IP) and click Properties.

3 Select Use the following DNS server addresses. For the Preferred DNS Server, enter the IP
address of the DNS server configured for DSfW, then click OK.
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" Obtain DMS server address autormatically
%) Use the following DMS server addresses:

Preferred DNS server: (192168 1 1 |

Alternate DMS server: | . . . |

[ OF. H Cancel ]

4 From the Start menu, right-click My Computer and select Properties.
5 On the Computer Name tab, click Change.

6 Inthe Computer Name Changes dialog box, select Domain, enter the DSfW domain name, then
click OK.
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7 When prompted, provide the name and password for an account with permission to join the
domain. This is the Administrator and password configured when you installed DSfW.

8 A welcome message is displayed after the computer has successfully joined the domain. Click
OK to continue.

Computer Name Changes E'

L
- | J Welcome ko the example. com dormain,

9 As prompted, click OK to restart the computer for the changes to take effect.

The computer you just joined to the domain has an object created for it in the Computers container in
the DSfW domain.

A user with administrative privileges for the container that is being name-mapped can join a
workstation to the domain being created.
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11.2

NOTE: When you install Windows XP, it prompts you to select whether it is part of the workgroup or
the domain. If domain is selected, it reports that an invalid domain is specified. However, if there is an
existing Windows XP machine installed, it is possible to join this workstation to the domain.

Assume that you join a workstation to the example.com domain. After you join a workstation to the
domain, a computer object is created in the default container cn=computers, dc=example, dc=com.
This default container is by default associated with the default password policy cn=Default
Password Policy,cn=Password Policies,cn=System,dc=example,dc=com.

The wellKnownObjects attribute on the domain container (dc=example,dc=com for the domain
example.com) contains a list of well-known object containers by GUID and distinguished name. The
well-known objects are system containers. If you want to place all the computer objects under a non-
default custom container, you must modify the computers container entry of the wellknownObjects
attribute to include the desired container.

1 Launch iManager and connect to a DSfW server.

2 In Roles and Tasks, select Directory Administration > Modify Object.

3 Specify the domain container object in the Object name field or browse and select the domain
container object and click OK.

4 Click General > Other tab.

5 Select wellKknownObijects from the Valued Attributes list and click Edit.

6 Select the entry that contains the GUID AA312825768811D1ADEDOOCO04FD and specify the
desired container in the Volume field.

After you modify the wellknownObjects attribute entry, ensure that you associate the cn=Default
Password Policy,cn=Password Policies,cn=System,dc=example,dc=comto the new Computer
container. This password policy association is required for all such containers that will hold computer
objects.

Logging In to a DSfW Domain

After the Windows workstation has joined the DSfW domain and the computer has been restarted (as
explained in Section 11.1, “Joining a Windows Workstation to a DSfW Domain,” on page 149), DSfW
user accounts can be used to log on to the Windows workstation.

1 Start the Windows workstation or press Ctrl+Alt+Del to bring up the Windows log on dialog box.

2 Inthe Log On to Windows dialog box, enter the user name and password of a user that has been
provisioned for DSfW. Initially, the only provisioned user is the Administrator account created
when you installed DSfW.
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11.3

114

11.4.1

11.4.2

3 Inthe Log on to field, click the down-arrow to select the DSfW domain (identified by its NetBIOS
name), then click OK.

Log On to Windows

!
f

Copynight &1 1985-2001
Microsoft Comporation

User name: | Administrator |
Passward: | TTTITY Y] |
Log an ko EXAMPLE 3 |

W D5- 5P Ethis cumiuteri

L Ok J [ Cancel J [Ehut Du:uwn...] [thi-:uns o

Logging Out

To log out of the DSfW domain, select Log Off from the Start menu.

Limitations

This section covers the limitations and known issues that you may encounter while joining a
workstation to a domain and logging in.

Error while Joining a Workstation to a Domain

This error can occur due to the extra attributes that gets added in the Domain Password Policy after it
has been opened using the iManager Passwords Plug-in and saved without making any changes.

To resolve this issue, see TID 7004481 (http://www.novell.com/support/php/
search.do?cmd=displayKC&docType=kc&externalld=7004481)

Error While Joining a Workstation to a Domain if Time is Not
Synchronized

While joining a workstation to a domain, you must ensure that the system time is synchronized
between the Windows workstation and the DSfW server. Otherwise, you will receive an error
indicating incorrect username or password. An error message similar to the following is logged in the
/var/opt/novell/xad/log/kdc.log file:

Dec 04 10:50:37 sleslOsp3 krb5kdc[5048] (info) : preauth (timestamp) verify failure:
Clock skew too great

Dec 04 10:50:40 sleslOsp3 krb5kdc[5048] (info): AS REQ (7 etypes {23 -133 -128 3 1
24 —135}) 192.168.100.129: PREAUTH FAILED: Administrator@NTS.NOVELL.COM for
krbtgt /NTS.NOVELL.COM@NTS.NOVELL.COM, Clock skew too great
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11.5

11.5.1

11.5.2

Support for SASL NTLMSSP Bind in LDAP

This feature enables support for LDAP-based applications to authenticate (bind) to a Domain
Controller over SASL layer via GSSAPI/GSS-SPNEGO employing NTLM. As part of this feature,
DSfW introduces support for NTLM in case Kerberos is down or where a legacy third party application
is limited with NTLM support alone. However, applications employing NTLM outside SASL layer will
remain unsupported. It is recommended that you avoid NTLM-based authentication, because it is
susceptible to attacks. For more information, see NTLM Authentication Protocol.

¢ Section 11.5.1, “Planning for Support of SASL NTLMSSP Bind in LDAP,” on page 154

¢ Section 11.5.2, “Troubleshooting,” on page 154

Planning for Support of SASL NTLMSSP Bind in LDAP

To use this feature on Windows 7 or Windows XP SP3 or later, you must change the local policy as
follows:

1 On a Windows system, click Administrative Tools > Local Security Policy > Security Settings >
Local Policies > Security Options > Network Security: LAN Manager Authentication Level

2 Modify the value of the LAN Manager Authentication Level to Send LM and NTLM -use NTLM2
session security if negotiated.

Troubleshooting

Use the information in this section to resolve SASL NTLMSSP-based bind issues.

SASL NTLMSSP-Based Bind Over LDAP is Not Working

If there are pre-existing non-OES 11 SP3 domain controllers in your environment, perform the
following steps on these domain controllers:

1 Start the ndstrace process by issuing the ndstrace -1>log& command. This runs the process
in the background.

2 Force the backlink to run by issuing the ndstrace -c set ndstrace=*B command from the
ndstrace command prompt.

3 Unload the ndstrace process by issuing the ndstrace -ucommand. Running the backlink
process is especially important on servers that do not contain a replica.

4 Restart the ndsd sever by using the ndsd restart command.

5 Verify that the size or hash of the /var/opt/novell/eDirectory/data/nmas-methods/
SPNEGOLSMLIN X64.S0 library matches to that of an OES 11 SP3 server.
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2 Using Mac Client

12.1

12.2

12.2.1

Beginning with OES 11 SP2, DSfW supports the OS X 10.8 and OS X 10.9 clients. This support
enables you to join a Mac client to a DSfW domain. After the client is joined to a domain, you can log
in to the domain using DSfW user credentials and access NSS shares. You can also apply MCX
settings and manage DSfW users using Workgroup manager, the native Mac user management tool.

¢ Section 12.1, “Planning for Mac Support,” on page 155
¢ Section 12.2, “Using Mac Support,” on page 155

Planning for Mac Support

Consider the following when using Mac as a client:

+ Joining a Mac client to a domain using the NetBIOS name of the DSfW domain is not supported.

Using Mac Support

This section describes how to join a Mac client to a DSfW domain and access NSS shares.

¢ Section 12.2.1, “Joining a Domain,” on page 155

+ Section 12.2.2, “Logging in to a DSfW Domain from a Mac Workstation,” on page 156
+ Section 12.2.3, “Accessing NSS Shares,” on page 156

¢ Section 12.2.4, “Troubleshooting,” on page 156

Joining a Domain
Follow the steps below to join a Mac client to a domain.

From the Apple menu, click System Preferences.
Click Network.
Click Advanced > DNS.

Add the DNS Server holding the zone information of the DSfW domain and the domain name of
the DSfW domain.

Under System Preferences, click Users & Groups > Login Options > Join.

A W N PP

Click Open Directory Utility.
Select the Active Directory option, then click Apply.
Specify the Active Directory domain, then click Bind.

© 0 N o O

Specify the local administrator credentials, then click OK.
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12.2.2 Logging in to a DSfW Domain from a Mac Workstation

After you join the Mac workstation to the DSfW domain, you can use DSfW user accounts to log in to
the Mac workstation.

1 Click Admin > Other.
2 Specify the domain credentials with which you want to join the domain.

Logging to a DSfW Domain from a Mac 10.10 Workstation

After joining a Mac 10.10 workstation to a DSfW domain, logging in to the domain using the domain
administrator credentials displays a pop-up to reset the password. Logging fails even if you reset the
password. To avoid this, follow the steps given below:
1 IniManager, select Roles and Tasks > Rights > Modify Trustees.
2 Select the domain root partition.
3 Click Assigned Rights for Public Trustee.
4 Add the pwdChangedTime attribute to the Public Trustee.
4a Click Add Property.
4b Select the pwdChangedTime attribute from the Property Name list and click OK.

(¢]

Select the Inherit check box for the pwdChangedTime attribute.
Restart the DSfW services.

(o3}

12.2.3 Accessing NSS Shares

After you join a Mac workstation to a DSfW domain, you can access NSS shares.

1 Click Go > Connect to server.

2 Specify the server IP address and the share name that you want to connect to.

12.24 Troubleshooting

Use the information in this section to resolve Mac client issues.

Intermittent Failure While Joining Mac Client to a DSfW Domain

When you attempt to join a Mac client that was previously joined to a domain, the join might fail. This
is an intermittent issue. To resolve this issue, you must restart the Mac client.
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13.1

Creating Users

After Domain Services for Windows (DSfW) is properly installed and provisioned, you can create
users with either Novell iManager or a Microsoft Active Directory management tool such as Microsoft
Management Console (MMC).

Although the users are created in eDirectory, they appear in the DSfW domain when viewed from
MMC. User account information that is common to both eDirectory and Active Directory can be
managed with either tool.

Users created in the DSfW domain are automatically provisioned to use DSfW. In Active Directory,
logon users are normally created in the Users container within the domain. In DSfW, users can be
created anywhere within the domain (which corresponds to an eDirectory partition).

When a user is provisioned, the ADPH agent adds a number of Active Directory-specific operational
attributes to the User object. These include SAM (Security Account Manager)-related attributes and
RFC 2307 attributes.

NOTE: Novell recommends you to use either iManager or MMC for DSfW user and group
management. If you use iManager or MMC interchangeably for DSfW user or group management,
then some of the attributes of DSfW users or groups created using MMC will not match with those
created using iManager.

¢ Section 13.1, “Creating Users in iManager,” on page 157
¢ Section 13.2, “Creating Users in MMC,” on page 159
+ Section 13.3, “Moving Users Associated with Password Policies,” on page 160

+ Section 13.4, “Limitations,” on page 161

Creating Users in iManager

1 Start a browser and point to http:// ip_address_of server/nps/iManager.html.
For example, http://192.168.1.1/nps/iManager.html.

2 Accept the certificate, enter the Administrator account/password and eDirectory tree, and click
Login.

IMPORTANT: Contextless logins using iManager can lead to unexpected results if you try
logging in as an administrator. An administrator object exists for every domain and you might
accidently attempt to log in as an administrator of an domain where you lack sufficient access.
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Novell iManager

Login

Username:
|adm\nistralor.users.examp\e.com |

(Ex: admin or admin. novell)

Password:

|

Tree:
[ExAMPLE_TREE| |
(192,168, 14,199, mytree, myserver, COmpany . com)

g

@ Copyright 1999-2007 Movell, Inc. &l rights reserved.

3 Under Roles and Tasks, select Directory Administration > Create Object.
4 Select the User object class and click OK.

Novellg iManager

ADMINISTRATOR

@] Roles and Tasks o ]
- @ Create Object

| [All Categories] V|

. 2oy : o]
£l Directory Administration 7| Select the object class to create.

Copy Object

Credictinect Available object dasses:
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. Organization
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Rename Object Organizational Role 4
Groups Organizational Unit E

= Person

Help Desk Profile =
Kerberos Management ?Erf Etoéiule
s (e Mool T
Partitions and Replicas
Rights [[show all object dasses
Schema .| Mote: This option is only available to authorized users. =
e Ok | Cancel | ~|
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5 Specify the user account information, specify the context, and click OK.

@ Roles and Tasks e

& Create User

*=required

| [All Categaries] v|

Username: *

First name:

Directory Administration

Last name: ™ |

Copy Object Full name:
Create Object Context: *
Delete Object
Modify Object
e Passusard: | |

Mowve Object
Rename Object

Retype passuword: | |

Mote: Failure to enter a passward will allow the user to login without a passward.

Set simple password

Mote: Simple password is required for native file access for Windows and Macintozh
uzers, (Mot required when Universal password is enabled)

[ Capy from template or user object

----------------------------- |

Files and Folders v

Fi

Users created anywhere in the domain (partition) are automatically provisioned for DSfW. Additional
information you specify for each user, such as telephone numbers and e-mail addresses, can also be
viewed and modified in MMC. However, attributes that are specific to eDirectory can not be managed
in MMC.

NOTE: If an administrator changes the primary group of the user objects, the gidNumber and
primaryGrouplD attributes might not be synchronized. LUM refers to the gidNumber, and Samba
depends on the primaryGroupld. File system access issues might occur if they are not synchronized.

13.2 Creating Users in MMC

If you have a Windows Server 2003 network with Active Directory, you should have the Administrative
Tools already installed. If not, they can be downloaded from Microsoft's Web site (http://
www.microsoft.com/downloads/details.aspx?FamilyID=C16AE515-C8F4-47EF-A1E4-
ABDCBACFF8E3&displaylang=en).

1 At a Windows workstation, click Start > Run and enter mmc.

2 When the Console opens, select File > Add/Remove Snap-ins.

3 Select Active Directory Users and Computers and click Add.

4 Click OK.

A new window opens with a list of objects in the left column, including the Domain Services for
Windows domain name.

5 Open the Domain Services for Windows domain and click the Users container.
6 Select Action > New > User, or click on the user icon in the toolbar.
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7 Follow the prompts to complete the user object creation.

NOTE: Ensure that the user logon name and the full name that you specify are the same. This is
because for an eDirectory user, the full name is the configuration name (cn).

Users created in the domain are automatically provisioned for DSfW. Additional information you
specify for the user, such as telephone numbers and e-mail addresses, can also be viewed and
modified in iManager. However, attributes that are specific to Active Directory cannot be managed in
iManager.

13.3 Moving Users Associated with Password Policies

When a user is moved into a DSfW domain and the associated password policy of the moved user
does not fall under the domain boundary, the generation of the DSfW-specific authentication keys of
the moved user might fail unless the associated password policy is in the security container. This is
because the DSfW server (NCP server object) does not have permissions on the associated
password policy object of the moved user, if the password policy object is not present either in the
security container or the domain boundary.

You must ensure that all the DSfW servers (domain controllers) of a DSfW domain are granted read
rights on the associated password policy. On the other hand, if the associated password policy of the
moved user is located in the security container, the generation of DSfW-specific authentication keys
is seamless as every server in the eDirectory Tree has preassigned rights on the security container.
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13.4

13.4.1

13.4.2

13.4.3

13.4.4

13.4.5

It is recommended to have the password policies in the security container which allows moving users
into the DSfW domain to work seamlessly. Alternatively, if the associated password policy is not
under security container, you must grant Read and Compare permissions for [All Attributes Rights]
on the password policy object for all the NCP server objects of the domain controllers of a DSfW
domain.

Limitations

Section 13.4.1, “User Samification Fails On Moving Users into a DSfW Domain,” on page 161

*

*

Section 13.4.2, “Moving User Objects Across Containers,” on page 161

*

Section 13.4.3, “Primary Group Appears Twice in the memberOf Properties Page,” on page 161

*

Section 13.4.4, “Adding Newly Created Users to a Group gives Error Message,” on page 161

*

Section 13.4.5, “Dynamic Groups Is Not Supported in DSfW,” on page 161

User Samification Fails On Moving Users into a DSfW
Domain

When you move a user into a DSfW domain, the user samification fails. This means that AD attributes
will not be generated for this user and hence the user will not be a part of the domain. This issue
occurs when master replica of the domain patrtition is present on a non-DSfW server.

Moving User Objects Across Containers

When you move objects across containers through MMC, even though the move operation is
successful, you might get an error message saying that Windows cannot move that object because
there is no such object on the server. You can use MMC to connect to the domain controller that holds
the master replica and retry the operation.

Primary Group Appears Twice in the memberOf Properties
Page

DSfW explicitly adds users to the primary group. This causes MMC to display the group twice in the
memberOf property page.

Adding Newly Created Users to a Group gives Error
Message

You cannot add users by using MMC to Domain Local, Global and Universal Groups who do not have
the Last Name property. Though an error message is displayed, the users are added to the groups.
The error message can be avoided if the user is created with the Last Name property.

Dynamic Groups Is Not Supported in DSfW

DSfW server does not support Dynamic Groups. However if applications are connected to plain
eDirectory servers, dynamic groups will function as expected.
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4 Understanding DNS in Relation to DSfW

14.1

The Domain Name System (DNS) is a hierarchical naming system for computers, services, or any
resource connected to the network. DNS stores information in a distributed, coherent, reliable,
autonomous, and hierarchical database.

DSfW uses the Novell DNS service as its location service, enabling users or computers to find the
location of network resources. It maps hostnames to IP addresses and locates the services provided
by the domain, such as LDAP, Kerberos and Global Catalog.

Novell DNS Services in Open Enterprise Server (OES) integrates the Domain Name System (DNS)
service into eDirectory. Integrating this service into eDirectory provides centralized administration and
enterprise-wide management of DNS by using the Java Management Console. The Novell DNS
configuration information is replicated just like any other data in eDirectory.

NOTE: A Novell DNS server can only be managed by using the Java Management Console utility.
The DNS YaST plug-in or the DNS plug-in of Microsoft Management Console (MMC) do not support
managing a Novell DNS server.

DSfW and DNS

DSfW uses the Novell DNS service that is included with OES. The DNS server that gets installed
when you choose the DSfW pattern for installation is configured with DSfW-specific configuration.

While installing the first domain controller of a domain, you can configure a new DNS server or use an
existing parent domain DNS server to host the new domain information. By default, the first domain
controller in the forest root domain is automatically configured to be the DNS server. This is done for
both name-mapped and non-name-mapped installations, if the Configure this server as a Primary
DNS server option in YaST is selected while configuring the first domain controller of the forest root
domain.

When a domain controller is added to a forest, the DNS zone hosted on a DNS server is updated with
the DNS Locator object, the Address (A) record and the Service (SRV) record. To find domain
controllers in a domain or forest, a client queries DNS for the SRV and A resource records of the
domain controller. These records help in domain name resolution and service identification. For more
information about A and SRV resource records, see “Types of Resource Records” in the OES 11
SP3: Novell DNS/DHCP Services for Linux Administration Guide.

While provisioning the DSfW server, secure dynamic updates are enabled as part of the Update
Service Configuration task. Dynamic updates enable DNS client computers to register and
dynamically update their resource records with a DNS server whenever changes occur.

An existing DSfW DNS server can be migrated to Active Directory DNS in order to facilitate
management of DNS data from the MMC DNS plug-in. However, migration of DNS does not provide
Active Directory's inherent storage and replication benefits. For information about how to migrate
DSfW DNS to Active Directory DNS, see Setting Up a Windows DNS Server for DSfW.

It is also possible to migrate an existing DSfW DNS server to any other domain controller of the same
domain or to a domain that has a read/write replica of the partition where the zone records are
located. For details, see Section 14.4, “Migrating DNS to Another Domain Controller,” on page 166
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14.1.1

14.2

14.2.1

Limitations

+ |tis not possible to use an existing Novell DNS server configured on a local or remote server to
work with DSfW.

+ Third-party DNS servers are also not supported, with the exception of the Windows DNS, which
can later be used by transferring the DNS data from an existing DSfW DNS to the Windows
DNS. For more details, see Section 14.2.3, “Configuring a Domain Controller by Using an
Existing DNS Server,” on page 165.

+ DSfW cannot be configured with an existing Windows DNS. However, an existing DSfW DNS
server can be migrated to a Windows DNS server. For details, see Setting Up a Windows DNS
Server for DSfW

Understanding DNS Settings in the DSfW
Environment

This section explains the configuration changes that happen while DNS is configured for DSfW.

+ Section 14.2.1, “General DNS Settings,” on page 164
+ Section 14.2.2, “Configuring a Domain Controller as a Primary DNS Server,” on page 165

+ Section 14.2.3, “Configuring a Domain Controller by Using an Existing DNS Server,” on
page 165

General DNS Settings

The DSfW installation page requires details on the following objects:

+ Context of the DNS-DHCP Locator object
+ Context of the DNS-DHCP Group object
+ Context of the RootServerinfo object

DNS-DHCP Locator Object: The DNS-DHCP Locator object contains global defaults, DNS options,
and a list of DNS servers and zones in the tree. The Java Management Console uses the Locator
object to locate the object instead of searching the entire tree to display these objects.

DNSDHCP Group Object: The DNSDHCP-Group object is a standard eDirectory group object. The
DNS servers gain access to the DNS data within the tree through the DNSDHCP-Group object.

RootServerinfo Object: The RootServinfo object is a container object that contains resource
records for the DNS root servers. The resource record sets contain Name Server(NS)records and
Address (A) records of name servers that provide pointers for DNS queries to the root servers. In
addition to these objects, the following objects are required for DSfW:

+ DNS Server Object

+ DNS Zone Object

+ DNS Resource Record Set Object

+ DNS Resource Records

Only one copy of these objects exists in the DSfW tree. The DNS servers, DHCP servers, and the
Microsoft Management Console must have access to these objects.
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14.2.2

14.2.3

14.3

Configuring a Domain Controller as a Primary DNS Server

For a non-name-mapped setup, the contexts of the Locator object, RootServerinfo object, and the
DNS-DHCP group object is automatically populated as the NCP server object location in the YaST
page. By default, this context is ou=0OESSystemObjects, <DomainDN>.

For a name-mapped setup, the fields are blank and the user can enter any context in the tree.For an
additional domain controller configuration, the Locator and Group contexts are retrieved from the
existing DNS server. This is also useful for administrators who might not want to configure many DNS
services in a network.

The default refresh interval of the DNS server is 15 minutes. Any changes made to the DNS settings
take effect in the subsequent refresh cycle. For the changes to be applied immediately, the DNS
server (novell-named) must be restarted so that the DNS server reads the newer data from the
server.A DNS administrator object must be created for DNS server configuration. Provide the name
and the location of the DNS administrator object. This information is required only if you configure this
server as a primary DNS server. For a forest root domain installation, the DNS is configured by
default in first domain controller, so this information is required for DNS configuration.

While configuring first domain controller in any subsequent domain (except a forest root domain), the
/etc/resolv.conf file must point to the existing DNS server. This is required to perform lookups
during configuration. Later if you choose this server to be configured as a primary DNS server, the
DNS configured on this server and the /etc/resolv.conf file gets automatically updated during
provisioning and points to the local DNS server.

For information on installing and configuring Novell DNS services, see “Installing and Configuring
DNS " in the OES 11 SP3: Novell DNS/DHCP Services for Linux Administration Guide OES 11 SP3:
Novell DNS/DHCP Services for Linux Administration Guide

Configuring a Domain Controller by Using an Existing DNS
Server

When the first domain controller in a domain is using an existing DNS server, YaST provides an
option to retrieve these values from the existing DNS server. During installation through YaST, you
can retrieve these values by selecting Retrieve DNS entries, and then selecting Retrieve.

NOTE: If you are configuring an additional domain controller for a domain that is already configured
to host a DNS server, make sure your first entry in the /etc/resolv.conf file is pointing to the DNS
server that the first domain controller is using.

Setting Up a Windows DNS Server for DSfW

Although it is possible to migrate DSfW DNS to a Windows DNS server, the migrated DNS records
cannot be integrated with Active Directory. Use the following procedure to migrate DSfW DNS server
to a Windows DNS server.

1 Using MMC, add secondary zones for all the existing forward and reverse lookup zones hosted
in the DSfW DNS server.
Windows DNS does a zone transfer of the newly created zones from the DSfW server.

2 Using Java Management Console, configure the servers that were designated as primary
servers to be secondary servers.
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3 In the first domain controller, edit the /etc/resolv.conf file and change the IP address to the
server where the Windows DNS Server is running

4 Restart Novell DNS server for the changes to take effect by using the rc-novell-named
restart command.

14.4 Migrating DNS to Another Domain Controller
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In a typical DSfW deployment, any domain controller can be configured as a DNS server. If the
domain controller serving as primary DNS server does not function due to a hardware or software
fault, the other domain controllers need at least one DNS server to keep the domain services intact.

IMPORTANT: The DNS migration can happen even when the source DNS server is down. If the DNS
server is down, make sure that any of the additional domain controllers in the forest have the replica
of the Tree Root partition. This is necessary to perform Step 2.

When the first domain controller goes down, make sure that the configuration partition and schema
partition replica is there on at least one domain controller in the domain. This is required to keep the
functioning of DSfW intact.

To migrate the DNS server from the first domain controller, from the additional domain controller
execute the following steps:

1 Using the casacli client utility, set the CASA credentials on the additional domain controller
with the following commands.
KEYVALUE=<common proxy user DN> CASAcli -s -n dns-ldap -k CN
KEYVALUE=<common proxy user password> CASAcli -s -n dns-1ldap -k Password

To retrieve the common proxy user DN, use the following command:
/opt/novell/proxymgmt/bin/cp retrieve proxy cred username

To retrieve the common proxy user password, use the following command:
/opt/novell /proxymgmt /bin/cp retrieve proxy cred password

2 Using Java Management Console, execute the following steps:

2a Create a DNS server object. For more information, see “Creating a DNS Server Object” in
the “OES 11 SP3: Novell DNS/DHCP Services for Linux Administration Guide”.

While creating the DNS server object you must specify the NCP server name of the
additional domain controller, hostname and the domain name for the server object.

2b Select the DNS zones in Java Management Console.

Associate the zone with the DNS server. For details on associating zone with a DNS server,
see “Zone Management’in the OES 11 SP3: Novell DNS/DHCP Services for Linux
Administration Guide

3 Restart novell-named on the additional domain controller using the following command:
rcnovell-named restart
After migrating the DNS server to the destination domain controller, the DNS entry referencing the
first domain controller is still retained in the cache for some time. This does not affect the functionality

in any way as when a name resolution request is issued, it gets resolved by the DNS server on the
other domain controller, if the first domain controller has not responded.
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14.5

IMPORTANT: If you have changed any DNS records or the configuration file, the changes are
effected after the dynamic reconfiguration interval of DNS. The default value of this interval is 15
minutes. If the changes are not done, we recommend you to restart the DNS server using the
rcnovell-named restart command.

Restarting DNS

If you have changed any DNS records or have changed the DNS configuration file, you need to
restart the DNS server so that the changes take effect.

To restart the DNS server, use the following command:

rcnovell-named restart

For information on updating records, refer to “Understanding DNS and DHCP Services” in the OES
11 SP3: Novell DNS/DHCP Services for Linux Administration Guide
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Configuring DSfW Server as a WINS
Server

This section describes how to configure a DSfW server as a WINS server.

Windows Internet Name Service (WINS) is a service that resolves NetBIOS computer names. It
provides NetBIOS name to IP address mapping for the client workstations in different subnets.
Without WINS, the NetBIOS to IP address mapping is limited to a single subnet. For example, if you
ping a NetBIOS name, the corresponding IP address is returned. Without WINS, this mapping is done
only for workstations within a subnet. However, with WINS, this mapping can be done for clients to
WINS servers across subnets.

¢ Section 15.1, “Using WINS in DSfW Environment,” on page 169

+ Section 15.2, “Rectifying Duplicate Workstation Names,” on page 171

+ Section 15.3, “Verifying Duplicate Workstation Names Prior to WINS Configuration,” on
page 173

¢ Section 15.4, “Troubleshooting,” on page 173

15.1 Using WINS in DSfW Environment

Beginning with OES 11 SP2, you can configure a DSfW server as a WINS server. Configuring a
DSfW server as a WINS server helps to prevent having two workstations with the same name in a
domain. If a workstation client is configured to use a WINS server, before joining a domain, the
administrator is alerted if a workstation with the same name already exists in the domain.

Duplicate workstation names in a domain can lead to several problems. If your domain has duplicate
workstations, users might experience slow logins to the domain. Logins might take several minutes
instead of seconds. You will also require substantial recovery effort to bring back configuration to a
unique workstation name across a domain.

Configuring a DSfW server as a WINS server also changes the NetBIOS join functionality. Without
WINS server, a NetBIOS join will not work if there is no domain controller in the subnet. However, with
WINS support, the join will work if the workstation's WINS configuration points to a domain controller
that is configured as a WINS server.

¢ Section 15.1.1, “Planning for WINS Support,” on page 169

+ Section 15.1.2, “Configuring WINS Server and Client,” on page 170

¢ Section 15.1.3, “Migrating WINS Server,” on page 170

+ Section 15.1.4, “Caveats,” on page 171

15.1.1 Planning for WINS Support

Use the following guidelines to configure a WINS server:

+ You can configure only one DSfW domain controller as a WINS server in a domain. All the
workstations in the domain must be configured to use this domain controller as the WINS server.
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15.1.2

15.1.3

+ Microsoft or any other OES server should not be configured as a WINS or a WINS proxy server
for the workstations in the domain.

+ DSfW server cannot be configured as a WINS proxy server.

+ DSfW WINS server helps in detecting workstations with duplicate names. Any other WINS
functionality is not supported.

+ Ensure that the client workstation's firewall for UDP port 137 is disabled.

+ Ensure that the gateways between DSfW server and Windows clients have the UDP port 137
disabled for messages originating from server to workstation.

+ If you have a significant number of workstations that are part of the domain, then DHCP service
can be used for configuring these workstations as WINS clients.

Configuring WINS Server and Client

+ “Configuring WINS Server” on page 170
+ “Configuring WINS Client” on page 170

Configuring WINS Server

You can configure WINS server by selecting the Configure this machine to be a WINS server check
box while installing and configuring DSfW using YaST. For information, see “Configure this machine
to be a WINS server:” on page 57.

Configuring WINS Client

1 On a Windows system, click Start and point to Control Panel.
2 Click Network and Dial-up Connections > Local Area Connections > Properties.

3 Select the Internet Protocol (TCP/IP) Properties entry in the list and then click Properties>
Advanced > WINS Address tab.

4 Select the Disable NetBIOS over TCP/IP option.
5 Click Add.
6 Specify the IP address or the domain name of the WINS server.

Migrating WINS Server

This section describes how to migrate a DSfW WINS server from one domain controller to another.

Before you migrate WINS, ensure that you stop the nmb service on the server where WINS is
configured and take a backup of the wins.dat and wins. tdb files (/var/1ib/samba). Follow the
steps given below to migrate WINS:

1 Verify if WINS is configured on the server by running the following command:
/opt/novell/xad/share/dcinit/configure dsfw wins.pl --isconfigured-upgrade

2 Unconfigure WINS on the source server.
/opt/novell/xad/share/dcinit/unconfigure dsfw wins.pl

3 Verify if WINS is configured on the server by running the following command:

/opt/novell/xad/share/dcinit/configure dsfw wins.pl --isconfigured-upgrade
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4 Configure WINS on the target server.
/opt/novell/xad/share/dcinit/configure dsfw wins.pl
5 Stop the nmb process in the target server.
rcnmb stop

6 Copy the wins.dat and wins.tdb files (/var/1ib/samba) from the source server to the target
server.

7 Start the nmb process.
rcnmb start

8 Reconfigure WINS clients to point to the target server. For more information on configuring
WINS clients, see “Configuring WINS Client” on page 170.

15.1.4 Caveats

+ If you have workstations joined to the domain prior to the WINS configuration, you must ensure
that you configure those workstations as WINS clients after the WINS server configuration and
reboot those clients. This will add workstation names to the WINS database and ensure that their
duplicate names are detected.

+ You can configure only one DSfW domain controller as a WINS server in a domain. Therefore, if
the WINS service goes down, any workstation join with a duplicate name will not be reported.
Also, if a workstation is down, a duplicate workstation join will not be reported. To identify
workstations with duplicate names during such scenarios, follow the steps below:

1 Run the following command:
/opt/novell /xad/share/dcinit/checkdupws.pl --current

2 Ensure that you have unique workstation names.

3 Run the following command:
/opt/novell/xad/share/dcinit/checkdupws.pl --clear-cache

This will clear the duplicate workstation name cache and display the list of duplicate workstation
names that are cleared.

You can also schedule this script to be run after a specified interval. To schedule the script, run
the following command:

/opt/novell /xad/share/dcinit/checkdupws.pl --schedule=<interval in hours>

This schedules the script to be run periodically in the specified interval. The script is run with the
--clear-cache option in the scheduled interval. The /var/opt/novell/xad/log/
wins duplicate check.log will list the duplicate workstation names.

15.2 Rectifying Duplicate Workstation Names

If you have workstations with duplicate names in a domain, you might not be able to log in to one of
these workstations. To rectify this, do the following:
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Figure 15-1 Rectifying Duplicate Workstation Names

1 Log in to the workstation that you are unable to log in to, using the local workstation administrator
credentials.

2 Rejoin the second workstation to the domain using a unique name. You must first unjoin the
workstation from the domain and then join the workstation with a unique name.

3 Rejoin the first workstation, using the same name. You must first unjoin the workstation from the
domain and then join the workstation with a unique name.
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15.3

15.4

15.4.1

Verifying Duplicate Workstation Names Prior to
WINS Configuration

If workstations with duplicate names exist in a domain prior to WINS configuration, you can use the
workstation check script /opt /novell/xad/share/dcinit/checkdupws.pl to identify workstations
with duplicate names and take appropriate action.

1 Run the following command:
checkdupws.pl --history

2 Ensure that you have unique workstation names.
3 Run the following command:

checkdupws.pl --clear-cache

This will clear the duplicate workstation name cache.

Troubleshooting

This section describes known issues and frequently asked questions for configuring DSfW server as
a WINS server.

WINS Server Does not Report Duplicate Workstation Name

If a workstation is down when another workstation with the same name joins the domain, the WINS
server will not report the duplicate workstation name. This could lead to issues such as slow logins
when the first workstation is up and running. To rectify this, schedule the duplicate workstation script
to run periodically every few hours.

checkdupws.pl --schedule=<interval in hourss>

This script will log duplicate workstation names in /var/opt/novell/xad/log/checkdupws.log. For
more information on rectifying duplicate workstation names, see Section 15.2, “Rectifying Duplicate
Workstation Names,” on page 171.
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Configuring Sites and Subnets

A site is made up of one or more Internet Protocol (IP) subnets that are linked by high-speed and
reliable connections. Sites represent the physical structure or topology of your network, and a domain
represents the logical structure where all the domain controllers are logically linked. Subnets are
associated to a site. Associating a subnet to a site implies associating an IP address or set of IP
addresses to the site.

In a DSfW environment, when you configure the first domain controller, a site named “Default-First-
Site-Name” is created. All domain controller objects for all the domains are associated with this site.

Figure 16-1 Sites and Subnets
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Having multiple domain controllers in different geographical locations associated with the same
domain and within a single site is not an ideal scenario. For such environments, the sites and subnets
feature enables you to configure multiple sites and distribute domain controllers over different
geographical locations.

After you configure the sites and subnets feature, when a client tries to log in to a domain, the request
goes to the nearest available domain controller, thus ensuring faster domain login.

¢ Section 16.1, “Planning for Sites and Subnets Support,” on page 176
+ Section 16.2, “Managing Sites and Subnets,” on page 176
¢ Section 16.3, “Troubleshooting,” on page 176
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16.1

16.2

16.3

16.3.1

Planning for Sites and Subnets Support

Use the following guidelines to configure sites and subnets:

+ Ensure that all the domain controllers present in the replica ring are up and running.

+ All domain controllers must have replicas of all partitions with objects that belong to the domain.

Managing Sites and Subnets

Using MMC (Active Directory Sites and Services) snap-in tool, you must first create a new site and
subnet. You must then associate the subnet to a site and move the container object from “Default-
First-Site-Name” or any other site to the new site.

Create a site. For more information, see Creating a Site.

Create a subnet. For more information, see Creating a Subnet.

Associate a subnet with the site. For more information, see Associating a Subnet with a Site.

A W N P

Move the Active Directory server object of the domain controller from “Default-First-Site-Name”
or any other site to the new site.

NOTE: Although the Active Directory server object is moved from one site to the other, the
changes do not get reflected immediately.

The movement of Active Directory server object from one site to the other completes with the help of
a crontab job (sites_dnsupdate.py) which takes care of creating 6 DNS records for each site. Use
the sites_dnsupdate.py --logging option in the crontab job to capture the additional logs apart
from the error and warnings.

NOTE: Ensure that you use the MMC (Active Directory Sites and Services) snap-in tool on a DSfW
server only to move the Active Directory server object from one site to another. Novell recommends
you to not perform any other operation using this tool other than the move operation on the domain
controller.

Troubleshooting

This section describes known issues and frequently asked questions for configuring Sites and
Subnets.

Moving a DSfW Server to a Site Results in an Error Message

When you move the DSfW server from one site to another, you might receive the following error
message:

Windows cannot move object DSFW-SERVER because: There is no such object on the
server.

This is because of the latency during the movement operation. You may ignore this message as this
does not affect the movement of the DSfW server to the destination site.
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NOTE: After you move the DSfW server, the changes might not get reflected in MMC immediately. If
the changes do not get reflected immediately, you must manually refresh.
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7 Managing Group Policy Settings

17.1

In Active Directory, Group Policies ease the administrator's job of implementing security settings and
enforcing IT policies for all users within an organizational unit, domain, or across an entire site. Group
policy settings are made in a Group Policy Object (GPO). You can create GPOs for various
departments in an organization to more easily manage the computers and users in each department.
For example, you might create a GPO for the Engineering department and a different GPO for the
Sales department.

DSfW supports all Group Policy settings that apply to Windows servers and workstations. The
Password Policies for DSfW users are applied through NMAS/Universal Password settings. For
information on password policy management, refer to Section 17.2.1, “GPO Account Policies,” on
page 183.

NOTE: Group Policy settings that apply to Domain Controllers are not supported in the OES
environment since here it is a OES server and not a Windows Server.

When a DSfW domain is provisioned a single group policy called '‘Default Domain Policy' is created.
Along with many workstation specific policies, the Group Policy Object also contains the Kerberos,
Account Lockout and Password related policies under the '‘Account Policies’ section.

You must be a member of the Domain Admins group to edit an Active Directory Group Policy for a
domain.

¢ Section 17.1, “Configuring Group Policies,” on page 179
¢ Section 17.2, “Group Policy Objects,” on page 182
+ Section 17.3, “Sysvol,” on page 185

¢ Section 17.4, “Limitations with Group Policy Management,” on page 186

Configuring Group Policies

To create a new Group Policy, you can use the Active Directory Users and Computers tool.

NOTE: If you have installed the Group Policy Management Console from Microsoft, the Group Policy
tab options described below are no longer accessible. Refer to the Microsoft Windows Server 2003
documentation for instructions on how to use the Group Policy Management Console to manage
Group Policies.

To Configure a new Group Policy

1 Start Active Directory Users and Computers.

2 In the console tree, right-click the Domain Services for Windows domain, and then select
Properties.

3 Click the Group Policy tab, then click New to create a new Group Policy.
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4 Specify a name for the new Group Policy, then click OK.

The policy settings you define are linked to the domain, which means the policy settings you
define are applied to the domain according to the inheritance and preference options used by

Active Directory.

These additional Group Policies can be associated to a Organization Unit under the domain.

Editing an Existing Group Policy

To modify Group Policy settings within Group Policy objects (GPOs), you can use the Group Policy
Object Editor which is a Microsoft Management Console (MMC) snap-in used for configuring and
modifying Group Policy settings. It operates as an extension to Group Policy Management Console

(GPMC).

If GPMC is not available, you can use the Active Directory Users and Computers snap-in or the

Active Directory Sites and Services snap-in.

To edit and existing group policy, follow the instructions in How To Use the Group Policy Editor to
Manage Local Computer Policy (http://support.microsoft.com/kb/307882)

NOTE: If you are not able to edit the Group Policy, it is because the DFS cache is pointing to a server
that is not holding the PDC Emulator role. To set the DFS link to point to the server holding the PDC
Emulator role, execute the steps in Setting the DFS Referral of the Server Holding the PDC Emulator

Role as Active on the Workstation.
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Setting the DFS Referral of the Server Holding the PDC Emulator Role as Active
on the Workstation

To set the DFS link of the server holding the PDC Emulator role as active, execute the following
procedure:

1 Browse to the sysvor folder by typing \\domain.tld\sysvol\ or \\ ipadress\sysvol inthe
file explorer. Select the domain.t1d folder.

2 Right click the domain.t1d folder to view the properties. Click the DFS tab. It will list two
referrals.

3 Select the link of the server holding the PDC Emulator role and set it as active.

This procedure of settings the DFS referral can be used even if there are multiple domain controllers
in a domain. However, while setting the DFS referral, you must ensure that you do not specify the fully
gualified domain name of the domain controller in the file explorer to browse the sysvoL folder. For
instance, for a domain named dsfw.com that has multiple domain controllers nmfadc.dsfw.com and
nmfrd.dsfw.com, you must specify \\dsfw. com\sysvol in the file explorer for setting the DFS referral
as shown in the figure below.

% sysvolon Novell Open Enterprise Server (dsfw.com)

File Edit Wie Favoriltes
e Edi flew  Favorltes

@Back x \‘) L$ /'.‘__-j Search ['L_ Folders v
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| General| DFS | Customize |

| Shdsbw combapzvolhdzf com |

Referral list:
Path Active Status
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[_ Ok ][ Cancel ] Apply

You must not specify the fully qualified domain name of the domain controller in the file explorer as
shown in the following figure.
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17.2

¥ sysvol on Movell Open Enterprise Server (nmfadc.dsfw.com)
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For more information about Group Policy Object settings, refer to Microsoft's online Group Policy
documentation (https://technet.microsoft.com/en-us/library/cc726027(v=ws.10).aspx). For more
information about NMAS and Universal Password settings, refer to the Novell eDirectory
documentation (http://www.netiq.com/documentation/edir88/).

Group Policy Objects

¢ Section 17.2.1, “GPO Account Policies,” on page 183
¢ Section 17.2.2, “gposync,” on page 184
+ Section 17.2.3, “Enforcing Computer Configuration and User Configuration,” on page 184
¢ Section 17.2.4, “Troubleshooting,” on page 184
Group Policy settings are stored in Group Policy Objects (GPO). A GPO consists of the following:
Group Policy Container: Stored in the directory.
Group Policy Template: Stored in the sysvor, SMB volume.
The default configuration of sysvoL resides in the /etc/samba/smb. conf file.
[sysvol]
comment = Group Policies
path = /var/opt/novell/xad/sysvol/sysvol
writable = Yes

share modes = No
nt acl support = No
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17.2.1

Group Policy Template is stored in the sysvoL SMB volume.

GPO Account Policies

The group of security settings in the GPO is called Account Policies and contains the following
policies:

+ Password Policy

+ Account Lockout Policy

+ Kerberos Policy

In a Domain Services for Windows domain, the password policies are stored in the container
cn=Domain Password Policy,cn=Password Policies,cn=System, <domain roots.

The Password Policy and the Account Lockout Policy are enforced by eDirectory. The Account
Policies settings are not read directly by eDirectory or KDC.

The Kerberos Policy is enforced by the Kerberos Key Distribution Center (KDC). The eDirectory

server enforces only those policies that are stored in its Directory Information Base (DIB). The
Kerberos KDC expects the Kerberos Policy to be stored in eDirectory.

The following Account Policies settings are supported:

Password Policies

Table 17-1 GPO and eDirectory Parameter Mapping for Password Policies

GPO Parameter eDirectory Parameter
Enforce Password History pwdlnHistory

Maximum Password Age passwordExpirationinterval
Minimum Password Age nspmMinPasswordLifetime
Minimum Password Length passwordMinimumLength

Account Lockout Policy

Table 17-2 GPO and eDirectory Parameter Mapping for Account Lockout Policies

GPO Parameter eDirectory Parameter
Account Lockout Duration intruderLockoutResetInterval
Account Lockout Threshold loginintruderLimit

Reset Account Lockout Counter After intruderAttemptResetinterval
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Kerberos Policy

Table 17-3 GPO and eDirectory Parameter Mapping for Kerberos Policies

GPO Parameter eDirectory Parameter
Maximum Lifetime for User Ticket maxTicketAge
Maximum Lifetime for User Ticket Renewal maxRenewAge

17.2.2 gposync

The gposync tool synchronizes the policies stored in eDirectory with those in sYSvoL.

This tool is programmed to run every 30 minutes by using the cron service. If the policies stored in
eDirectory are newer than the Account Policies in SYSVOL, gposync updates the Account Policies.
Similarly, it updates the policies in eDirectory if they are older than Account Policies maintained in
sysvoL.When you modify the Account Policies in sysvoL by using Group Policy Management
Console (GPMC), gposync makes the relevant changes to the policies in eDirectory when it runs the
next time.

The gposync utility parses all the applied GPO policies and synchronizes appropriately to containers
it is associated with. A typical output gposync utility on success will be as follows:

The list of Group Policies present in the domain dc=multizone,dc=com are:
{31B2F340—016D—11D2—945F—OOCO4FB984F9}

Syncing {31B2F340-016D-11D2-945F-00C04FB984F9} Group Policy

Update NMAS Password Policy Links

Link present at : dc=multizone,dc=com

Group Policy Template is older than NMAS login policy <cn=Domain Password
Policy,cn=Password Policies,cn=System,dc=multizone,dc=com>.
DOMAIN\intruderLockoutResetInterval [1800] => System Access\LockoutDuration [30]
DOMAIN\intruderAttemptResetInterval [1800] => System Access\ResetLockoutCount [30]
DOMAIN\loginIntruderLimit [0] => System Access\LockoutBadCount [0]
NMAS\passwordExpirationInterval [3628800] => System Access\MaximumPasswordAge [42]
NMAS->GPO synchronization OK.

17.2.3 Enforcing Computer Configuration and User Configuration

DSfW supports computer configuration and user configuration settings in GPOs. You can change the
computer configuration settings, such as customizing the start menu, desktop, and Internet Explorer,
and the user configuration settings, such as roaming profiles and desktop customization.

17.24 Troubleshooting

If you receive a message indicating that the computer configuration or user configuration is not
applicable, do one of the following:

+ Verify that winbindd is running and functional. The getent passwd <username> command
returns the information for the local users and the domain users.

If you are using the getent utility in the DSfW environment, substitute the username with the
domain user name.

+ Check the Samba log files in /var/log/samba for any errors.
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17.3

17.3.1

Sysvol

+ Section 17.3.1, “sysvolsync Utility,” on page 185

The System Volume (Sysvol) is a shared directory that stores the server copy of the domain's public
files that must be shared for common access and replication throughout a domain. The sysvol
corresponds to the /var/opt/novell/xad/sysvol/sysvol directory on the domain controller. The
Group Policy Template of the default domain policy GPO is stored in the /var/opt/novell/xad/
sysvol/sysvol/<domain name>/Policies/{31B2F340-016D-11D2-945F-00C04FB984F9 }directory.

A Group Policy Template contains the following information:

+ Template-based administrative policies

+ Security settings

+ Script files

+ Information for the applications that are available for Group Policy software installation.

The sysvoL volume of a domain is now stored on each domain controller of the domain. This
enhancement resolves the performance and scalability limitations arising from the initial design of
having the sysvoL volume only on the first domain controller.

Following are the benefits of having the sysvoL volume on every domain controller:

+ Reduces the load on each domain controller as now during user login or workstation bootup,
policies can be read from any domain controller as each domain controller holds a copy of
SYSVOL.

+ Provides fault tolerance in form of backup domain controllers providing seamless transition from
the first domain controller, in event of failure.

The synchronization of data between the domain controllers is handled by sysvolsync utility. During
the DSfW installation a crontab entry is added for sysvolsync that synchronizes the changes on the
domain controller playing the role of a PDC emulator with the other domain controllers in the domain.
The synchronization by default happens every half an hour.For more details on the sysvolsync utility
see, Section 17.3.1, “sysvolsync Utility,” on page 185

sysvolsync Utility

The sysvolsync utility is introduced to provide synchronization of sysvol and the underlying policies
between the domain controllers of a domain. This utility when invoked finds the domain controllers for
the domain and initiates the synchronization process with them, contacting one domain controller at a
time.During the synchronization only the changes are transferred and not the entire data. This helps
in faster synchronization between the domain controllers. All the POSIX file permissions and ACLs
are retained during transfer.

For intermediate synchronization, you can invoke the utility using the following command:
/opt/novell/xad/sbin/sysvolsync

During the synchronization the changes are transferred from the first domain controller(holding the
PDC Emulator role) to the other domain controllers.

The details of synchronization events are captured in /var/opt/novell/xad/log/sysvolsync.log
file.
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17.4

17.4.1

17.4.2

17.4.3

17.4.4

Limitations with Group Policy Management

+ Section 17.4.1, “Users Cannot Log In if They Are Moved From a Non-Domain Partition to a
DSfW Domain Partition,” on page 186

+ Section 17.4.2, “Members of GroupPolicy Creator Owner group cannot change the active DFS
Referral,” on page 186

¢ Section 17.4.3, “Ignore Warnings while Backing up Group Policies,” on page 186
¢ Section 17.4.4, “WMI Filters Cannot be Applied for Processing GPOs,” on page 186

Users Cannot Log In if They Are Moved From a Non-Domain
Partition to a DSfW Domain Partition

If a user with a Universal password policy is moved from non-domain partition to a DSfW partition, the
user will not be able to login into the DSfW domain.

To resolve this issue, delete the old password policy using iManager. After this step is done, the user
will be able to login to the workstation.

Members of GroupPolicy Creator Owner group cannot
change the active DFS Referral

If a member of the GroupPolicy Creator Owner group tries editing the group policy through the Group
Policy Management Console(GPMC), and if the GPMC is referring the ADC, the user will not be

permitted to change the DFS referral to make it point to the first domain controller. To make changes,
you will require administrator privileges

Ignore Warnings while Backing up Group Policies

You might get 'access denied’ warnings while backing up Group Policies in XP and Vista clients
connected to DSfW. It is safe to ignore them.

WMI Filters Cannot be Applied for Processing GPOs

WNMI filters are not supported in this release.
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18.1

Managing Trust Relationships in Domain
Services for Windows

Trust relationships are a key to managing Domain Services for Windows (DSfW).

+ Section 18.1, “What is a Trust?,” on page 187
+ Section 18.2, “Cross-Forest Trust Relationships,” on page 188

+ Section 18.3, “Limitations with Cross-Forest Trust,” on page 212

What is a Trust?

A trust is used to allow users of one domain to access resources from another domain. By default,
two-way, transitive trusts are automatically created when a new domain is created. For authentication
and name lookups to work across domains, a trust relationship must be created between the
domains. The trust relationship includes a shared secret that can be used for both Kerberos and
NTLM authentication and information that is used to support hame resolution.

DSfW supports the following cross-forest trusts:

+ External Trusts: These trusts are non-transitive trusts between two domains in different forests.
They can be one-way or two-way. This type of trust is useful to allow resource sharing only
between specific domains in different forests.

+ Forest Trusts: These trusts are transitive trusts between two forests. These trusts include
complete trust relationships between all domains in the relevant forests, so resource sharing
among all domains in the forests is allowed. The trust relationship can be either one-way or
bidirectional.

Both forests must be operating at the Windows Server 2003 forest functional level. By default,
DSfW operates at this level. The use of forest trusts offers several benefits:

+ They simplify resource management between forests by reducing the number of external
trusts needed for resource sharing.

+ They provide a wider scope of UPN authentications, which can be used across the trusting
forests.

+ They provide increased administrative flexibility by enabling administrators to split
collaborative delegation efforts with administrators in other forests.

+ They provide greater trustworthiness of authorization data. Administrators can use both the
Kerberos and NTLM authentication protocols when authorization data is transferred
between forests.

NOTE: External Trusts and Forest Trusts are cross-forest trusts.

+ Realm Trusts: These are one-way and two-way transitive and non-transitive trusts that you can
set up between an Active Directory domain and a Kerberos V5 realm, such as trusts found in
UNIX and MIT implementations.
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18.2

18.2.1

Refer to Understanding Trusts (http://technet.microsoft.com/en-us/library/cc736874.aspx) and New
Trust Wizard Pages (http://technet.microsoft.com/en-us/library/cc784531.aspx) for more information
on trusts.

Cross-Forest Trust Relationships

Administrators must configure trust relationships manually to access resources in a different forests.
Every trust relationship between each domain in the different forests must be explicitly configured.

+ Section 18.2.1, “Creating a Cross-forest Trust between Active Directory and Domain Services for
Windows Forests,” on page 188

+ Section 18.2.2, “Creating a Cross-forest Trust between two Domain Services for Windows
Forests,” on page 202

¢ Section 18.2.3, “Shortcut Trusts,” on page 212

Creating a Cross-forest Trust between Active Directory and
Domain Services for Windows Forests

This section describes how to create a cross-forest trust between Active Directory and DSfW.

+ “Configuring the DNS Forwarders on the Domain Services for Windows Server” on page 188
+ “Configuring the Reverse Lookup Zone Forwarder” on page 190

+ “Configuring the DNS Forward Lookup Zone on the Active Directory Server” on page 192

+ “Creating the Trust” on page 195

+ “Verifying the Trust” on page 202

In this example, win2003ad.com is the domain name of the Active Directory forest and dsfw.com is
the domain name of the DSfW forest.

Configuring the DNS Forwarders on the Domain Services for
Windows Server

You need to configure a DNS forwarder on the DSfW DNS server to forward any DNS queries for the
Active Directory domain to the Active Directory domain's DNS server.

+ Active Directory domain name: win2003ad.com

+ DSfW domain name: dsfw.com

1 Inthe DNS Service window of the DNS/DHCP Java-based Management Console utility, click
Create on the tool bar.

2 Select Zone from the Create New DNS Object dialog box, then click OK.
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Create New DNS Record x

Selected DMNS Record:

Ok
Zonge
DNS Server Cancel
[Zone |
DS Key Help

3 Select Create New Zone and specify the DNS configuration parameters as follows:

Create Zone x

@ Create New Zone
i Create IN- ADDR ARPA

Create

Cancel

Help

MDS Context:

|Du=OI§Swtemeject5,d|:=a|:rne,d|:=|:nm | b
Zone Domain Name:

lad. corm |

fone Type:
i Primary i® Forward

(' Secondary
Mame Server IP Address:

Assign Authoritative DNS Server:
DMNS_nnmfrd -

Mame Server Host Mame:
nnmfrd.betal?.com

[ | Define Additional Properties

+ Specify the eDirectory context for the zone or browse to select it; that is, the container
containing the DNS related objects.

+ Specify a name for the zone; that is, the domain name of the Active Directory forest.
+ Select the Zone Type as Forward.

+ Select a DNS server from the Assign Authoritative DNS Server drop-down list. This is the
name of the DNS server object.

¢ Click Create. A message indicates that the new forward zone has been created.
4 Select the zone that is created.

5 Click the Forwarding List tab. This tab displays a list of all forwarding IP addresses. To add an
address to the list, click Add, select the Forwarder Address option and specify the IP address of
the Active Directory forest's DNS server. Click OK.
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DNS/DHCP Management Console: 198.168.1.10

DHS. OHCF (detWare) | DHCF (085 Linied

¥ o@ND 3 e e

# (@ All Zones Attributes | Forwarding LISt | Zone Out Filter | SOA Information | Key List
& [ 19216856 GA16R 192 n-addapa)
=0

Forwarding List
= [ digitalairlines.com =
.

@ RoutServerinfy

Empty forwarder
® Forwarder Address;

Add Forward IP Address %

.10

[aga_ | oeiee

DNE_example

[Geiectea a0 com, *¢n=ad, om0l = OESSyStemOB]ets, 0 wbetlal?, Bt mcorm

6 Restart DNS by using the rcnovell-named start command.
7 To save the changes done to the nds, click the Save button.

Configuring the Reverse Lookup Zone Forwarder

You need to configure a DNS reverse lookup zone for DSfW for a Windows domain.

1

In the DNS Service window of the DNS/DHCP Java-based Management Console utility, select

All Zones click Create.

Select Zone from the Create New DNS Obiject dialog box, then click OK.

Create New DNS Record =

Selected DMNS Record:

Ok
Zone
DMS Server Cancel
[Zone |
DS Key Help

3 Specify the DNS configuration parameters:
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Create Zone x

() Create New Zone Create
@ Create IN-ADDR ARPA
Cancel
Help
MDS Context:
||:|u=DESwtemObjects,dc=acme,dc=n:clm | =
Metwork Address:
198 |.|188 |.]1  [.[10 |

Zone Domain Name:

fone Type:

Assign Authoritative DMNS Server:

Mame Server Host Mame:

[ | Define Additional Properties

(Example: Enter 164.99.155 for 155.99.164.IN- ADDRARPA)

i) Primary i® Forward

i Secondary
Mame Server IP Address:

DNS_example -

example.digitalairlines .com

*

Select Create IN-ADDR.ARPA.

Specify the network address. This is the IP address of the Active Directory forest's DNS

server.

Select Forward as the Zone Type.

Select a DNS server from the Assign Authoritative DNS Server drop-down list. This is the

name of the DNS server object.
Click Create. A message indicates that the zone has been created.

4 Select the zone that is created.

5 Click the Forwarding List tab. This tab displays a list of all forwarding IP addresses. To add an
address to the list, click Add, select the Forwarder Address option and specify the IP address of
the Active Directory forest's DNS server. Click OK.

Managing Trust Relationships in Domain Services for Windows

191



DNS/DHCP Management Console: 198.168.1.10 e6®

[ DNS [ DHCP quetware) | DHCP (OES Linux |
E e
¢ @ All Zones | Attributes | Forwarding List | Zone Out Filter | S04 |"Key List_ | Control Lists | Advanced

o [@ 198.168.1(56.168.192.in- addr.arpa)
o

o (@ example.com

o @ digitalairlines.com

< (@ RootServerinfo

Forwarding List

Add Forward IP Address ®

) Empty forwarder
® Forwarder Address:

DNS_example

[Se\Ected 198.168.1.10(18.56.168. 192 IN-ADDR ARPA), "CH=13_56_163_192_IN-ADDR_ARPA ou=0ES5ystemObjects, de=hetal?, do=com", 1 recordisy

6 To save the changes done to the nds, click the Save button.

7 Verify the DNS configuration by trying to resolve the Active Directory domain and its DNSSRV
records using nslookup, as follows:

nslookup -query=any ldap. tcp.dc. msdcs.<AD domain name>

For example:

# nslookup -query=any ldap. tcp.dc. msdcs.win2003ad.com

Server: 192.168.1.10

Address: 192.168.1.10#53

Non-authoritative answer:

ldap. tcp.dc. msdcs.win2003ad.com service = 0 100 389 osg-dtsrv22.
win2003ad.com.

Authoritative answers can be found from:
osg-dt-srv22.win2003ad.com internet address = 192.168.1.20

Configuring the DNS Forward Lookup Zone on the Active Directory
Server

To resolve the DSfW forest from the Active Directory forest, you must either create a forward lookup
stub zone or a forwarder on the Active Directory forest's DNS server.

1 Atyour Windows management workstation, click Start>Run, enter mmc in the text field and click
OK.

la Click File>Add/Remove snap-in, click Add and select DNS snap-in, then click Add. Click
Close to close the window and then click OK.
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= dnsmgmt - [DNS RDT-38]

2 Fle Acion VYiew Window Help

=181

SETET

« 3|

ExEFpe2®E8 E®

-
B Configure  DMS Server...

Mew Zone...

Set Aging/Scavenging for Al Zones. .
Scavenge Stale Resource Records
Update Server Data Files

Clear Cache

Launch nsloakup

Create Default Application Directary Partitions. ..

£
A—
E3 EDIRDT-38

ones
ones

All Tasks

View
Mew Windaw from Here

Delete
Refresh
Export List...

Help

‘Opans the properties dialog box far the current selection,

1b Select the Forwarders tab, then click New and add a new forwarder for the DSfW domain.
Specify the DSfW domain name and click OK.

= dnsmgmt - [DNS DT-38]

H EptroT-38

=181%]
.3-. Ele  Action Vew Window Help ‘;Iilﬁl
- | BE XFHR EE[ 2 E®
I o

Marne

[ElEvent Viewer
Forwarders
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| ] Forward Lookup Zones
[Dreverse Laakup

EDIRDT-38 Properties 21x|

Debug Logging | Ewent Lagging I Manitaring | Security
Intetfaces Forwarders | Advanced | Root Hiets

Forvearders are servers that can resolve DNS queries not answered by this
server. Forward queries for names in the following DNS domains.

ONS domain:

. 2|
Tnun Forward queries For names in the Following DNS domain,

bel DS domain:

Sel Idsfw.com

r

OK Cancel

Wp

Dowr

Mumber of secands before fonward queries time out; 5

™ Do not uge recursion for this domain

QK | Cancel | Spply
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1c Select the new forwarder, specify the IP address of the DNS server of the DSfW domain,
then click Add.

EDIRDT-38 Properties 2 =]

[Debug Logging ] Event Logaging ] Manitaring ] Security ]
Interfaces Fonwarders l Advanced ] Foot Hintz ]

Famwarders are servers that can resolve DMNS queries nat answered by thiz
zerver. Fonvard quenies for names in the following DMS domains.

DS domair:

All ather DMS domaing i Mew...
college. edu o —
maniju-ad. com j =

To add a fonwarder, select a DWNS domain, type the forwarder'z IP address
below, and then click Add.

Selected domain's fonwarder |P address list:
192 162 1 10

Mumber of zeconds before forward queries time out: A

[ Do not uge recursion for this domain

(1] | Cancel | Apply |

1d Verify the DNS configuration by using nslookup to resolve the Active Directory domain and
its DNS SRV records, as follows:

nslookup -query=any ldap. tcp.dc. msdcs.<DSfW domain name>

indows [Uersion 5.2_37981
G Cnpyrlght 1985-2883 Microsoft Corp.

C:“Documents and Settings“Administrator’nslookup —query=any _ldap._tcp.dc._msdcs
.dsfw.com

Server: localhost

Addresz: 127.8.0.1

_ldap._tcp.dc. mgdcﬁ.dﬁfu.cum SRU szervice location:
priority =
we ight 1BE
port 389
sur hostname oes-de-1.dsfw.com
nameserver = ces-do-1l.dsfw.com

l.dsfw.com internet address = 192.168.1.10

C:~Documents and Settings™Administratorl_
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2 Right-click Reverse Lookup Zones, select New Zone.
2a Select Primary Zone. Deselect the Store the zone in Active Directory option.
2b Specify the Network IP and click Finish. The zone is now created.
2c Right-click the newly created zone to create a PTR record and enter the required details.

3 If the Active Directory domain's Domain Functional Level is not Windows Server 2003, do the
following to raise it:

3a Open Active Directory Domains and Trusts snap-in from the MMC.

3b Right-click the icon representing the Active Directory domain, select Raise Domain
Functional Level from the menu, then set it to Windows Server 2003.

4 If the Active Directory forest's Forest Functional Level is not Windows Server 2003, do the
following to raise it:

4a Right-click the Active Directory Domains and Trusts snap-in from MMC.

4b Select Raise Forest Functional Level from the menu and set it to Windows Server 2003.

Creating the Trust

1 Atyour Windows management workstation, click Start>Run, enter mmc in the text field and click
OK.

2 Click File>Add/Remove snap-in, click Add and select Active Directory Domains and Trusts snap-
in, then click Add.

3 Click Close, then click OK.
4 Right-click the DSfW domain, then select Properties.
5 Select New Trust from the Trusts tab, then click OK.

win2003ad.com Properties el Fd

General Truste | Managed Eyl

Domains trusted by this domain [outgoing trusts]:

Domain Mame | Trugt Tupe | Tranzitive | Eropertiez... |

adchild. win2003ad. com Child Tes

mariu-ad.com Farest Yes Femaye |

[Domains that trust this domain (incoming tousts):

Drarmain M ame | Tzt Tupe | Transzitive | Properties. .. |

adchild. win2003ad. com Child Tes

manju-ad.com Farest Yes Remave |

Mew Trust... |

ok I Cancel Al
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6 Click Next to start creating a new trust.

MNew Trust Wizard |

Welcome to the New Trust

Q& Wizard

Thiz wizard helps you create a trust between thiz domain
and any of the fallowing:

A Wndows domain in thiz forest ar in anaother forest,

= AW ndows MT 4.0 domain.

A Ferberos W realm trust.

= Another forest.

A trugt iz a relationship that enables users in one domain,
forest, or realm to be authenticated in a zpecified domain,
forest, or realm.

To continue, click Mesxt. Help |
Cancel |

¢ Back

7 Specify the DNS name (or NetBIOS name) of the Active Directory forest, then click Next.

Mew Trust Wizard

Trugt Name
You can create a trust by using a MetBIOS or DMS name.

Type the name of the domain, forest, or realm faor this trust. [F you bepe the name of a forest, you
muzt twpe a DMNS name.

Example MetBI0S name: supplier0-int
Example OMS name: supplierd]-intermal. microsaft. com

M arne:

win2003ad.com

< Back I Mest » I Cancel
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8 Select Forest trust, then click Next.

Mew Trust Wizard

Trust Type

Thiz damain is a forest oot domain. IF the specified domain qualifies, you can
create a forest trust.

Select the tppe of trust you want to create.

" External tust
An esternal trust iz a nontranzsitive tust between a domain and another darmain
outzide the forest. & nontransitive tuzt is bounded by the domainz in the
relationzhip.

&% Forest tust
i forest trust is a ransitive tust bebween buo forests that allows users in any of the !
idomains in one forest bo be authenticated i any of the domains in the other forest. |

< Back I Mest » I Cancel

9 To select the direction of trust, do one of the following:
+ Click Two-way to create a two-way forest trust.
+ Click One-way:incoming to create a one-way incoming forest trust.
+ Click One-way:outgoing to create a one-way outgoing forest trust.

Mew Trust Wizard

Direction of Trust
Y'ou can create one-way ar bwo-way busts.

Select the direction for thiz trust.

% T wo-way

[Jzers in thiz domain can be authenticated in the zpecified domain, realm, ar :
forest, and uzers in the specified domain, realm, or forest can be authenticated in
this damair. i

" One-way: incoming
[Izers in thiz domain can be authenticated in the zpecified domain, realm, or forest.

" Ome-way: outgoing
[zers in the zpecified domain, realm, or forest can be authenticated in thiz domain.

< Back I Hest = I Cancel
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10 Click Next.
11 Select Both this domain and the specified domain and click Next.

Mew Trust Wizard

Sides of Trust
If you have appropriate permizzions in both domainz, vou can create both sides of
the trust relationship.

To begin uzing a bust, both zsides of the trust relationzhip must be created. For example,
if you create a one-way incoming trust in the local domain, a one-way outgaoing trust
muzt alzo be created in the specified domain before authentication raffic will begin
flowing acrozs the trust.

Create the trust far the following:

™ This domain only
Thiz option creates the tust relationship in the local domain.

¥ B oth thiz domain and the specified domain
Thiz option creates a trust relationship in the local damain and a carespanding trust
relationzhip in the zpecified domain. Y'ou must have trust creation privileges in the
zpecified domairn.

< Back I Mest » I Cancel

12 Specify the user name and password of the Active Directory domain administrator, then click
Next.

Mew Trust Wizard

User Mame and Password
To create this tust relationship, you must have administrative privileges for the
zpecified domain.

Specified domain: dsh.com

Type the uzer name and pazsword of an account that haz adminiztrative privileges in
the specified domain.

Uszer narme: I ﬁ adrministrator j

Pazswiord: |nn-.

< Back I Mest » I Cancel
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13 Select Forest-wide authentication to authorize users to use resources in the local forest or those
identified by the administrator, then click Next.

MNew Trust Wizard |

Outgoing Trust Authentication Level--Local Forest

Ilzers in the specified forest can be authenticated to uze all of the resources inthe
loc:al fargst ar only thoze rezources that pou zpecify.

Select the scope of authentication far users from the dsbw. com forest.

% Forestwide authentication :
fwdindowis will automatically authenticate users from the specified forest for all resources |
in the local forest. This option is preferred when both farests belong ta the same i
iorganization.

= Selective authentication
Windowes will not automatically authenticate users from the specified forest far any
resources in the local forest. After you finish thiz wizard, grant individual access to each
domain and server that you want to make available to ugers in the zpecified forest. Thiz
option is prefered if the farests belong to different organizations.

< Back I Mest » I Cancel

14 Select Forest-wide authentication to authenticate Active Directory forest users to use resources
in the dsfw.com forest or those identified by the administrator, then click Next.

Mew Trust Wizard x|

Outgoing Trust Authentication Level--5pecified Forest

Ilzerz i the local forest can be authenticated to uge all of the resources in the
zpecified forest or only thoze resounces that you zpecify.

Select the scope of authentication far users from the local farest,

¥ Forest-wide authentication

indawz will automatically authenticate users from the local forest for all resources in
the dsfw.com forest. This option iz preferred when both forests belong to the same
orgatuzakion,

" Selective authentication
Wfindows will nat automatically authenticate uzers from the local forest for any resources
in the dshw com forest. After pou finizh this wizard, grant individual access to each domain
and zerver that you want to make available to uzers from the local forest. This option iz
preferred if the forests belong to different arganizations.

< Back I Mest » I Cancel
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15 Review the trust settings and complete the creation of trust by clicking Next.

Mew Trust Wizard

Trust Creation Complete
The trust relationzhip was successfully created.

Status of changes:

[Trust relationzhip created successfully. -
Specified domain: dsbw. com

Direction:

Twa-way: Uzers in the local domain can authenticate in the specified domain and
uzerz in the zpecified domain can authenticate in the local domain.

Trust type: Forest trust

Outgoing trust authentication level: Forest-wide authentication in lozal and
specified forests.

]

To configure the new trust, click Mest.

¢ Back I Mest » I Cancel

16 Click any option depending on your choice, then click Next.

Mew Trust Wizard

Confirm Outgoing Trust
“ou ghould confirm this trugt only if the other side of the trust has been created.

Do wou want to caonfirm the autgoing trust?

£+ Mo, do not confim the outgoing bsk

£ Yes, confirm the outgoing trust

¢ Back I Mest » I Cancel

200 OES 11 SP3: Domain Services for Windows Administration Guide



17 Click any option depending on your choice, then click Next.

Mew Trust Wizard

Confirm Incoming Trust
You ghould confirm this trust only if the other side of the trust has been created.

Do wou want to caonfirm the incorming trust?

' Mo, do not confim the incoming tust

£~ “Yes, confirm the incoming trust

¢ Back I Mest » I Cancel

NOTE: In Step 16 and Step 17, if you select Yes option to confirm the trust, ensure that you
validate the trust later by selecting Properties>Validate option.

18 Complete the trust creation by clicking Finish.

Mew Trust Wizard |

Completing the New Trust

g&? Wizard

You have successfully completed the Mew Trust wizard.

Status of changes:

[T szt relationzhip created succezsfully. ;I

Foute these names to the specified forest:
* def.com

Foute these names to the local forest:
* win2003ad. com

To clogze this wizard, click Finizh.

< Back I Finigh I Cancel
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19 The new domain summary appears in the Trusts page.

win2003ad.com Properties el Fd

General Truste | Managed Eyl

Domains trusted by this domain [outgoing trusts]:

Domain Mame | Trugt Tupe | Tranzitive | Eropertiez... |

adchild. win2003ad. com Child Tes

dzfw . com Forest Yex Eemove |

manju-ad.com Farest Tes

[Domains that trust this domain (incoming tousts):

Drarmain M ame | Tzt Tupe | Transzitive | Properties. .. |

adchild. win2003ad. com Child Tes

dzhw.cam Rermowve |
manju-ad.com Forest Yes
Mew Trust... |

0k I Cancel Ammly

Verifying the Trust

To verify that the DNS configuration is correct:

1 Verify that the Log on to drop-down list in the Login window of a Windows XP machine that is
joined to the Domain Services for Windows domain has an entry for the Active Directory domain.
For other higher versions of Windows like Windows 7 and Windows 8, follow the instructions in
Step 2 on page 202.

2 Try to log on to the Windows machine that is joined to the Domain Services for Windows domain
with an Active Directory domain user principal name.

3 Verify that the Log on to field in the Login window of a Windows XP machine that is joined to the
Active Directory domain has an entry for the Domain Services for Windows domain. For other
higher versions of Windows like Windows 7 and Windows 8, follow Step 4 on page 202.

4 Try to log on to the Windows machine that is joined to the Active Directory domain with a Domain
Services for Windows domain user principal name.

18.2.2 Creating a Cross-forest Trust between two Domain Services

202

for Windows Forests

This section describes how to create a cross-forest trust between two DSfW forests.

+ “Configuring the DNS Forwarders on the Domain Services for Windows Server” on page 203

+ “Configuring the Reverse Lookup Zone Forwarder” on page 203
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+ “Creating the Trust” on page 204
+ “Verifying the Trust” on page 212

In this example, there are two DSfW forests: dsfwl.com and dsfw2.com.

Configuring the DNS Forwarders on the Domain Services for
Windows Server

You need to configure a DNS forwarder on the first DSfW DNS server (dsfwl.com) to forward any
DNS queries for the second DSfW domain(dsfw2.com). The queries are forwarded to the DNS server
of the second domain.

1 In the DNS Service window of the DNS/DHCP Java-based Management Console utility, click
Create on the tool bar.

2 Select Zone from the Create New DNS Object dialog box, then click OK.

3 Select Create New Zone and specify the DNS configuration parameters as follows:

+ Specify the eDirectory context for the zone or browse to select it; that is, the container
containing the DNS related objects.

+ Specify a name for the zone; that is, the DSfW domain name with which you want to create
trust (second domain).

+ Select the Zone Type as Forward.

+ Select a DNS server from the Assign Authoritative DNS Server drop-down list. This is the
name of the DNS server object.

+ Click Create. A message indicates that the new forward zone has been created.
4 Select the zone that is created.

5 Click the Forwarding List tab. This tab displays a list of all forwarding IP addresses. To add an
address to the list, click Add, select the Forwarder Address option and specify the IP address of
the DNS server of the DSfW domain with which you want to create trust (second domain). Click
OK.

6 Restart DNS by using the rcnovell-named start command.
7 To save the changes done to the nds, click the Save button.

Repeat steps Step 1 to Step 7 to create forwarder for the first DSfW domain (dsfwl.com) in the DNS
server of the second DSfW domain (dsfw2.com).

Configuring the Reverse Lookup Zone Forwarder

You need to configure a reverse lookup zone for the second DSfW domain on the DNS server of the
first DSfW domain.

1 In the DNS Service window of the DNS/DHCP Java-based Management Console utility, select
All Zones click Create.
2 Select Zone from the Create New DNS Object dialog box, then click OK.
3 Specify the DNS configuration parameters:
+ Select Create IN-ADDR.ARPA.

+ Specify the network address. This is the IP address of the DNS server of the DSfW domain
with which you want to create a trust.

¢ Select Forward as the Zone Type.

Managing Trust Relationships in Domain Services for Windows 203



204

¢ Select a DNS server from the Assign Authoritative DNS Server drop-down list. This is the
name of the DNS server object.

+ Click Create. A message indicates that the zone has been created.

4 Select the zone that is created.
5 Click the Forwarding List tab. This tab displays a list of all forwarding IP addresses. To add an

address to the list, click Add, select the Forwarder Address option and specify the IP address of
the Active Directory forest's DNS server. Click OK.

6 To save the changes done to the nds, click the Save button.

7 Verify the DNS configuration by trying